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Chapter 1. Test Execution Specialist Guide

This guide describes tasks that you can perform on schedules, test execution with custom code, and 

Extending Rational®  Performance Tester  to support other protocols. This guide is intended for testers or 

test execution specialists.

Running schedules
After you have added the user groups, tests, and other items to a schedule, and you are satisfied that it 

represents a realistic workload, you run the schedule.

Running a local schedule or test
You can run a test locally or a A schedule, in this context, is used to refer to both VU Schedule  and Rate 

Schedule  on remote locations with a default launch configuration.

To play back tests against the applications that require client authentication such as Digital Certificates, 

Kerberos, you must provide the appropriate authentication before playing back the test.

• To play back a test with a digital certificate, see Playing back a test with a digital certificate  on 

page .

• To play back a test that require Kerberos authentication, see Generating tests that use Kerberos  on 

page .

When you run a schedule or test in this way, IBM®  Rational®  Performance Tester  automatically sets up 

a simple launch configuration. A test runs on the local computer, with one user. A schedule runs with the 

user groups or Rate Runner groups and the locations that you have set. However, the execution results 

have a default name (the same as the schedule or test, with a suffix) and are stored in a default location.

The Rate Schedule  can be run only on agent locations. The Rate Schedule  can be run on agents that were 

installed only with PVU-based licenses.

When you run a schedule with multiple agents, an agent might be lost, especially during the long load test 

run. Losing an agent is not common and occurs during some extreme cases such as when computer's 

memory is exhausted. When an agent is lost, by default, the schedule is stopped. When the schedule 

is stopped in this manner, you must fix the reason of agent loss or add more agents before running 
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the schedule. To continue to run the schedule without the lost agent, in the Schedule editor, click the 

Advanced  tab and clear the Loss of an agent halts execution  check box.

Typically, the agents divide the load among themselves. So, running a schedule without the lost agent 

might give unpredictable results. If you use a segmented dataset and if you run a schedule without the 

lost agent, the data is not redistributed among the surviving agents. Also, if the schedule has multiple 

stages, by default, the load is distributed among the surviving agents at the next stage. But, if the Replace 

lost users in current stage  check box is selected, then the load is distributed evenly among the surviving 

agents in the current stage. If the check box is cleared and a percentage of users or clients are allowed to 

exit during stage execution, the load is distributed among the surviving agents in the next stage. Loss of 

an agent in a schedule run is logged in the Performance Report.

To stop a test gracefully without causing incomplete page hits, select the Active actions are allowed to 

complete if stop requested  check box at Window  > Preferenes  > Test  > Test Execution.

To receive email notification for the status of the run, specify the email properties in Window  > Preferenes 

> Test  > Test Execution.

1. In the Test Navigator, expand the project until you locate the schedule or test.

2. Right-click the schedule or test, and then click Run As  > Performance Schedule  or Run As  > Test.

Note:  If you run an HTTP schedule on a remote Macintosh computer, the test fails. The cipher 

suite that is used for recording must be available in Oracle JDK on the Macintosh computer. For 

example, you can use TLS_RSA_WITH_AES_128_CBC_SHA  on Macintosh.

After you run a test or a schedule, the Performance Test Runs view opens. In this view, you can add 

comments about the selected result and view the settings that were used to run the schedule. To 

add comments, in the lower-left panel of the Performance Test Runs view, click User Comments. The 

comments that you enter are displayed on the Summary page of performance reports. To view the 

settings that were used for a schedule run, click Schedule Settings. The Performance Test Runs View 

Schedule Settings page displays and shows the statistics and test log settings that were used for the run.

Note:  When you record a test that includes a file download, the file is not physically saved to disk. 

However, you can confirm that the file was retrieved from the server by looking in the response of the 

request that asked for the file. One method to locate the request for large downloaded files is to look for a 

request with a large response size.

You can configure a schedule or test. A typical reason for setting up a configuration is to control where 

the execution results are stored. For more information, see Setting a launch configuration  on page 27.
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Related information

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Running a long run mode SAP GUI test
When running a SAP GUI test that could last for many hours and could use up the operating system 

resources, you can choose to run the test with the Long Run Mode process. It is an external process that 

restarts automatically after the specified number of SAP sessions are over. So, tests of longer duration 

tests are more likely to finish.

The following guidelines improve the success of long duration tests:

• Use agent computers with at least 2GB of RAM and 10GB of free disk space, running the same 

version of the IBM®  Rational®  Performance Tester  or Rational®  Performance Tester  Agent.

• Disable antivirus software, screen savers, and automatic updaters on the agent computers during 

the test.

• Keep individual tests short by having loops of not more than 10 iterations within each test. Get the 

desired long run duration by looping within the schedule. Do not exceed 20 or 30 virtual testers for 

each agent computer with a think time of more than several seconds.

• Use tests with a minimal number of verification points.

• Do not use the Signature theme. Disable all animations in the SAP GUI.
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• Do not use the mouse during the test. Any mouse click could be interpreted by a hidden SAP GUI 

window, which could cause the test to fail.

• Ensure that the Screen Throughput counter remains low (approximately 1 every second for each 

agent).

• Before playing back a test, in SAP Connection Details editor, click Test Connection  to test the 

connection to the SAP GUI server.

1. In the schedule, select a User Group that includes a SAP GUI test.

2. In the User Group Details, click the Options  tab and click Edit Options.

3. In Long Run Mode process renewal level, select one of the following options:

• Schedule: Starts the Long Run Mode process at the schedule level. All of the SAP sessions 

are managed by one process.

• User Group: Starts the Long Run Mode process at the beginning of each user group.

• Virtual User: Starts the Long Run Mode process for each virtual user.

• Long Run Mode off: Does not use the Long Run Mode process. In this mode, the SAP 

GUI is directly called by Rational®  Performance Tester, thereby increasing the resource 

consumption of the operating system.

4. In Number of SAP session starts per process, specify the number of SAP sessions to run. The 

Long Run Mode process runs one session at a time. For example, if you specified 100 sessions for 

Virtual User, the Long Run Mode process takes one session at a time, and when the 100 sessions 

are run, a new process starts.

5. Click OK  and save the schedule.

Related information

Running a local schedule or test  on page2

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49
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Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Evaluating results  on page

Running long duration Citrix tests
When tests exceed many hours, resource consumption issues can cause problems for the Citrix clients. 

The long run mode increases the reliability of long duration tests with the Citrix protocol by running the 

test using multiple processes.

Ensure that the test plays back reliably, with no errors, when run as a single test.

For Citrix tests, a new process is created for each virtual tester.

The following guidelines improve the success of long duration tests:

• Use agent computers with at least 2GB of RAM and 10GB of free disk space, running the same 

version of the IBM®  Rational®  Performance Tester  or Rational®  Performance Tester  Agent. 

Disable antivirus software, screen savers, and automatic updaters. Avoid using the agent 

computers during the test.

• Keep individual tests short by avoiding loops of more than 10 iterations within each test, and 

achieve the desired long run duration by looping within the schedule. Do not exceed 20 or 30 virtual 

testers per agent computer with a think time above several seconds.

• Use tests with a minimal number of verification points.

To enable long run mode:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the schedule, click the user group for which you want to enable the long run mode.

3. In the Schedule Element Details area, click the Options  tab and click Edit Options.

4. Select the Enable long run mode  check box and click OK.

5. Save the schedule.
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Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Testing with Docker images
IBM®  Rational®  Performance Tester, IBM®  Rational®  Functional Tester, and IBM®  Rational® 

Performance Tester  Agents are available for download as Docker images. You can use them to fulfill the 

continuous testing aspects of your DevOps lifecycle.

You must use only floating licenses for the product and VT-pack when playing back tests using Docker. 

These licenses should be hosted on a server that can be accessed by the workbench.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27
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Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Running tests with containerized agents
When you have a local workbench, instead of installing the agents on different machines and locations, 

you can deploy the containerized agents to generate the load.

You must have configured the Docker container. See Configuring Docker containers  on page .

Typically, when the agents are installed, you specify the workbench host name and port number to 

establish the connection with the workbench. If you use containerized agents, they are already installed. 

Therefore, you specify the connection information during the run.

Note:  The version number of the container images and the desktop products must match. If you have 

previous version of the container image, uninstall it and install the latest version.

To uninstall the image, you must stop the container by running the docker stop "CONTAINER ID"  command, 

and then run the docker rmi -f "image ID"  command to uninstall the image.

1. Start the container instance of the agent by running the following command:

$ docker run -dit --rm -e MASTER_NAME=Workbench_name or IP  -e MASTER_PORT=port_number  -e AGENT_NAME=Agent_name 

 -e AGENT_IP=IP_address imageName:imageVersion

Table  1. Description of parameters

Command Description

-dit Specifies that the agent container runs in the background.

--rm Specifies to clean up the container and remove the file system when the 

container exits.

MASTER_NAME Specifies the IP or host name of the workbench.
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Command Description

MASTER_PORT Specifies the port number of the workbench. If you use the default port 

number of 7080, this command is optional.

AGENT_NAME Optional: Specifies the name of the agent that report to the workbench.

AGENT_IP Optional: Specifies the IP address of the agent that report to the work

bench.

imageName:im

ageVersion

Specifies the name and version of the image.

2. Click the Agent Status  icon  from the product to verify the two container agents are polling the 

workbench.

Note:  The agent host names should match the IDs of the containers running in Docker. Make 

a note of the IP address of the each agent since they must be used when creating the agent 

locations.

3. In the schedule editor, create a new location test asset for each container agent so that the 

selected User Group  runs on two agent locations.

4. Run the schedule.

The deployment step could result in the schedule remaining in the “Launching”  state for several 

minutes.
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Running automated tests with containerized workbench and agents from 
Docker
To simplify the deployment piece of Continuous Testing, you can use built Docker images to deploy the 

workbench and the agents and start testing in no time. You need not install the workbench and the agents 

on different machines. You can deploy the Docker images and use Docker commands to play back tests.

You must have configured the Docker container. See Configuring Docker containers  on page .

You must already have exported the test assets to a location from where Docker can import them. For 

information about exporting the test assets, see Copying test assets with dependencies  on page .

Note:  The version number of the container images and the desktop products must match. If you have 

previous version of the container image, uninstall it and install the current version. To uninstall the image, 

use these commands:

1. Stop the container by running

docker stop "CONTAINER  ID"

.

2. Uninstall the image by running

docker rmi -f "image ID"

.

1. To run the test without using any agents, start the container:

$ docker run --rm -e RATIONAL_LICENSE_FILE=PORT@HOST  -v hostTestAssets:/containerTestAssets 

 -v hostImportedData:/containerImportedData  imageName:imageVersion cmdline 

 -workspace //containerImportedData/workspace -project projectName  -schedule testName  -results autoResults 

 -stdout -exportlog /containerPathExtracted/testlog.txt 

Table  2.

Command Description

--rm Removes the container after the run com

pletes.

-e Sets environment variables.

RATIONAL_LICENSE_FILE=<PORT>@<HOST> Specifies the port number of Rational Li

cense Key Server, usually 27000, and the 

server IP address. The floating license for the 
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Command Description

product and VT-packs must be on the license 

server.

hostTestAssets:/containerTestAssets Specifies the folder location on the host ma

chine and the container containing the com

pressed test assets (Zip format). Use both 

the locations to map one or more shared vol

umes to transfer data such as test assets, 

logs, and execution results between the host 

and the container.

hostImportedData:/containerImportedData Specifies the workspace location on the host 

machine and the container containing the 

test assets that are not compressed. Results 

from the test execution are saved to the di

rectory you specify on the host machine.

TEST_IMPORT_PATH=<PATH> Specifies the location of the compressed test 

assets to be imported into the container. The 

location path is on the container side and not 

the host. For example, /containerTestAs

sets/archiveName.zip. The volume and path 

names are user defined and should be con

sistent.

imageName:imageVersion Specifies the name of the image and its ver

sion to run.

cmdline Specifies the existing command line argu

ments to define the location of the work

space, project name, test or schedule name, 

results file name, and the location of the ex

ported logs.

After the test run completes, check the hostImportedData  on the host machine to view the 

exported log.

2. To run the tests on containerized agents, load the agent images into the Docker repository:

tar --wildcards --to-command='docker load' -xzf <workbenchImageName> 'images/'*
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For example, the workbench image name could be ibm-rtw-<versionNumber>.tar.gz.

When the image is loaded, the following message is displayed - Loaded image: 

imageFileName:versionNumber

3. Specify the agent details in the workbench. You can do this in one of the two ways:

• Specify all of the details in the local workbench and export the test assets to the directory 

that will be used by the containers to choose the tests.

• Bring up the workbench UI in the container to specify the agents in the schedule editor. 

To bring up the workbench UI in the container, install and configure an X11 server such as 

Xming on your host machine and specify -e DISPLAY=<IP>:0.0  parameter in the docker 

run command. The IP is the IP address of your host machine. For information about how to 

install and configure Xming, see its product documentation.

Note:

• If you use 'localhost' instead of the IP address with the default Docker settings, the 

container will forward the display to itself. If your IP is assigned via DHCP it is liable to 

change and you will need to update your container’s environment variable accordingly.

• Do not use underscores in the agent names.

4. To map a User Group with a specific agent, assign a static IP to the agent. To assign an IP to the 

agent, use the NODE_IP  parameter along with the docker run  command.

Note:  Ensure that this IP matches with the IP specified for the Location asset in the 

workbench.

5. Initiate the test runs against the agents in one of the following ways:
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a. To facilitate a run where container agents will automatically connect the workbench 

container to run a schedule, install the Docker Compose  tool.

i. Create a docker-compose.yml  file that specifies similar parameters as mentioned 

in step 5.

ii. To run the tests, in the command prompt, navigate to the directory containing the yml 

file and run:

docker-compose up

In addition to the parameters in step 5, you must also specify the following two parameters 

in the yml file:

• MASTER_NAME: Specify the name of the workbench container.

• AGENT_NAME: Specify the name of the agent. The agent name defined in the 

schedule must match with the name of the agent container.

Sample compose file:

#SIMPLE DOCKER COMPOSE FILE/TEMPLATE

#BE SURE TO REPLACE ANY PROJECT-SPECIFIC NAMES/PATHS AND LICENSING VARIABLES WITH YOUR OWN VALUES

version: '2'

services:

  agent1:

    image: <agentImageName>:<imageVersion>

    environment:

      - MASTER_NAME=<workbenchImageName>

      - AGENT_NAME=<agentImageName>

    

  agent2:

    image: <agentImageName>:<imageVersion>

    environment:

      - MASTER_NAME=<workbenchImageName>

      - AGENT_NAME=<agentImageName-2>

    

  workbench:

    image: <workbenchImageName>:<imageVersion>

    entrypoint: cmdline -workspace /runData/workspaceJuly10 -project 921proj -schedule 

 Schedules/agentSched -results autoResults -stdout -exportlog /runData/agentSchedLogJuly10.txt

    ports:

         - "7080:7080"

         - "7443:7443"

13

https://docs.docker.com/compose/


Test Execution Specialist Guide

14

    volumes:

      - C:\Tests:/Tests

      - C:\runData:/runData

    environment:

      - RATIONAL_LICENSE_FILE=27000@<IP>

      - TEST_IMPORT_PATH=/Tests/agentProj.zip

Note:  Docker Compose is included with some versions of Docker. The tool automates 

some network configurations and makes it easier to coordinate multiple containers. To 

check whether you have it, run docker-compose --version.

b. Start the agent containers by passing the following command as many times as you want 

the number of agents for the run. To start four agents, pass the command four times.

docker run -it -e MASTER_NAME=IP_ADDRESS  -e MASTER_PORT=PortNumber  -e AGENT_NAME=NameofAgent  -e 

 AGENT_IP=AgentIP imageName:imageVersion

Table  3. Description of parameters

Command Description

-dit Specifies that the agent container runs in 

the background.

-e Sets environment variables.

--rm Specifies to clean up the container and re

move the file system when the container 

exits.

MASTER_NAME Specifies the IP or host name of the work

bench.

MASTER_PORT Specifies the port number of the work

bench. If you use the default port number 

of 7080, this command is optional.

AGENT _NAME Specifies the name of the agent. When 

there are multiple agents running the test, 

the agent names helps you in identifying 

the results the agent is associated with.
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Command Description

AGENT_IP Specifies the IP address of the agent.

imageName:imageVersion Specifies the name and version of the im

age.

6. Verify whether the schedule has completed successfully. If you used an option such as -exportlog 

to output results to the shared volume, check the corresponding directory on your host machine 

that was mapped to hostImportedData  to retrieve the exported data.

If the test or schedule has completed successfully, the agent will likely be running. You might have to 

explicitly stop the agent by running

docker stop containerID

If you used Docker Compose tool to run the tests, you can stop the agents when the workbench container 

exits by running

docker-compose up --abort-on-container-exit

Related information

Testing with containerized agents  on page8

Testing with IBM®  Cloud Private
You can automate your testing environment by using Docker container images of the workbench and 

agents on top of IBM®  Cloud Private.

You must use only floating licenses for the product and VT-pack when playing back tests. These licenses 

should be hosted on a server that can be accessed by the workbench.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29
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Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Running automated tests with containerized agents on IBM®  Cloud Private
To adopt IBM®  Cloud Private  fully and manage the entire development to deployment workflow on cloud, 

you would want to start and stop capabilities with a few clicks. By providing the agents in containers, you 

can dynamically provision capability as required without procuring the machines and installing the agents.

You must have configured IBM®  Cloud Private  as per the instructions in Configuring IBM Cloud Private  on 

page .

You must use only floating licenses to play back the tests.

To automate deployment and playback of the tests, you can choose to create bash scripts for the 

Kubernetes commands and integrate with Jenkins.

Note:  The version number of the container images and the desktop products must match. If you have 

previous version of the container image, uninstall it and install the current version. To uninstall the image, 

use these commands:

1. Stop the container by running

docker stop "CONTAINER  ID"

.

2. Uninstall the image by running

docker rmi -f "image ID"

.
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1. Log in to the IBM®  Cloud Private  management console and complete the following steps:

a. From the navigation menu, click Workloads  > Deployments  > Create Deployment

b. On the Generals  tab, enter a name for your deployment.

c. On the Container  tab, enter the name of the agent container and the image to use for the 

container. Provide the image name in the following format:

cluster_CA_domain:8500/namespace/imagename

d. In the Enviornment Variable  tab, for Name, enter MASTER_NAME  and for Value  enter the IP 

address of the workbench computer workbenchIP

e. Click Create.

f. Create a deployment for the second agent image. Use another name for the agent image. 

You can use the same image tag and the environment variables.

2. Verify that you have two deployments of the agent by clicking Workloads  > Deployments.

3. On your workbench, use the Agent Status button to verify the two container agents are polling the 

workbench.

Note:  The agent host names should match the IDs of the containers running in IBM®  Cloud 

Private. Make a note of the IP address of each agent because they will be used when creating the 

agent locations.

4. Create a new location asset for each container agent and associate it with a user group. For more 

information, see Running a user group at a remote location  on page .

5. Run the schedule and verify the test results in the workbench.

Note:  The deployment step could result in the schedule launch remaining in the “Launching” 

state for several minutes.

To stop the agents, in the management console, click Workloads  > Deployments  and under Action select 

Remove  to remove each agent deployment.

Running automated tests with containerized workbench and agents on 
IBM®  Cloud Private
To adopt IBM®  Cloud Private  fully and manage the entire development to deployment workflow 

on the cloud, you would want to start and stop capabilities with fewer clicks. By providing both the 

workbench and agents in containers, you can dynamically provision capability as required and run the test 

automation suites without procuring the machines and installing the products.

17

unique_27
unique_27


Test Execution Specialist Guide

18

You must have configured IBM®  Cloud Private  as per the instructions in Configuring IBM Cloud Private  on 

page .

You must use only floating licenses for the product and VT-pack when playing back tests. These licenses 

should be hosted on a server that can be accessed by the workbench.

Note:  The version number of the container images and the desktop products must match. If you have 

previous version of the container image, uninstall it and install the current version. To uninstall the image, 

use these commands:

1. Stop the container by running

docker stop "CONTAINER  ID"

.

2. Uninstall the image by running

docker rmi -f "image ID"

.

1. In IBM®  Cloud Private, create services for the workbench and agents by creating the 

services.yml  file. Services are logical set of pods that can provide a single IP address and DNS 

name by which the pods can be accessed. Creating the services only reserves the IPs and does not 

create the actual workbench or agent pods. See the sample services.yml file.

Sample services file:

cat services.yml

 

apiVersion: v1

kind: Service

metadata:

  labels:

    io.kompose.service: <workbench_name>

  name: <workbench_name>

spec:

  type: NodePort

  ports:

  - name: "7080"

    port: 7080

    targetPort: 7080
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  - name: "7443"

    port: 7443

    targetPort: 7443

  selector:

    io.kompose.service: <workbench_name>

status:

  loadBalancer: {}

---

apiVersion: v1

kind: Service

metadata:

  labels:

    io.kompose.service: agent1

  name: agent1

spec:

  ports:

  - name: "7080"

    port: 7080

    targetPort: 7080

  selector:

    io.kompose.service: agent1

status:

  loadBalancer: {}

2. Run the command to create the service.

kubectl create -f services.yml

3. Pass the command to get the IP addresses of the workbench and the agents so that you can use 

them in the deployment.yml  file to connect the agents with the workbench.

kubectl get services

4. Create a deployment.yml  file to specify the license, agents, workbench, license, and test asset 

information in the yml file.

Sample deployment file:

cat deployment.yml

apiVersion: extensions/v1beta1

kind: Deployment

metadata:

  labels:
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    io.kompose.service: <workbench_name>

    pt.classification: workbench

  name: <workbench_name>

spec:

  replicas: 1

  strategy:

    type: Recreate

  template:

    metadata:

      labels:

        io.kompose.service: <workbench_name>

        pt.classification: workbench

        pt.name: <workbench_name>

    spec:

      containers:

      - command:

        - cmdline

        - -workspace

        - /runData/<WORKSPACE_NAME>

        - -project

        - <TEST_PROJECT_NAME>

        - -suite

        - Tests/<TEST_SUITE>.testsuite

        - -results

        - autoResults

        - -stdout

        - -exportlog

        - /runData/<TEST_LOG>.txt

        

 

        env:

          - name: RATIONAL_LICENSE_FILE

            value: <licenseServerPort>@<licenseServerIPAddress>

          - name: TEST_IMPORT_PATH

            value: /Tests/<TEST_ASSET_NAME>.zip

        image: mycluster.icp:8500/default/<imageName>:<imageVersion>

        name: <workbench_name>
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        ports:

        - containerPort: 7080

        - containerPort: 7443

        resources: {}

      restartPolicy: Always

 

status: {}

---

apiVersion: extensions/v1beta1

kind: Deployment

metadata:

  labels:

    io.kompose.service: agent1

    pt.classification: agent

  name: agent1

spec:

  replicas: 1

  strategy: {}

  template:

    metadata:

      creationTimestamp: null

      labels:

        io.kompose.service: agent1

        pt.classification: agent

        pt.name: agent1

    spec:

      containers:

      - env:

        - name: AGENT_NAME

          value: agent1

        - name: AGENT_IP

          value: <ClusterIPAddress>

        - name: MASTER_NAME

          value: <workbench_name>

        image: mycluster.icp:8500/default/<imageName>:<imageVersion>

        name: agent1

        resources: {}
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      restartPolicy: Always

status: {}

5. Run the deployment.yml  file to create the workbench and agent containers.

kubectl create -f deployment.yml

6. Get the list of containers and map the workbench container with a variable.

kubectl get pods

7. Run the command to copy the test assets to the workbench container.

kubectl cp tests/HelloWorldDocker.zip ${WB_POD}:.

Note:  You can get the ${WB_POD} variable assigned to the workbench name by using this 

command:

$ WB_POD=$(kubectl get  pods --selector pt.name=ptwb -o jsonpath='{.items[*].metadata.name}')

8. Run the command to execute the test.

kubectl exec -it ${WB_POD} -- bash -c 'export TEST_IMPORT_PATH=HelloWorldDocker.zip && cmdline 

 -workspace /tmp/ws -project HelloWorldDocker -schedule Schedules/vuSch -exportlog tl.log'

9. Run the command to copy the test results and log out.

kubectl cp ${WB_POD}:/tmp/CommandLineLog.txt

kubectl cp ${WB_POD}:/tmp/ws/.metadata/.log log.txt

kubectl cp ${WB_POD}:tl.log

10. Use IBM®  Cloud Private  Console to verify that the workbench and agent deployments are 

created and running successfully. Refer the test execution logs in the workbench and agent pod 

deployments.

11. Run the commands to stop the workbench and agent containers and verify the test run status in 

the exported logs.

kubectl delete -f deployment.yml

kubectl delete -f services.yml

Related information

Running automated tests with containerized agents on IBM Cloud Private  on page16
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Adjusting delays in HTTP tests
You can configure HTTP tests to use client-side processing delays. Client-side processing delays wait for 

the first character or last character that is received in a response for a previous request in order to better 

emulate the work done on the client computer. You can also scale the recorded delays in HTTP tests to 

change the rate at which a test runs.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Configuring HTTP client delays
You can configure delays for HTTP requests to emulate client-side processing delays. Applications that 

use client-side Javascript, such as Web 2.0 applications, often incur significant delays due to processing 

done on the client. You can emulate this client-side processing in HTTP tests. Running an HTTP test too 

quickly can cause unexpectedly low page response times to be reported, and can generate excessive load 

on the server under test.

To remove request delays from response times for all the tests, click Window  > Preferences  > Test  > Test 

Generation  > HTTP Test Generation  and select the Remove HTTP request delays from response times.
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To remove request delays from response times for a specific test, in the Test editor select HTTP Options 

and clear the Remove HTTP request delays from response times  check box.

To configure HTTP client delays:

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. Click the name of the test.

3. Click HTTP Options.

4. On the HTTP options  page, select Enable new client processing delays.

5. Under Test Contents, select the request on which to enable client processing delays.

6. Under Test Element Details, click the Advanced  tab.

7. Under Client Processing Delay, click Request.

A test editor window opens, listing the previous requests in the test.

8. Select the request to wait for, and then click OK.

9. For Release when, select First Character Received  or Last Character Received.

10. Type any Additional delay  to add in milliseconds.

Related information

Adjusting client delays for all tests  on page24

Adjusting client delays for all tests
To ensure consistency in client processing delays for all the tests in a user group, starting from 9.1.1.1, 

you can override the client processing delays of the tests and set it in the schedule.

To remove request delays from response times for all the tests, click Window  > Preferences  > Test  > Test 

Generation  > HTTP Test Generation  and select the Remove HTTP request delays from response times.

To remove request delays from response times for a specific test, in the Test editor select HTTP Options 

and clear the Remove HTTP request delays from response times  check box.

1. In the schedule editor, select the user group for which you want to set consistent client delay.

2. Click the Options  tab and click Edit Options.

3. Select the Override Test Client Delay  check box, adjust the HTTP requests delay, and click OK.
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Related information

Configuring HTTP client delays  on page23

Overriding the HTTP connection timeout value
By default, HTTP page connections use a timeout value of 190 seconds, which might not be sufficient for 

some applications. You can override the page connection timeout value for specific pages in a test.

To configure the HTTP connection timeout:

1. In the Test Navigator  view, browse to the test and double-click it.

The test opens.

2. Under Test Contents, select the request on which to enable client processing delays.

3. Under Test Element Details, click the Advanced  tab.

4. Under Timeout, select Override timeout value  and specify the timeout delay. You can specify a 

numeric value for the timeout delay or use a dynamic value from data sources such as dataset, 

variables, and data correlation.

Overriding WebSocket response timeout value
By default, the timeout value for WebSocket responses is 240 seconds at the test level. This value might 

be insufficient or in excess for different applications. You can customize the timeout value for specific 

responses.

1. In the Test Navigator  view, browse to the test and double-click it. The test opens.

2. Under Test Contents, select the request on which to enable client processing delays.

3. Under WebSocket Response Details, click the Advanced  tab.

4. Under Timeout, select Timeout activated  and specify the timeout delay. You can specify a numeric 

value for the timeout delay or use a dynamic value from data sources such as dataset, variables, 

and data correlation.

Related information

Recording a WebSocket test  on page
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Playing back HTTP tests faster than the recorded rate
If the client computer used for recording an HTTP test was slower than required, or if you want to emulate 

a faster client computer, you can increase the playback rate without altering the actual values in the 

recorded test by reducing the client delays proportionately. Similarly, you can slow down the client by 

increasing the client delays.

Each request in a recorded test includes a programmatically calculated delay before the request is issued. 

This delay is a statistical emulation of user behavior. To see a delay in a test, click a request, and examine 

the Test Element Details  area: 

You can scale the delay in these requests to change the rate that a test runs. This scaling occurs at the 

test level.

To scale the delays:

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. Click the name of the test.

3. In the Test Element Details  area, select a scaling percentage. Move the slider to scale the speed at 

which the HTTP requests are sent. You can specify a range from no delays to twice the recorded 

length. 

This scale is applied to all requests in the test.

Note:  If you increase playback speed dramatically, requests might occur out of order. To 

correct this problem, decrease playback speed until the test runs correctly.

You can also set a maximum HTTP delay. Click Window  > Preferences  >  Test  >  Test Generation  > 

HTTP Test Generation. Select the Protocol  tab, and enter a value for Maximum Request Delay. Although 

requests larger than this value are truncated in the generated test, the recorded test still contains the 

original values.
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Setting a launch configuration
Instead of using the default launch configuration, you can specify the file name for the execution results, 

the name of the folder for the execution results, and, for a test, the number of users.

You generally run a A schedule, in this context, is used to refer to both VU Schedule  and Rate Schedule  by 

right-clicking it and selecting Run  > Run VU Schedule  or Run  > Run Rate Schedule. However, you should 

set a launch configuration when:

• You want to specify a name for the execution results, or you want them in a separate folder.

• You plan to run a test outside of a A schedule, in this context, is used to refer to both VU Schedule 

and Rate Schedule, and you want to run the test with more than one user.

• You want the launch configuration to appear in your toolbar menu.

• You want the launch configuration to be available to other users.

To set a launch configuration:

1. In the Test Navigator, expand the project until you locate the schedule or test.

2. Right-click the schedule or test, and then click Run As  > Run configuration.

If the Perspectives page is displayed, keep the defaults.

3. In the Configurations  area on the left, click VU Schedule  or Rate Schedule, and then click New.

A test configuration, initially named New_configuration, is created. Typically, you supply a 

configuration name that is similar to the schedule name.

At this point, you can run the schedule if you click Run. However, you will not have created a 

meaningful configuration.

4. Click the Test Logs  tab and check the default settings. To change the default settings, clear the 

Use defaults  check box and type a file name for the execution results. The product appends a 

time stamp to this name. To overwrite the file each time that you run the configuration, select the 

Override existing test log  check box.

5. Click the Common  tab to inspect or modify your run preferences.

6. In Save as, select one of the following options:

Option Description

Local
This launch configuration is stored in your 

workspace, and it is not visible to other users.
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Option Description

Shared
Other users have access to the launch config

uration; you are asked where to store it.

7. For Display in favorites menu, select one or more of the following options:

Option Description

Run

The configuration is displayed in your Run 

toolbar menu. If you select a toolbar menu at 

all, this is the logical choice for a schedule or 

test.

Debug
The launch configuration is displayed in your 

Debug  toolbar menu.

Profile
The configuration is displayed in your Profile 

toolbar menu.

8. Verify that Launch in background  is selected. If you do not run the configuration in the background, 

you cannot do anything in Eclipse until it finishes running the configuration.

9. Click Apply, and then click Run  to run the configured schedule or test, or click Close  to save the 

configuration and run it later.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53
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Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Running a configured schedule
If you do not use the default launch configuration, you can configure the schedule and then run it.

You must configure the schedule before you run it. For more information, see Setting a launch 

configuration  on page 27.

1. In the Test Navigator, expand the project until you locate the schedule.

2. Right-click the schedule, and then click Run  > Run.

3. In the Configurations area on the left, click Test Schedule, and then click the name of the schedule 

to run.

4. Click Run.

While the schedule is running, the reports are updated in real time, and you can see the changes.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53
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Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Configuring multiple host names for a location
You can run several locations on the same computer by configuring multiple host names for a location. 

This configuration affects all tests running at that location; all tests will run with the configured port.

To configure multiple host names for a location:

1. Open the hosts file, which maps IP addresses to hosts, with an ASCII editor.

On Windows™, the hosts file is in C:\\Windows\system32\drivers\etc\hosts. On Linux™, 

the hosts file is in \etc\hosts

2. At the end of the hosts file, add your IP mappings. Use one IP address, but map it to two (or more) 

logical host names.

For example, you could add map the IP address 123.4.5.6. to two logical hosts, as show in the 

bottom two lines:

3. Create two deployment locations that have names identical to the names you added in the hosts 

file:

a. Open the schedule that contains the user group that you want to run on multiple hosts.

b. Open the user group, and click the Location  tab.
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c. Click Add  > Add New, and enter the location data. Make sure the locations have different 

directories (in this example, they are tempa and tempb).

d. Click Finish.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74
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Automating tests
You can run a schedule from the command line. You can also set preferences to export results after the 

run completes from the command line or from the workbench. Together, these features let you run tests 

and analyze results without opening the workbench. You can even write scripts to process the exported 

results.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Creating a command-line config file
Starting from V10.0.2, you can create command line config file from the product, which you can use while 

running tests or schedules from the command-line interface and Maven.

You must have performed the following tasks:

• Created test assets in a workspace.

• Installed Maven if you are running tests or schedules from the Maven build.

For information about creating tests or schedules and installing Maven, see related links.
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Previously, you created the config file manually by adding parameters to it for running the tests or 

schedules by using the config file from the command line. Now, you can create a command-line config 

file from the product by right-clicking the test asset. The required parameters are automatically assigned, 

and you can specify any optional parameters, while creating the config file. You can use this config file to 

run the tests or schedules from the command-line interface and Maven plug-in that is provided with the 

product as part of Maven build.

1. In the Test Navigator, browse and select the test  or schedule.

2. Right-click the test or schedule , and then click Create command line config file.

3. In the Create New Config File  window, enter a name for the new configuration file and then click 

Next.

4. Perform the following sub-steps in the Command Line Arguments  window:

a. Select the format of the config file from the following options:

• Regular  – Use this format to run tests or schedules from the command-line interface.

• Maven  – Use this format to run tests or schedules from the Maven build.

b. If you want to add more parameters to a config file, specify the values in the fields from the 

available configuration options.

5. Click Finish.

The Config file created  dialog box displays the location of the config file.

You must complete the following steps:

1. Close the product.

2. Run a test or schedules by using the config file either from the command-line interface or from the 

Maven build.

Related information

Running a test or schedule from a command line  on page33

Exporting report counters automatically  on page46

Activating secure storage of dataset passwords for test automation  on page49

Creating tests  on page

Testing with Maven  on page

Running a test or schedule from a command line  on page33
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Running a test or schedule  from a command line
You can run a test or schedule  without opening the product by using the command-line interface.

You must have set the Web Reports  preferences in the desktop client to view the status of the test run 

from the command line. See Accessing reports remotely  on page .

1. Navigate to the directory that contains the cmdline.bat  and cmdline.sh  files.

On Windows™  operating systems, this directory is located at 

productInstallationDirectory\cmdline. For example, C:\Program Files\IBM\SDP

\cmdline.

2. Issue the following command:

cmdline  -workspace  workspace_full_path  -project  proj_rel_path  -eclipsehome  eclipse_full_path 

-plugins  plugin_full_path  -schedule   sched_rel_path  -suite  suite_rel_path  -importzip 

file_full_path.zip  -varfile  variable_file_full_path  -servicename  service   -serviceargs 

service_args  -configfile  file_full_path  -results  result_file  -overwrite  {"true" | "false"}  -quiet 

-users  nn  -vmargs  JVM_args  -rate  RateRunnerGroupName=iterationNumber/duration, 

iterationNumber/duration-duration  Stage1=durationOfStage; Stage2=durationOfStage  -publish 

serverURL#project.name=projectName  -publish_for  {ALL,PASS,FAIL,ERROR, INCONCLUSIVE} 

-exportlog  log_full_path  -exportstats  local_dir_path  -exportstatsformat  name of the file format  

-timerange  "all, 5 Users, 10 Users"  -exportstatshtml  local_dir_path  -compare  "result_path1, 

result_path2"  -exportstatreportlist  stats_list  -execsummary  local_dir_path  -execsummaryreport 

reportID  -usercomments  "any user comment"  -publishreports  "FUNCTIONAL, MOBILE_WEBUI, 

STATS, TESTLOG"   -stdout   -swapdatsets  existing_dataset_file_path:new_dataset_file-path 

-hitory  jaeger,testlog,null  -overridermlabels  "label name 1,label name 2"

Notes:

• The workspace is locked after you issue the command. To check the progress of the test 

or schedule  during the run, invoke another workspace and open the project through that 

workspace.

• On Linux operating system, the command must start with cmdline.sh.

• The command line does not provide a way to specify the secure storage password for 

resource monitoring. You must provide the password in the workbench and ensure that it is 

stored and persisted in the schedule before you execute the schedule from the command 

line.

If a value contains spaces, enclose the value in quotation marks. To see the online help for this 

command while you are in the directory that contains the .bat file, type cmdline -help.

The following table explains each options:
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-work

space

Required. The complete path to the Eclipse workspace.

-project Required. The path, including the file name of the project relative to the work

space.

-eclipse

home

Optional.

The complete path to the directory that contains eclipse.exe.

For example, C:\Program Files\IBM\SDP

-plugins Optional. The complete path to the folder that contains the plugins. Typically, on 

Windows operating systems, this folder is located at C:\Program Files\IBM

\IBMIMShared\plugins.

Required. This option is required only if the folder is at a different location.

-schedule Optional. However, in a command, it is mandatory to use one of the following op

tions:

• -suite

• -schedule

• -servicename

You must not use the -schedule  option along with the other options. The path in

cludes the file name of the schedule to run relative to the project.

Starting from V9.2.1.1, you can execute multiple schedules simultaneously.

For example, -schedule  sch1:sch2:sch3

-suite Optional. However, in a command, it is mandatory to use one of the following op

tions:

• -suite

• -schedule

• -servicename

You must not use the -suite  option along with the other options. The path in

cludes the file name of the suite to run relative to the project.

Starting from V9.2.1.1, you can execute multiple tests simultaneously.

For example, -suite  test1:test2:test3.

-im

portzip

Optional. To import the project as test assets with dependencies into your work

space, use the -importzip  option. This command is available from V9.2.1.1 and 

later.
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You can execute test assets from the imported zip file, but you must specify the 

-importzip  {complete path where the zip file is stored on your computer}  option 

along with the -schedule  or  -suite  options.

For example, C:\User\Desktop\test1.zip

-varfile Optional. You can use this option to specify the complete path to the XML file 

that contains the variable name and value pairs.

-service

name

Optional. However, in a command, it is mandatory to use one of the following op

tions:

• -suite

• -schedule

• -servicename

You must not use the -servicename  option along with the other options. The path 

includes the file name of the service to run relative to the project. Instead of run

ning a performance test, the specified service is run when it is available.

-ser

viceargs

Optional. You can use this option to specify a series of arguments to pass to the 

service specified.

For example, -serviceargs  "-myserviceparm1 myserviceparm1value"

The values are in quotation marks as they contain spaces.

-config

file

Optional. You can use this option to specify the complete path to a file that con

tains the parameters for a test or schedule  run. Each parameter must be on a 

single line. To create a configuration file, you must use an editor that does not 

wrap lines. Any parameters, whether required or optional, can be set in the con

figuration file. The command line parameters override the values in this file.

Notes:

• If you are creating a config file manually, the file must be in the UTF-8 for

mat. You must not use quotation marks in this file even for values that 

contain spaces.

• You can create command line config file from the product, which you can 

use while running tests or schedules  from the command-line interface or 

Maven. For more information about how to create a command line config 

file from the product, see related links.

-results Optional. You can use this option to specify the name of the results file. The de

fault result file name is the test or schedule  name with a time stamp appended. 
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You must specify a folder name that is relative to the project to store the test re

sults.

For example, -results  folder/resultname

-over

write

Optional. Determines whether a result file with the same name is overwritten. 

The default value, false, indicates that the new result file is created. If the value 

is true, the file is overwritten and retains the same file name. You must use dou

ble quotes “”  for values true  or false.

-quiet Optional. Turns off any message output from the launcher and returns to the 

command shell when the run or the attempt is complete.

-users Optional. Overrides the default number of virtual users in the run. For a schedule, 

the default is the number of users specified in the schedule editor. For a test, the 

default is one user. This option creates a new copy of the schedule that contains 

the specified number of users.

-vmargs Optional. To specify the Java™  maximum heap size for the Java™  process that 

controls the command line playback, use the -vmargs  option with the -Xmx  argu

ment.

For example, when you use-vmargs  -Xmx4096m, specify a maximum heap size 

of 4096m. This method is similar to specifying -Xmx4096m  in the eclipse.ini file 

for the workbench when playing back the test from the user interface.

-rate Optional. You can use this argument to specify a rate that you want to achieve 

for a workload in the Rate Runner group. For example, -rate  "Rate Runner Group 

1=1/s, 3/m; Rate Runner Group 2=5/s, 10/s".

Here, Rate Runner Group 1  is the name of the Rate Runner group that has two 

stages. The desired rate for the first state is one iteration per second and the 

rate for the second stage is three iterations per minute.

Note:  The Rate Runner group name must match with the name in the Rate 

Schedule.

-duration Optional. You can use this argument to specify the duration of the stages in the 

Rate Schedule.

For example, -duration  Stage1=10s; Stage2=3m

Note:  The stage number specified must exist in the Rate Schedule.
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-publish Optional. You can use -publish  parameter to publish test results to Rational® 

Test Automation Server. You can use the following options along with the -pub

lish  parameter:

• no

You can use the no  option if you do not want to publish test results after 

the run. This option is useful if the product preferences are set to publish 

the results, but you do not want to publish them.

• You can use any of the following options to specify the project name:

◦ serverURL  #project.name=projectName&teamspace

.name=name_of_the _teamspace

◦ serverURL  #project.name=projectName&teamspace.alias=name_

of_the _teamspace_alias

You must consider the following points while providing the project name:

◦ If the project name is not specified, then the value of the  -project 

parameter is used.

◦ If you have a project with the same name in different team spaces, 

then you can append either the &teamspace.name=name_of_the 

_teamspace  or &teamspace.alias==name_of_the_teamspace_

alias  options along with the -publish  parameter.

For example: -publish “https://local

host:5443/#project.name=test&teamspace.name=ts1”

Where:

▪ https://localhost:5443  is the URL of the server.

▪ test  is the name of the project.

▪ ts1  is the name of the team space.

Note:  If the name of the project or team space contains a space character, 

then you must replace it with %20.

For example, if the name of the team space is Initial Team Space, then you must 

provide it as Intial%20Team%20Space.

Remember:  If you provide the server and the project details under Window  > 

Preferences  > Test  > Rational Test Automation Server  in the product and if you 

use serverURL#project.name=projectName  along with the -publish  para

meter, the server details in the command-line interface take precedence over the 

product preferences.
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Important:  You must provide the offline user token for the server by using 

the RTCP_OFFLINE_TOKEN  environment variable before you use the -publish  pa

rameter in the command-line interface.

-publish_

for

Optional. You can use this option to publish the test results based on the com

pletion status of the tests:

• ALL - This is the default option. You can use this option to publish test re

sults for any text execution verdict.

• PASS - You can use this option to publish test results for the tests that 

have passed.

• FAIL - You can use this option to publish test results for the tests that 

have failed.

• ERROR - You can use this option to publish test results for the tests that 

included errors.

• INCONCLUSIVE - You can use this option to publish test results for the 

tests that were inconclusive.

You can add multiple parameters separated by a comma.

-export

log

Optional. You can use this parameter to specify the file directory path to store 

the exported HTTP test log, UI Test report, and Unified report.

Starting from V10.0.1, by using the -exportlog  parameter, you can provide multi

ple parameter entries when running multiple tests. You must use a colon to sep

arate the parameter entries.

For example: -exportlog  c:/logexport.txt:c:/secondlogexport.txt

If there are multiple -suite  parameter entries with a single -exportlog  parameter 

entry, then the -exportlog  parameter generates the appropriate number of test 

logs by appending 0, 1, 2, and so on to the -exportlog  parameter entry name.

For example: -suite  "sampletest1:sampletest2:sampletest3"  -exportlog  c:/logex

port.txt  The command generates the following test logs:

• logexport_0.txt

• logexport_1.txt

• logexport.txt

The last test log generated has the same name as that of the initial -exportlog 

entry.
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Note:  If there are multiple -suite  and -exportlog  parameter entries, the num

ber of -suite  entries must match with the number of -exportlog  entries. Other

wise, the following error message is displayed:

Error, number of -suite and -exportlog entries do not match.

-export

stats

Optional. You can use this option to export reports in comma-separated values 

(CSV) format, with the file name derived from the report name. This directory can 

be relative to the project or a directory on your file system. If the -exportstatre

portlist  option is not specified, the reports specified on the Export Reports  page 

of the Performance Test Report  preferences are exported.

-export

statsfor

mat

Optional. You can use this option to specify a format for the result that you want 

to export along with the -exportstats  option. You must use at least one of the fol

lowing parameters with the -exportstatsformat  option:

• simple.csv

• full.csv

• simple.json

• full.json

• csv

• json

For example, -exportstats  <local_dir_path>  -exportstatsformat  simple.json

You can add multiple arguments separated by a comma.

For example, -exportstats  <local_dir_path>  -exportstatsformat  simple.json, ful

l.csv

When you want to export both simple and full type of test results in a json or csv 

format, you can specify json  or csv  as the arguments in the command. When the 

test run completes, the test result exports to simple.json and full.json files.

For example, -exportstats  <local_dir_path>  -exportstatsformat  json

You can select the Command Line  check box from the product preferences 

(Window  > Preferences  > Test  > Performance Test Reports  > Export Reports) 

when you want to export test results to one of the selected formats after the test 

run completes.

Remember:  When you run the test from the command line, and if you use 

the  -exportstats  parameter, then the command line preferences take prece
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dence over the preferences set in the product. Therefore, by default, the test re

sult exports to a CSV format.

For example, when you select the Command Line  option and Report format  to 

json  in the product preferences, and run the test from the command-line inter

face without using the -exportstats  option. The result is exported to a json file 

after the test run is complete.

-

timerange

Optional. You can use this option along with -exportstats, -exportstatshtml, and 

-execsummary  to export test results within one or more time ranges. The value 

is the time range that you specify in the schedule.

For example, “all, 5 Users,10 Users”. You must separate time ranges with a com

ma and use double quotation marks (“”) when there is space in a time range.

-export

statshtml

Optional. When you want to export web analytic results, you can use this option. 

The results are exported in the specified directory. You can then analyze the re

sults on a web browser without using the test workbench.

-compare You can use this argument along with -exportstatshtml  and -execsummary  to 

export the result in compare mode. The value can be paths to the runs and are 

relative to the workspace. You must separate the paths by a comma.

-export

statre

portlist

Optional. You can use this option to specify a comma-separated list of report IDs 

along with -exportstats  or -exportstatshtml  to list the reports that you want to 

export in place of the default reports, or the reports selected under Preferences. 

To view this setting, navigate to Window  > Preferences  > Test  > Performance 

Test Reports  > Export Reports.

To copy the report IDs list into your command line, navigate to Window  > Pref

erences  > Test  > Performance Test Reports  > Export Reports. Under Select re

ports to export, select the required reports, and click Copy ID to clipboard. You 

can then paste the clipboard content on to your command line editor

-exec

summary

Optional. You can use this option to export all of the reports for the test run in a 

printable format, also known as an executive summary, to the local computer. 

You must specify the path to store the executive summary.

-exec

summa

ryreport

Optional. You can use this option to export a specific report as an executive 

summary for the test run to the local computer. You must specify the ID of the 

report to export.
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For example, to export an HTTP performance report, specify http. You must use 

this option along with -execsummary.

To copy the report IDs list into your command line, navigate to Window  > Pref

erences  > Test  > Performance Test Reports  > Export Reports. Under Select re

ports to export, select the required reports, and click Copy ID to clipboard. You 

can then paste the clipboard content on to your command line editor

-user

com

ments

Optional. You can add text within double quotation mark (“”) to display it in the 

User Comments  row of the report.

Note:  You can use the file CommandLine.exe  to run the command to add 

comments in a language that might not support Unicode characters on Windows 

operating system.

-pub

lishre

ports

Optional. You can use this option to publish test results in Rational®  Test Au

tomation Server. The parameters that you can use with it are the following:

• FUNCTIONAL

• MOBILE_WEBUI

• STATS

• TESTLOG

For example, -publishreports  "STATS, TESTLOG"

You must prefix with “!”  to publish all the reports except the specified one.

For example, -publishreports  "! TESTLOG"

All the reports except the TESTLOG report is published to Rational®  Test Au

tomation Server  after executing the command.

-stdout Optional. You can use this option to display the information about the test or 

schedule  on the command line.

After you run a test or schedule  from the command line, the following outputs 

are displayed to give you the overall information of the test or schedule:

• --VERDICT: The verdict of the test or schedule.

• --REMOTE_RESULT: The URL of the result published to Rational®  Test Au

tomation Server.

• --REMOTE_RESULT_UI: The URL of the result published to Rational®  Test 

Automation Server  and can be opened in a browser to analyze the result.

• --LOCAL_RESULT: The path of the result saved locally.
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For example, -workspace  workspace_full_path  -project  proj_rel_path  -schedule 

sched_rel_path  -publishpublish_url  -stdout

-swap

datasets

Optional. Use this option to replace dataset values during a test or schedule. If a 

test or schedule  is associated with a dataset, you can replace the dataset at run 

time while initiating the run from the command line.

You must ensure that both original and new datasets are in the same workspace 

and have the same column names. You must also include the path to the dataset 

when you run the -swapdatasets command.

For example, -swapdatsets  /project_name/ds_path/ds_filename.csv:/project_

name/ds_path/new_ds_filename.csv

You can swap multiple datasets that are saved in a different project by adding 

multiple paths to the dataset separated by a semicolon.

For example, -swapdatsets  /project_name1/ds_path/ds_filename.csv:/project_

name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_file

name.csv:/project_name2/ds_path/new_ds_filename.csv

-history Use this command when you want to view a record of all events that occurred 

during a test  or schedule  run. However, you must use the command suffixed with 

any of the following options:

• jaeger: To send test logs to the Jaeger UI during the test  or schedule  run.

• testlog: To send test logs as traditional test logs in Rational®  Perfor

mance Tester  during the test   or schedule  run.

• null: To send no test logs either to the Jaeger UI or Rational®  Perfor

mance Tester  during the test   or schedule  run.

For example:

-workspace workspace_full_path -project proj_rel_path 

-suite suite_rel_path -stdout -history comma delimited list of modes

-workspace C:/Users/IBM/rationalsdp/test_ws -project Project1 

-suite test1.testsuite -stdout -history jaeger

Note:  You can add multiple options separated by a comma to send test logs 

during the test   or schedule  run to Rational®  Performance Tester  and the Jaeger 

UI.

For example:
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-workspace C:/Users/IBM/rationalsdp/test_ws -project Project1 

-suite test1.testsuite -stdout -history jaeger, testlog

For more information about how to view test logs in the Jaeger UI and Rational® 

Performance Tester, see related links.

- overrid

ermlabels

Optional. By using the -overridermlabels  command, you can control the Re

source Monitoring sources that are required to collect in a performance sched

ule during the schedule run.

You can use this command if you want to perform any of the following actions:

• To enable the Resource Monitoring from Service  option for a perfor

mance schedule if the Resource Monitoring from Service  option is not 

enabled from the schedule editor in Rational®  Performance Tester.

• To ignore Resource Monitoring sources that were set in the performance 

schedule and to change for a label matching mode.

• To replace an existing set of Resource Monitoring labels that were set 

in the performance schedule and run the schedule with a new set of Re

source Monitoring labels.

Note:  You must add the Resource Monitoring labels to the Resource 

Monitoring sources on the Resource Monitoring  page in your Rational® 

Test Automation Server  project. You can use these labels for adding the 

Resource Monitoring sources to run the performance schedule through 

the command line interface.

The command accepts a comma-separated list of labels.

For example, if you have added a label in Rational®  Test Automation Server  for 

a Resource Monitoring source as rm1, then run the following command to collect 

data from the source as follows:

-workspace workspace_full_path -project proj_rel_path 

-suite suite_rel_path -overridermlabels "rm1"

Note:  You can add multiple labels to a performance schedule separated by 

a comma  to collect data from the multiple sources during the schedule run. For ex

ample:

-workspace workspace_full_path -project proj_rel_path

 -suite suite_rel_path -overridermlabels "rm1,rm2,rm3"
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If your label contains a comma (,), then when running the -overridermlabels 

command, you must replace the single comma  with the double comma  in the la

bel.

For example, if you have added a label to a Resource Monitoring source as 

(rm1,test), then you must run the following command to collect data from 

source as follows:

-

workspace workspace_full_path -project proj_rel_path -suite suite_rel_path -overridermlabe

ls "rm1,,test"

To stop the test run, you can open another command prompt window and use one of the following 

options with the cmdline  option:

Com

mand

Description

-sto

prun

Optional. Stops the test run after the specified number of seconds. The block is ex

ecuted, and the test log is transferred before stopping the run. You must use the 

-workspace  command and specify the location of the workspace.

-

aban

don

run

Optional. Stops the test run immediately. You must use the -workspace  command 

and specify the location of the workspace.

Note:  Messages are displayed to indicate when the test or schedule  is launched and when it is 

completed unless you include the -quiet  option.

Examples of the commands for running tests from the command line

You can run tests from the command line either by using a configuration file or by directly specifying the 

path of the test in the command. Each command-line option must be followed by an appropriate value.

The contents of a sample configuration file, config_file1  are as follows:

workspace=D:\My Workspace

eclipsehome=C:\Program Files\IBM\SDP

plugins=C:\Program Files\IBM\IBMIMShared\plugins

project=myProject

suite=mytestsuite
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To run tests from the command line by using the sample config file config_file1  you must use the 

following command:

cmdline –configfile <config file path>

For example:

cmdline –configfile E:\Workspace1\Project1\Tests\config_file1.txt

To run the tests from the command line without using a configuration file, you must specify the path of 

the tests along with the command as follows:

cmdline <path of the test>

For example:

cmdline -workspace “D:\My Workspace” -eclipsehome "C:\Program Files\IBM\SDP" -plugins "C:\Program 

Files\IBM\IBMIMShared\plugins" -project myProject -suite mytestsuite

The -workspace  command-line option is followed by a value that contains a space. If the value contains 

space, then you must enclose the value, D:\My Workspace  within quotes. Otherwise, you can provide the 

value without quotes.

After you run the test or schedule, you may want to export the results for further analysis. For more 

information, see Exporting report counters automatically  on page .

Related information

Creating a command-line config file  on page32

Exporting report counters automatically  on page46

Activating secure storage of dataset passwords for test automation  on page49

Viewing test logs in Jaeger  on page

Creating a command-line config file  on page32

Viewing test logs  on page

Exporting report counters automatically
You can change the test preferences so that report counters are automatically exported at the end of a 

run. This option is useful when you run a schedule from the command line because you can automatically 

export results without opening the workbench.

To automatically export report counters to a CSV file when a test or schedule is complete:

../../com.ibm.rational.test.lt.doc/topics/txrepcountersauto.html
../../com.ibm.rational.test.lt.doc/topics/txrepcountersauto.html
../../com.ibm.rational.test.lt.doc/topics/txrepcountersauto.html
../../com.ibm.rational.test.lt.doc/topics/txrepcountersauto.html
unique_42
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1. Open the Preferences page. Click Windows  > Preferences.

2. Open the Export Reports page. In the Preferences  window, expand Test  and Performance Test 

Reports, and then select Export Reports.

3. In the Export Reports window, select the options as follows:

Option Description

Export reports when run completes from

Select Command line  or Workbench. If you 

select Command line, you can also select 

Print simple CSV reports to command line  to 

display the exported data on the command 

line (standard output) as well as export it to 

the CSV file. The file is displayed after the 

command line run has completed.

Simple (counters as lines, 

time ranges as columns)

To export a simple report in the CSV format, 

select this check box.

List All Time Ranges  - Select this check box 

to include data from all the time ranges. The 

Entire Run time range is included by default.

Include per instance counters: Select this 

check box to include counters for all the page 

elements.

Export each agent separately  - Select this 

check box to export data for each agent to a 

separate CSV file.

One file per agent  - Select this check box to 

export data for each agent (location) to differ

ent sections in a single CSV file.

Full (time intervals as lines, 

counters as columns)

To export a comprehensive report that in

cludes the result name, node name, and time 

ranges, select this check box. Typically, you 

do not include these details unless you are 

exporting customized reports that include 

counters from specific test runs.

Split output if column exceeds  - Because 

there will be a lot of data, select this check 
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Option Description

box to create multiple CSV files if the number 

of columns exceed the specified limit.

Include per instance counters  - Select this 

check box to include counters for all the page 

elements.

Export each agent separately  - Select this 

check box to export data for each agent (lo

cation) to different sections in the same CSV 

file.

One file per agent  - Select this check box to 

export data for each agent to a separate CSV 

file.

HTML report
Select this check box to export full report da

ta in the HTML format.

Executive Summary report

Select this check box to export the report in 

the HTML format. This report summarizes 

the state of the test or schedule run and dis

play the report on only one HTML page. It can 

be printed.

Select reports to export

Expand the tree, if necessary, to display the 

type of report to export. If you select more 

than one report, each report is exported to a 

separate CSV file in the Test Runs directory.

Show Report Ids  - Select this check box to 

view the ID of each report. The IDs are used 

when exporting the specific reports from 

command line.

4. Click Apply.

The CSV file is called results_file_name.report_name.csv. It contains metadata about the test run, a 

blank line, and then lists each counter and its last value. Each counter is on a separate line.



Chapter 1. Test Execution Specialist Guide

Related information

Creating a command-line config file  on page32

Running a test or schedule from a command line  on page33

Activating secure storage of dataset passwords for test automation  on page49

Activating secure storage of dataset passwords for test automation
Starting from 9.2.0.1, you can store the encrypted dataset passwords in the Eclipse secure storage 

location on the computer. Now, when you run the tests from the command line, the product automatically 

uses the password and completes the test run. Prior to 9.2.0.1, you could not run the tests from the 

command line with encrypted datasets.

1. Click Window  > Preferences  > Test  > Test Execution  > Automation Security.

2. Select the Activate Secure Storage Support for Encrypted Datasets  check box.

The password is stored in the Eclipse secure storage. Do not share the computer's login 

credentials with others.

3. To add the encrypted datasets, click Add, select the encrypted dataset, and click OK.

You will be prompted to enter the dataset password that you used when encrypting the dataset.

4. Enter the password and click OK.

When you run the tests from the command line, the test runs will complete successfully without the 

need to specify the password. If another user runs the same tests with encrypted datasets, the dataset 

password must be entered for the tests to run successfully.

Related information

Creating a command-line config file  on page32

Running a test or schedule from a command line  on page33

Exporting report counters automatically  on page46

Controlling cache sizes
If you use an infinite loop and the number of cached responses in a test increases exponentially, you can 

set a limit to cache for a user group in the schedule.
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When the cache limit is reached, the least-recently accessed cached entry is released to accommodate 

a new entry. Also, when a test follows another test in the schedule, you can clear the cache before a test 

starts.

1. To clear the cache before a test starts, from the Test Navigator, open a test.

2. Click the HTTP Options  tab and select the Clear page cache when the test starts  check box.

3. To set a limit to the number of cache entries, in the Test Navigator, navigate to a schedule and 

double-click it to open it.

4. Click the user group for which you want set the cache limit.

5. Click the Options  tab and then click Edit Options.

6. Select the Set cache size limit  check box and, in the Maximum cache size  field, type a numeric 

value.

This value indicates the number of entries allowed for a user.

7. Click OK  and save the schedule.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74
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Increasing memory allocation
The virtual users that access your web server require memory to prepare requests, send requests, and 

receive responses. Because the amount of memory is not automatically set on remote computers, you 

might receive an out-of-memory error. To correct this situation, increase the memory allocation for that 

computer.

If you receive an out-of-memory error when you run a test or schedule, override the default amount of 

memory that is allocated for that computer. To do this, set the RPT_VMARGS property, which overrides 

RPT_DEFAULT_MEMORY_SIZE. After the first successful execution, IBM®  Rational®  Performance Tester 

automatically sets value for RPT_DEFAULT_MEMORY_SIZE, which represents the maximum heap that will 

be specified by Rational®  Performance Tester  in subsequent executions.

Note:  Ensure there is at least one successful execution after all locations are created so 

RPT_DEFAULT_MEMORY_SIZE exists.

Tip:

If you see out-of-memory issues, it is a good practice to first check the javacore*  file. You can also look 

at the results and verify that the server is responding correctly because many times errors can lead to 

excessive resource consumption. You can also monitor memory usage with Task Manager or other tools 

at varying user load levels such as 10, 50, 100, 500 or 1000 users and use that data to make an estimate 

of the memory needs per virtual user and then project memory requirements for larger user loads. In 

some cases the best solution is to add another agent.

Rational®  Performance Tester  sets heap size for RPT_DEFAULT_MEMORY_SIZE based on the bit-type of 

the JRE:

• For 32-bit Java Runtime Environment (JREs), Rational®  Performance Tester  sets 70% of the size of 

physical memory to RPT_DEFAULT_MEMORY_SIZE. Typically, the maximum limit is set to 1200m.

• For 64-bit JREs, some workloads might perform better with a lesser heap size than 70% of physical 

memory up to a maximum of 12000m.

To increase the memory allocation on a remote computer:

1. In the Test Navigator (from your local computer), expand the project until you find the deployment 

location that you want to change.

Deployment locations are represented by the  icon.

2. Right-click the deployment location, and then click Open.

3. Under Property Groups, click the General Properties  link, and then click Add.

4. In the New Property window:
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a. In the Property Name  field, type RPT_VMARGS.

b. In the Operator  field, confirm that the operator is =.

c. In the Property Value  field, type -Xmxnnnnm, where nnnn  is the amount of memory, in 

megabytes, and then click OK.

If you need to set multiple RPT_VMARGS  values for a location, place them in the same property entry 

and separate them with a space. Do not use multiple property entries to set multiple RPT_VMARGS 

values for a location.

The following New Property  window sets maximum heap to 1200 megabytes:

Tip:  It is a good practice is to monitor memory usage with Task Manager or other tools at 

varying user load levels such as 10, 50, 100, 500 or 1000 users and use that data to make an 

estimate of the memory needs per virtual user and then project memory requirements for larger 

user loads. In some cases the best solution is to add another agent.

If you have increased the available memory and you still receive out-of-memory errors, add more remote 

computers for your user groups. For information about how to do this, see Running a user group at a 

remote location  on page .

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15
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Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74

Controlling the test runs from web analytics report
When a schedule is in the running state, you can perform the following actions from the web analytics 

reports to cater to your need.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Debugging HTTP tests  on page59

Debugging Citrix tests  on page74
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Changing the number of virtual users during a run
If the number of virtual users that was defined initially is incorrect, you can correct the number of users, 

and apply the change to one stage or to all of the remaining stages in the schedule.

1. From the test editor, click Run Test. The execution report is opened either in the internal or external 

browser, and the state of the run is shown as Running.

2. During the run, click Running  > Change Users Number.

3. In Change number of users  dialog box, select one of the following options:

Option Description

Add users

If a schedule contains only percentage 

groups, the virtual users are added by propor

tion. For example, assume that your schedule 

contains three user groups, assigned at 20%, 

30%, and 50%. If you add 10 virtual users, two 

added are to the first group, three are added 

to the second group, and five are added to the 

third group.

If a schedule contains both absolute and per

centage groups, the absolute groups are as

signed first. For example, assume that your 

schedule has one user group that is fixed at 

10 users, and only one virtual user is running 

in that group. You add 100 virtual users. Nine 

virtual users are added to the absolute group, 

and the remaining virtual users are appor

tioned among the percentage groups.

Remove users

Users are removed proportionately from user 

groups according to each user group's per

centage value. The time at which users are 

asked to stop is controlled by the Change 

rate  that you set in the schedule.

Apply to all remaining stages

Click to apply the change to all remaining 

stages in the schedule run, and clear to apply 

the change only to the current stage.
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4. Click Change.

The number of users is changed for the specified stages.

Changing the rate during a run
Typically, you specify the desired rate for the Rate Runner group in the Rate Schedule. However, due to 

various reasons, you might want to change the rate when the Rate Schedule  is running.

For example, you apply the load iteratively. Therefore, in the Rate Schedule, you specify a moderate rate. 

If the run is progressing steadily and there is scope to apply more load, you can increase the rate. When 

you change the rate, the changed rate is applied to the remainder of the current stage. The next stage will 

automatically select the rate defined in the schedule editor.

To change the rate during a run:

1. From the Test editor, click Run Rate Schedule. The execution report is opened either in the internal 

or external browser, and the state of the run is shown as Running.

2. During the run, click Running  > Change Rate.

The Change Rate  dialog box displays all the Rate Runner groups that are defined in the Rate 

Schedule.

3. To specify another rate for the Rate Runner group, in Target Rate, specify the rate.

Releasing virtual users from synchronization points
To record the response time of the system under test at different points, you can release virtual users 

either all together or in staggered intervals. You can release virtual users from synchronization points 

during a run.

Add synchronization points to a schedule. See Synchronizing users  on page

1. From the test editor, click Run Test. The execution report is opened either in the internal or external 

browser, and the state of the run is shown as Running.

2. During the run, click Running  > Manage Synchronization Points.

3. Select the synchronization points to release, and click Release.

Note:  Typically, the virtual user wait time is based on the time that the last user arrives 

at the synchronization point. However, if a virtual user arrives after you manually release a 

synchronization point, the user wait time is instead based on the time at which the synchronization 

point was released.
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Changing the stage duration during a run
Increase or decrease the duration of the current stage during a schedule run. You can change the duration 

of a stage that is set to run for a specified time, but not for a stage that is set to run until the work is 

complete. You can change the duration of a stage when the status is Running, but not when the status is 

Ramping  or Settle Time.

1. From the test editor, click Run Test. The execution report is opened either in the internal or external 

browser, and the state of the run is shown as Running.

2. During the run, click Running  > Change current stage duration.

3. In the Change Stage Duration  window, type the new stage duration in Run for specified period of 

time. Type a value that is longer than the amount of time that has elapsed for the current stage. 

Use the list to change the time units.

4. Click Change.

The duration of the current stage changes.

Changing the log level during a run
You can change the log level to determine problems during a run. By default, only warnings and severe 

errors are logged. Typically, you change this level only when requested to do so by IBM®  Software 

Support.

Although the test log provides general information about problems that occur during a run, you might 

need to investigate certain problems further by examining a detailed trace of the run. In general, change 

the problem determination level only when asked to by technical support. However, under certain 

conditions, you yourself might want to change the problem determination level. For example, if problems 

occur when a run reaches a certain number of users, you might increase the level to Config, which is the 

most detailed level that you will generally use.

To change the log level during a run:

1. From the test editor, click Run Test. The execution report launches either in the internal or external 

browser, and the state of the run is shown as Running.

2. During the run, click Running  > Change Log Level.

3. To change the log level, select any of the following options:
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Option Description

All, Finest, Finer, Fine
Set these options only if you are requested to 

do so by technical support.

Config

Logs static configuration messages. Config

uration messages, which include hardware 

specifications or system profiles, require no 

corrective action.

Info

Logs informational messages. Information

al messages, which include system state, re

quire no corrective action.

Warning

Logs warning messages. This is the default 

setting. Warning messages, which might indi

cate potential problems, require no corrective 

action.

Severe

Logs critical and unrecoverable errors. Crit

ical and unrecoverable messages interrupt 

normal program execution, and require cor

rective action.

None Turns logging off.

4. Click Change.

When a user group runs on your local computer, the problem determination logs are in the 

deployment_root  directory in your workspace. When a user group runs at a remote location, which 

is the typical use case, each remote location has a deployment directory, which you define and which is 

listed on the Locations page for that user group.

Note:  Common Base Event XML logs from remote locations use Universal Coordinated Time (UTC), 

also called Zulu time, which is likely different from your local time. For example, Eastern Standard Time 

(EST) is 5 hours behind UTC time.

To view the problem determination log, open the log file in an XML editor. Select the log whose timestamp 

matches that of the problem run. The most recent log has the suffix 00.log.
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Stopping test runs
You can stop a test run before it is complete. For example, you might detect serious problems in the run 

and not want to wait for it to finish. When stopping the test run, you can choose to save the results and 

the test log of the run.

To stop a test run on the local computer, use this command cmdline.bat -stoprun -workspace "c:

\myWorkspace".

To stop a test run from a remote computer, you can send the REST API command HTTP POST to 

http://hostNameOrIP:7878/executioncontrol/stoptestrun  with POST data {\"btnExecFinally\":true, 

\"btnResultCollection\":true,\"timeout\":30,\"timeoutScale\":\"sec\"}.

For instance, you can use Curl to send the POST command.

curl "http://hostNameOrIP:7878/executioncontrol/stoptestrun" -d "{\"btnExecFinally\":true, 

\"btnResultCollection\":true,\"timeout\":30,\"timeoutScale\":\"sec\"}".

Table  4. POST arguments

Argument Description

btnExecFinally Indicates whether to run the Finally block in the 

schedule.

btnResultCollection Indicates whether to collect the results for the 

test.

timeoutScale Indicates the units of time such as "milli", "sec", 

"min", "hour".

If you do not require test results and logs, abandon the test by clicking Running  > Abandon Test Run  or by 

using the command cmdline.bat -abandonrun -workspace "c:\myWorkspace".

1. During a test run, click Running  > Stop Test Run.

2. In the Timeout  field, type a number and select a time unit.

If you are running HTTP tests and want the results, consider selecting a duration that is long 

enough for a page to return.

3. Optional:  To collect the results and the test log until the time the test ran, select Collect test 

results and history. Typically, the partially run report is useful for debugging specific issues. If you 

do not select the check box, the report is not generated.

4. Optional:  To stop the execution of the test in the Finally block, clear  Execute Finally block.

5. Click Stop.

The test stops after the timeout.
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Debugging HTTP tests
If a test does not behave as expected during playback, you can use the protocol data and test log to assist 

in debugging the test.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging Citrix tests  on page74

HTTP debugging overview
If a test is not behaving as expected, you can use the Protocol Data  view to debug the test. This view can 

be useful after you record a test, after you make changes to an existing test by adding datasets or data 

correlation, or after you make changes to the system under test.

The Protocol Data  view displays data that was recorded or played back. The Protocol Data  view can also 

display data in real time as tests and schedules run. To see recorded data, click a test element in the test 

editor. To see data played back after running tests, click an element in the test log. The Protocol Data  view 

updates accordingly. Substituted data is highlighted on the Request, Response Headers  and Response 
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Content  pages when you view test log or test editor elements that use data correlation. The Protocol Data 

view contains these pages:

Request

This page displays all request data sent to a server. This includes the URL of the requested 

resource, request headers, cookies, and form data.

Response Headers

This page displays the response status line and header fields that are received from a 

server.

Response Contents

This page displays the response contents, in text form, that is received from a server.

Browser

This page attempts to display the response contents as a web browser would display the 

contents. Because the protocol data is used instead of data from a live web server, playback 

might be successful even though the Browser  page might not render the contents exactly 

as a web browser would. Pages that might not display correctly include those that have 

resources cached on a web server and those that use Javascript and framesets extensively.

Event Log

This page displays event summary information for each HTTP page in the test. After a run, 

when you select a particular user from the test log, the page displays information about that 

user.

During a run, the page displays real-time information if real-time protocol data support is 

enabled. To enable this support, click Window  > Preferences  > Test  > HTTP Protocol Data 

View, and then select Enable real-time protocol data support.

Related information

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a test run  on page62

Watching a virtual user during a schedule run  on page63

Replaying a virtual user after a run completes  on page66

Viewing the playback summary of a virtual user  on page67
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Inspecting HTTP test logs in the Protocol Data view  on page70

Managing HTTP information in the Protocol Data view  on page71

Debugging HTTP Data Correlation Errors
Data correlation errors are very common and sometimes complex to fix. A dedicated Eclipse-based 

perspective can guide you to debug data correlation errors.

Using the perspective, you can fix the following data correlation issues:

• Missing reference for substitutions for the substitution sites. The product tries to locate values 

greater than seven characters in length and is alphanumeric.

• Missing substitution site in HTTP headers for values greater than seven character in length and is 

alphanumeric. The value to be substituted will be highlighted.

• Invalid regular expression.

The content in the different views of the perspective is connected to each other. So, when you select a 

request in the Test view, the log event corresponding to that request is displayed in the Test Log view. The 

Compare tab in the Protocol Data view displays the comparison between the selected request in the Test 

and the Log views. The Event Log selects the proper page event. The behavior is same if you select an 

event in the Test Log. The Test, the Event Log, and the Compare tab will update themselves to match that 

event. All tabs work in conjunction with each other.

1. In the Test Navigator view, right-click a result that contains data correlation errors and click Debug 

HTTP Data Correlation Errors.

The HTTP Test Debug perspective displays the first error.

2. Use the Compare  tab in the Protocol Data view to compare the requests or responses of the Test 

and Test Log.

3. Use the Problems  tab to view the recommended fix. Click Fix  to fix the error. You can navigate 

between the errors by clicking Previous  and Next.

Related information

HTTP debugging overview  on page59

Watching a virtual user during a test run  on page62

Watching a virtual user during a schedule run  on page63

Replaying a virtual user after a run completes  on page66
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Viewing the playback summary of a virtual user  on page67

Inspecting HTTP test logs in the Protocol Data view  on page70

Managing HTTP information in the Protocol Data view  on page71

Watching a virtual user during a test run
The Browser  page in the Protocol Data  view displays browser results during an individual HTTP test run. 

The Browser  page displays each page in real time.

Verify that real-time support is enabled. Click Window  > Preferences  > Test  > HTTP Protocol Data View

1. Verify that Enable real-time protocol data support  is selected.

2. Select which page you want the Protocol Data view to display by default. The Browser page renders 

the visual data, and the Event Log page displays a table of page titles, response times, verification 

point failures, and unexpected response codes. You can switch between the pages when you 

watch the user.

1. In the Test Navigator, browse to an HTTP test and double-click it.

The test opens.

2. Click Run  > Run As  > Test.

3. In the Protocol Data  view, click the Browser  tab.

The HTTP pages are displayed. Because the protocol data is used, the Browser  page might not 

render the contents exactly as a web browser would render the contents. But even if an HTTP page 

does not display correctly, you can still use the information on the Request, Response Headers, 

Response Content, and Event Log  pages to help you debug the test.

4. Use the playback buttons in the Protocol Data  view to control the real-time browser display. The 

playback buttons control only the Protocol Data  view. They do not pause or stop test execution. 

If you pause the real-time browser display and then click Play, the page displayed in the Browser 

window is the next page loaded by the playback engine. Use the Back  and Forward  buttons to 

control the display of pages that have already been loaded. If a problem occurs during playback, 

pause the test and use the Back  and Forward  buttons to move to the page where the problem 

occurred. The Request, Response Headers, and Response Content  pages show the information for 

the primary request.

The information on each page is updated in real time as you run the test. The Event Log  page shows the 

response time, verification point failures, unexpected response codes, and messages for each request. All 

of the other pages in the Protocol Data view display an Event Log summary bar while tests are running. 
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The Event Log summary bar shows the number of verification point failures, unexpected response codes, 

and messages for the current page request.

An unexpected response code is defined as a response code not in the 200 or 300 range. Response codes 

outside the 200 and 300 range that were recorded or that are represented in a response code verification 

point are not considered unexpected. For example, a response code of 404, "Not Found," is an unexpected 

response code, unless there is an associated response code verification point. If a 404 response code 

occurred while recording and then during playback the response code is also 404, this is not considered 

unexpected. Messages include data correlation failures and custom code messages.

All pages in the Protocol Data  view are active and updated while a test is running. Any of the events in 

the Event Log summary bar might indicate playback failures that require further investigation. After a test 

runs, you can also view the test log to debug the test. To learn more about the test log, see Viewing test 

logs  on page .

Related reference

HTTP protocol data view preferences  on page

Related information

HTTP debugging overview  on page59

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a schedule run  on page63

Replaying a virtual user after a run completes  on page66

Viewing the playback summary of a virtual user  on page67

Inspecting HTTP test logs in the Protocol Data view  on page70

Managing HTTP information in the Protocol Data view  on page71

Watching a virtual user during a schedule run
During a schedule run, you can select any virtual user and watch that user's real-time browser. Watching 

the real-time browser lets you investigate the status of individual virtual users while they are running. You 

can determine whether a run is valid despite the occurrence of individual virtual user failures.

Watching a virtual user during a run is useful in the following situations:
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• It enables you to quickly verify that virtual users are receiving the data that you expect. Assume 

that you want to verify that virtual users use different dataset data during a schedule run. You can 

select a virtual user during the run and see the real-time data for that user. You can then select 

another virtual user and see that user's data.

• It confirms whether a schedule run is valid despite the occurrence of failures. Assume that you are 

running a schedule that takes several hours to complete. Intermittent failures occur during the run. 

To find out whether these failures are significant enough to interrupt the run, you can investigate 

the activities of virtual users that are running at each location (agent computer). You can decide 

whether to allow the schedule to run to completion.

• It enables you to investigate errors during a run. Assume that you have confirmed that a schedule 

is running successfully, despite the errors of a few virtual users. However, you want to find the 

specific virtual users with verification point failures and see what each virtual user is doing when 

the failure occurs. To do so, start monitoring different virtual users until you find one who is 

experiencing failures. The Verification Point report is helpful for narrowing down which user groups 

are experiencing failures. When the virtual user has been identified and monitoring has started, use 

the Event Log page to see the error details for this user.

To watch a virtual user during a schedule run:

1. Run the schedule: Right-click the schedule, and then click Run  > Run Schedule.

2. In the Protocol Data view, click  (Watch Virtual User icon).

3. In the Select Virtual User to Watch  window, select the user group that contains the user.

4. Select the virtual user number in the user group or at a particular location (agent) on which the user 

group runs, and click OK.

Option Description

Specify a user inside this user group

The window lists the ranges of active users in 

the group. Specify a user number within the 

listed ranges.

This option is useful when you want to watch 

any user, or a particular user, in a specific 

user group. This might be the case if you 

have run the schedule before, examined the 

test log, and know the number of the virtual 

user that you want to see.

For example, a schedule that uses a dataset 

of user names might run correctly for the 
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Option Description

first 10 users but issue verification point fail

ures for the remaining users. In this case, you 

watch user number 11.

Indexed user on location

Select this option to see a user running at a 

specific location. Enter an index between 1 

and the number of users at that location. This 

number is mapped to a virtual user number, 

which is displayed in the title of the Event Log 

tab.

You enter an indexed number rather than a 

specific user number because not only are 

the actual user numbers spread out between 

locations (User 1 might be at Location A, 

Users 2 and 3 at Location B, and so on) but 

also a user's location can vary from run to run 

(User 3 might run on Location A during one 

run and Location B during the next run).

5. In the Protocol Data view, click the Browser  tab.

Only pages loaded while watching the virtual user are displayed; pages that have been loaded 

before live rendering began are not available. However, the data that you see is also available 

in the test log after the run completes. This data is always available, regardless of the test log 

preferences that you set in the schedule.

6. Click an icon for the virtual user.

Icon Description

 (Pause)  (Play)  (Back)  (Forward) Navigation actions, which let you move 

among pages.

 (Stop Watching) Stop monitoring the current user. Clicking this 

icon does not stop the user from running.

 (Watch Virtual User) Change from one user to another.

You can even add virtual users during the run and watch the added users. For more information, 

see Changing the number of virtual users during a run  on page 54.
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Related information

HTTP debugging overview  on page59

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a test run  on page62

Replaying a virtual user after a run completes  on page66

Viewing the playback summary of a virtual user  on page67

Inspecting HTTP test logs in the Protocol Data view  on page70

Managing HTTP information in the Protocol Data view  on page71

Replaying a virtual user after a run completes
After you create a schedule, run it with a small number of users and watch their activity to verify that the 

schedule is behaving as expected. You can compare the visual data that is rendered as well as the events 

that are logged for each user.

1. Open the schedule, click the Test Log  tab, and set each  Log Level  to All.

This setting makes sure that the virtual user that you select will have complete test log data.

2. Verify that the schedule contains a small number of virtual users.
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a. Open the schedule, click the User Load  tab and set a small number of users. 

Setting a small number of users prevents the log from becoming unwieldy, which can occur 

when the log level is All.

b. If you are running a fixed number of users, select each user group and set the numbers so 

that the total is equal to that in the User Load  tab.

3. Save the schedule and click Run  to run the schedule with the limited number of users.

4. After the schedule completes, open the test log: Right-click the schedule run, and select Display 

test log.

5. In the test log, click the Events  tab, expand the test log to display the virtual users, and select a 

virtual user to watch.

6. In the Protocol Data view, click Replay  ( ).

The virtual user's pages, which were loaded during the run, are redisplayed. Each page pauses the 

number of seconds that you set in the Replay Delay  preference (Window  > Preferences  > Test  > 

HTTP Protocol Data View).

7. To stop replaying, click Stop Replay  ( ).

Related information

HTTP debugging overview  on page59

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a test run  on page62

Watching a virtual user during a schedule run  on page63

Viewing the playback summary of a virtual user  on page67

Inspecting HTTP test logs in the Protocol Data view  on page70

Managing HTTP information in the Protocol Data view  on page71

Viewing the playback summary of a virtual user
The Event Log  page in the Protocol Data  view provides a summary of what happened during an HTTP test 

run. A complete summary is always available for a test. The information available for a schedule depends 

on its logging level.
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The amount of information that you see in the Event Log depends on the amount of information that is 

collected by the test log. When you run a test, all logging is automatically enabled, therefore the Event 

Log contains complete details. When you run a schedule, however, you select a Log Level  setting, and the 

amount of detail that the Event Log contains depends on this setting. For more information, see Setting 

the data that the test log collects  on page .

If your schedule run is not large, select the setting All  for all types of events. For large schedule runs, do 

not use the All  setting, because of the time and space required to transfer large amounts of log detail to 

your computer after a run is completed. Instead, define a special schedule for debugging tests with the 

log levels set to All. Limit this schedule to a single test (or a small number of tests) and to a small number 

of user groups or loop iterations. After you are satisfied that a test is performing correctly, you can move it 

to a schedule that emulates a realistic workload.

To view the Event Log  information:

1. In the Test Navigator, open a schedule or test.

2. Run the schedule or test: Click Run  > Run As, and select Performance Test  or Performance 

Schedule.

3. In the Protocol Data  view, click the Event Log  tab.

• If you are running a test, the Event Log page is immediately populated.

• If you are running a schedule, wait until the run is complete. Right-click on the report and 

select Display test log. Select a virtual user in the test log. The Event Log page shows the 

summary of events for that user.

The first column has an arrow to indicate the page that is currently displayed in the other Protocol 

Data  view windows: Request, Response Headers, Response Content, and Browser.

The second column shows the status of the page:

Symbol Meaning

Green check All requests for the page are successful and 

that there are no warnings.

Red X The page contains requests with failed ver

dicts or unexpected response codes. Typi

cally, failed verdicts are verification point fail

ures. Unexpected response codes are codes 

outside the 200 and 300 range that were not 

recorded as such or that are not represented 

in associated verification points.
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Symbol Meaning

Yellow warning symbol The page contains messages but no failure 

verdicts or unexpected response codes.

4. Double-click an entry in the Event Log  to open the Event Details  window. The Event Details  window 

shows a list of events for the page that is highlighted in the Event Log. The Name  and Parent 

columns show the name and parent request for each event. The Text  field shows details for each 

event.

Note:  The Go To  menu at the top of the Event Details  window lets you jump to the 

corresponding event in the test or the test log. This is useful for obtaining more contextual 

information about the error shown in the table.

5. Leave the Event Details  window open, and click other pages in the Event Log, or use the Forward 

and Back  buttons to navigate to other pages in the Event Log.

The Event Details  window is updated to show the events for the page that is selected in the Event 

Log.
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The information in the Event Details  window supplements the information in the test log. To see more 

information about a particular event, view the test log after the test finishes running. With the test log, you 

can see an event in context. The test log also provides links to the recorded test.

Related information

HTTP debugging overview  on page59

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a test run  on page62

Watching a virtual user during a schedule run  on page63

Replaying a virtual user after a run completes  on page66

Inspecting HTTP test logs in the Protocol Data view  on page70

Managing HTTP information in the Protocol Data view  on page71

Viewing test logs  on page

Inspecting HTTP test logs in the Protocol Data view
To verify that a test is performing as you intend, use the Protocol Data view, which displays the HTML 

details that were generated during a schedule run. If problems occur in a test run, you can also compare 

the data retrieved during the run with the recorded data.

Set the detail level. The amount of detail that you can see in the Protocol Data view depends on the Test 

Log  settings in the schedule; see Setting the data that the test log collects  on page . If you plan 

to use the Protocol Data view and your schedule run is not large, select the setting All  for all types of 

events. For large schedule runs, do not use the All  setting, because of the time and space required to 

transfer large amounts of log detail to your computer after a run is completed. You might create a special 

schedule for Protocol Data view runs with the log levels set to All. Limit this schedule to a single test (or 

a small number of tests) and to a small number of user groups or loop iterations. After you are satisfied 

that a test is performing correctly, you can move it to a schedule that emulates a realistic workload.

1. In the Test Navigator, right-click the results that you want to inspect, and click Display Test Log. 

The results have the same name as the test or schedule with a time stamp appended.

2. In the editing area, click the Protocol Data  tab to open the view.

Tip:  If you cannot locate the Protocol Data  tab, click Window  > Show View  > Protocol Data.
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3. In the Protocol Data view, click the tab for the type of contents or view that you want to display: 

Request, Response Headers, Response Contents, or Browser, or Event Log.

Substituted data is highlighted on the Request, Response Headers  and Response Content  pages 

when you view test log or test editor elements that use data correlation.

4. In the Events hierarchy area of the test log, click the line that contains the detail that you want to 

view.

The detail is displayed in the Protocol Data view.

Note:  User groups, virtual users, and some HTTP requests are processed in parallel. The test 

log reflects the order of execution, rather than the recording order or the order of user groups in 

schedules. Therefore, the order of page requests in the test might be different from the order in 

the test log, and the order of user groups in the test log might be different from the order in the 

schedule. However, the order of pages in a test and the order of tests inside a user group are the 

same in the test log as in the corresponding test and schedule.

If you have problems during playback, you can compare the data that you recorded with the data retrieved 

during the run. For information on displaying the recorded data, see Viewing a test in the Protocol Data 

view  on page .

Related information

HTTP debugging overview  on page59

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a test run  on page62

Watching a virtual user during a schedule run  on page63

Replaying a virtual user after a run completes  on page66

Viewing the playback summary of a virtual user  on page67

Managing HTTP information in the Protocol Data view  on page71

Managing HTTP information in the Protocol Data view
Several actions can be performed on the text displayed in the Protocol Data  view. You can save the text 

from the Protocol Data  view pages to a text file for use in other applications. You can search for text in the 

protocol data. You can compare the data retrieved during a run with the recorded data from an HTTP test. 

Typically, you compare a request or response from the test log to its corresponding data in the recorded 

test. You can also compare requests or responses from different virtual users in one test log.
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To export HTTP data from the Protocol Data view to a text file:

1. In the Test Navigator, right-click the results that you want to export, and click Display Test Log. The 

results have the same name as the test or schedule with a timestamp appended.

2. In the editing area, click the Protocol Data  tab to open the view.

3. Click the button that corresponds to the data that you want to export: Request, Request Headers, 

or Response Content.

You cannot export data from the Browser  page.

4. Optional: 

To export only a portion of the text, select the text, and click the appropriate option from the menu: 

5. Select one of the following options from the toolbar:

Option Description

Save to protocol data

Saves the entire text on the page to a text file 

within or outside of your workspace.

Copy to clipboard

Copies the entire text on the page to the clip

board.



Chapter 1. Test Execution Specialist Guide

Option Description

Compare to clipboard

Compares the entire text on the page to the 

contents of the clipboard. To compare the 

playback data with the recorded data, view 

the protocol data in the test log and select 

Copy to clipboard. Then, use the element link 

in the details section of the test log to navi

gate directly to the associated recorded ele

ment, and select Compare to clipboard.

Find

Searches the data in that test log page. You 

cannot replace data in the test log.

The text is saved in the default (locale-specific) encoding that is set on your computer. Keep this 

default locale setting unless your text contains non-Latin characters.

6. Optional: Click the menu on the toolbar  to save the file in 

Unicode.

Related information

HTTP debugging overview  on page59

Debugging HTTP Data Correlation Errors  on page61

Watching a virtual user during a test run  on page62

Watching a virtual user during a schedule run  on page63

Replaying a virtual user after a run completes  on page66

Viewing the playback summary of a virtual user  on page67

Inspecting HTTP test logs in the Protocol Data view  on page70

Viewing test logs  on page
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Debugging Citrix tests
The Citrix dashboard is an optional panel that displays detailed information and control commands for 

each virtual user during the run of a schedule. This is useful for debugging your tests and allows you to 

pause, interact, resume, or stop the execution of individual virtual user sessions.

Related information

Running a local schedule or test  on page2

Running a long run mode SAP GUI test  on page4

Running long duration Citrix tests  on page6

Testing with Docker images  on page7

Testing with IBM Cloud Private  on page15

Adjusting delays in HTTP tests  on page22

Setting a launch configuration  on page27

Running a configured schedule  on page29

Configuring multiple host names for a location  on page30

Automating tests  on page31

Controlling cache sizes  on page49

Increasing memory allocation  on page50

Controlling the test runs from web analytics report  on page53

Debugging HTTP tests  on page59

Enabling and disabling the Citrix monitoring panel
With the optional Citrix monitoring panel, you can monitor detailed information during the run of a 

schedule and debug your tests. To use the Citrix monitoring panel, you must enable it in the schedule.

The Citrix monitoring panel is available only during the run of a schedule. Enabling the option requires that 

you create a location for it in the project.

The Citrix monitoring panel uses resources; therefore use the monitoring panel only for debugging and 

test development. For actual performance testing, disable the panel.

To enable the Citrix monitoring panel in a schedule:
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1. Open a schedule that contains a user group with at least one Citrix test.

2. Select the user group, and on the Schedule Element Details  pane, click the Options  tab, and then 

click Edit Options.

The Protocol-specific Options  window opens.

3. If several types of tests are available in the user group, click the Citrix Options  tab.

4. Select Enable monitoring panel.

5. Optional: Select Enable log file generation  if you want to keep a log file of the debug session. 

After the run, you can locate the log file in the file system, in the deployment_root  directory of 

the workspace directory.

6. Click OK, and save the schedule.

During the next run of the schedule, the Citrix session window displays the monitoring panel, with which 

you can debug and control the progress of each virtual tester.

Related reference

Citrix monitoring panel reference  on page

Related information

Debugging tests with the Citrix monitoring panel  on page75

Debugging tests with the Citrix monitoring panel
When enabled, the Citrix monitoring panel provides the ability to pause your tests during a run and to 

provide manual input. It also provides a comparison view to compare expected window events with the 

actual window events received during the test. This capability can be useful when you are debugging your 

tests.

To display the Citrix monitoring panel during VU Schedule  runs, first enable the panel. See Enabling and 

disabling the Citrix monitoring panel  on page 74 for more information.

The Citrix monitoring panel uses resources; therefore, use the panel only for debugging and test 

development. For actual performance testing, disable the panel so that the results are accurate.

1. With the monitoring panel option enabled, run the VU Schedule.

A window opens with the virtual users running Citrix clients on multiple pages. Click a tab to 

display the corresponding virtual user.

2. Click the Monitoring  tab to display the monitoring panel.

The monitoring panel displays the following information:
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Monitoring Panel

This panel displays information about the execution of each virtual user.

Pool Name

Displays the name of the virtual user pool. There is one pool per 

location and user group.

Active Virtual Users

Displays the number of virtual users currently active. This value is 

updated permanently during the run.

User Action Rate

Displays the number of Citrix user key or mouse actions that were 

simulated during the last 5 second interval.

Total Elapsed Time

Displays the total time elapsed since the start of the schedule run.

Current®  Action

Displays the last user action executed in the test.

Timeouts

Displays the number of synchronization timeouts for the virtual user. 

The color represents the status of the timeout:

• Green: ok.

• Yellow: a timeout occurred on a conditional synchronization.

• Red: a timeout occurred on a mandatory synchronization.

Elapsed Time

Displays the time elapsed since the start of the virtual user run.

Status

Displays the execution status of the virtual user.

3. Select a virtual user and click one of the following buttons to interact with the execution of the test.

Go To

Click to display the Citrix session of the selected virtual user.

Pause or Play

Click to pause or resume the execution of the selected virtual user. You can also 

pause the execution by setting breakpoints in the test.
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Step

When the test is on pause, click to execute each user input action in the test, step 

by step. To pause test execution, you can either click the Pause  button or set 

breakpoints in the test. Click Play  to resume the test.

Interact

When the test is on pause, click to allow manual actions in the virtual user session. 

Use this feature if a test fails to synchronize or gets stuck in an unexpected state. To 

pause test execution, you can either click the Pause  button or set breakpoints in the 

test. Click Play  again to resume the test execution at the point where it was paused.

Stop

Click to stop the execution of the selected virtual user. When all virtual users are 

stopped, the schedule ends.

4. When you have finished interacting with the Citrix session, click Play  to resume the execution.

Related reference

Citrix monitoring panel reference  on page

Related information

Enabling and disabling the Citrix monitoring panel  on page74

Setting Citrix breakpoints
When the Citrix monitoring panel is enabled, you can define breakpoints in the test to pause the running of 

a user-input action. This capability is useful when you are debugging a Citrix test.

For the breakpoints to have any effect, the test must be running in a schedule with the Citrix monitoring 

panel enabled. See Enabling and disabling the Citrix monitoring panel  on page 74 for more 

information.

Breakpoints can be defined on these user-input test elements: mouse actions, key actions, text inputs, and 

logoff elements. When a breakpoint is encountered, the test pauses before the user input element is run.

1. Open a Citrix test in the test editor and select a user input element.

2. In the Test Element Details  area, select Stop test execution on this element when the monitoring 

panel is enabled.

Alternatively, you can right-click the user input element, and select Toggle Breakpoint.
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3. Add the test to a schedule and run the schedule with the monitoring dashboard enabled.

During the run, the virtual user pauses at the breakpoint.

4. When the test is paused, click Interact  to perform manual actions inside the Citrix session or Step 

to run the test step by step.

5. When you have finished, click Play  to resume the test run.

If there are multiple breakpoints in the test, the run resumes until the next breakpoint is 

encountered.

Extending test execution with custom code
You can extend how you run your tests by writing custom Java™  code and calling the code from the test. 

You can also specify that results from the tests that are affected by your custom code be included in 

reports.

Creating custom Java™  code
Custom code uses references in the test as input and returns modified values to the test. Use the 

ICustomCode2  interface to create custom code and the ITestExecutionServices  interface to extend test 

execution. These interfaces are contained in the com.ibm.rational.test.lt.kernel.services 

package.

Note:  When you use the ITestExecutionServices  interface in your custom code to report test results, 

the results for the custom code are displayed in the test log. If you log custom verification point verdicts, 

these are reflected in the overall schedule verdict.

Custom code input values can be located in references or field references. You can also pass a text string 

as an argument to custom code. References that are used as input to custom code must be included in 

the same test as the custom code. In the test, the reference must precede the code that it affects. Verify 

that the test contains the references that are required for customized inputs to your code. For details 

about creating references and field references, see Creating a reference or field reference  on page .

If your custom code uses external JAR files, you might need to change the Java™  build path. In some 

cases, you can avoid changing the build path manually by running the test before adding your custom 

code to it. The first time a test runs, classes and libraries that are required for compilation are added to 

the build path. For example, you can import Test and Performance Tools Platform (TPTP) classes that are 

required to create custom events in the test log if the test, to which you have added your custom code, 
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has run previously. However, if the test has never been run, import errors occur because the classes are 

not named in the build path for the project until the test has run.

If your code uses external resources, for example, an SQL database or a product that manages customer 

relationships, you must configure the custom code to work on every computer on which your test runs.

Custom code is saved in the src  folder of the project that contains the test that calls the code. By default, 

custom code is located in a package named test  in the src  folder.

You can reuse a custom code package for tests that are located in multiple projects. The projects must be 

in one workspace. To reuse custom code across projects, use the project name before the custom code 

package. For example, .

The following example shows the standard Navigator view of two custom code classes. (The Test 

Navigator does not display Java™  source files.)

When you add the ReplaceCC.java  and VerifyYUserID.java  custom code classes to the test and 

return a value to the test, Substitute  lists these two classes.

The test package also contains the generated Java™  code for tests in the project.

You can put custom code in a different package (for example, custom). Separate custom code from 

generated code, especially if you use a source-control system.

To add custom code:

1. Open the test, and select a test element.

2. Click Add  or Insert, and select Custom Code.

Add  appends the custom code to the bottom of the selected test element. Insert  adds the custom 

code above the selected test element.
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Note:  After you add or insert custom code, the Problems view displays an error stating that the 

new custom code element has no Java™  file. This error message remains until you click View Code 

or Generate Code, to remind you that the custom code test element is not yet associated with any 

Java™  code.

3. Inspect the Class name  field, and complete one of these steps:

• If the code to call already exists, change the class name to match its name. Click View Code 

to open the code in the Java™  editor.

• If the code does not exist, change the class name to describe the purpose of the code. Click 

Generate Code  to generate a template class for logging results and to open it in the Java™ 

editor. If a class with this name exists, you are warned that it will be overwritten.

4. In the Arguments  field, click Add.

5. In the Custom Code  window, select all inputs that your code requires.

The Custom Code  window lists all values in the test that can be used as inputs to your code 

(references or field references in the test that precede the code).

6. Click OK.

The window closes, the selected references are added to the Arguments  field.

7. To add text strings as inputs to your custom code, click Text, and then type the text string to use.

8. In the test, after your custom code, locate a value that your code returns to the test.

9. Highlight the value.

10. Right-click the highlighted value, click Substitute, and select the class name of your custom code.

The custom code classes that you have added are listed. After you have made your selection, the 

value to be returned to the test is highlighted in orange, and the Used by  table is updated with this 

information.

Custom code is not displayed in the Test Navigator  view. To view custom code, open the Package 

Explorer  view and use the Java™  tools to identify the custom code that you added.

Test execution services interfaces and classes
You use the test execution services interfaces and classes to customize how you run tests. These 

interfaces and classes are located in the com.ibm.rational.test.lt.kernel package. Each interface and class 

is described briefly in this topic and in detail in the Javadoc information.

The custom code does not run on the mobile device, but from the generated Java code that is available 

in the test workbench. So, if you initiate the test run from the mobile device and the test script includes 

custom code, the custom code is not executed. To execute the custom code that is available in a mobile 
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test script, you must initiate the run from test workbench. If you want to integrate custom code between 

two mobile instructions, you must split the test script. See Splitting a test.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Test execution services interfaces

Interface Description

ICustom

Code2

Defines customized Java™  code for test execution services. Use this interface to create 

all custom code.

ITestEx

ecution

Services

Provides information for adding custom test execution features to tests. Replaces the 

IKLog  interface. All the methods that were available in IKLog  are contained in ITestExe

cutionServices, along with several newly exposed objects and interfaces. This interface 

is the primary interface for execution services. ITestExecutionServices  contains the fol

lowing interfaces:

• IDataArea

• IARM

• IDataSetController

• ILoopControl

• IPDLogManager

• IStatisticsManager2

• ITestLogManager

• ITime

• ITransaction

• String

IDataArea Defines methods for storing and accessing objects in data areas. A data area is a con

tainer that holds objects. The elements of a data area are similar to program variables 

and are scoped to the owning container. To use objects specific to a protocol, you 

should use objects provided by that protocol that are stored in the protocol-specific data 

area.

IARM Provides information about defining ARM (Application Response Measurement) specifi

cations. You use this interface if your virtual users are being sampled for ARM process

ing.

ILoop

Control

Provides control over loops in a test or schedule. For example, you can use this interface 

to break loops at specific points in a test. The loop that is affected is the nearest con

taining loop found in either the test or the schedule.
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Interface Description

IPDLog

Manager

Provides logging information such as problem severity, location levels, and error mes

sages.

IStatistic

sManag

er

Provides access to performance counters in the ICustomCode2  interface (used for 

defining custom code). Performance counters are stored in a hierarchy of counters. Pe

riodically, all the counter values in the hierarchy are reported to the testing workbench 

and collected into test run results, where they are available for use in reports and graphs. 

Each counter in the hierarchy has a type (defined in class StatType). The operations that 

are available on a counter depend on the counter's type.

ITestLog

Manager

Logs messages and verification points to the test log. Use this interface for handling er

ror conditions, anomalies in expected data or other abstract conditions that need to be 

reported to users, or for comparisons or verifications whose outcome is reported to the 

test log. ITestLogManager  can also convey informational or status messages after the 

completion of a test.

ITime Defines basic time services, such as the current system time in milliseconds (adjusted 

so that all systems are synchronized with the schedule controller), the time the test be

gins, and the elapsed time from the beginning of the test.

ITransac

tion

Provides support for transactions. A collection of named transactions is maintained 

for each virtual user. Transactions created in custom code can be started and stopped 

wherever custom code can be used. These transactions can span several tests. Perfor

mance counters are kept for custom code transactions and appear in reports. An exam

ple of how you could use ITransaction  is to create transactions for one virtual user but 

not another, to help verify responses from tests.

IEngineIn

fo

Provides information about the testing execution engine; for example, the number of vir

tual users running in this engine, the number of virtual users that have completed, the lo

cal directory in which test assets are deployed, and the host name of the computer on 

which the engine runs.

ITestInfo Provides information about the test that is running; for example, the test name and infor

mation about the current problem determination log level for this test.

IVirtual

UserInfo

Provides information about virtual users; for example, the virtual user's name, problem 

determination log level, TestLog level, globally unique ID, and user group name.

IScalar Provides methods for simple integer performance counters. It is used for counters of 

SCALAR  and STATIC  types. Use this interface to decrement and increment counters.
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Interface Description

IStat Defines observational performance counters. It defines the method for submitting a data 

point to performance counters of type RATE, AVERAGE, and RANGE.

IStatis

tics

Retrieves the performance counter tree associated with the current statistics processor. 

Stops the delivery of performance counters. Changes the priority of the statistics deliv

ery thread.

IStatTree Provides methods that can retrieve child counters, create the XML fragments that define 

counters, and set the description field of counters.

IText Contains text-based performance counters. Performance counters that do not fit any of 

the other counter types can be created as type TEXT. TEXT  counters are not assigned defi

nitions, but they are collected in the test results.

Test execution services classes

Class Description

Data

Area

Lock

Ex

cep

tion

Throws an exception whenever an attempt is made to modify a locked DataArea key.

Out

OfS

cope

Ex

cep

tion

Indicates that an object created by ITestExecutionServices  has been referenced outside of 

its intended scope.

Trans

ac

tion

Ex

cep

tion

Throws an exception when a transaction is misused. The following conditions lead to a 

TransactionException  exception: attempting to start a transaction that has already been 

started, attempting to stop a transaction that has not been started, and getting the start time 

or the elapsed time of a transaction that has not been started. Any operation (except abort()) 

on a transaction that has been aborted will throw a TransactionException  exception.
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Class Description

Stat

Type

Provides a list of valid performance counter types. The performance counter types are: AV

ERAGE, iAVERAGE, iRANGE, iRATE, iSCALAR, iSTATIC, iSTRUCTURE, iTEXT, RANGE, RATE, 

SCALAR, STATIC, STRUCTURE, and TEXT.

Reducing the performance impact of custom code
If custom code runs inside a page, it can affect that page's response time.

HTTP pages are containers of HTTP requests. On a given HTTP page, requests run in parallel across all of 

the connections between the agent computer and the system under test.

Page response time  is the interval between page start  and page end, which are defined as follows: Page 

start is the first timestamp associated with the client-server interaction. This interaction is either the 

first byte sent or the first connect of the first HTTP request. Page end is the last timestamp associated 

with the client-server interaction. This interaction is the last byte received of the last HTTP request to 

complete. Because of parallelism, the last HTTP request to complete might not be the last one listed for 

the page.

Typically, you should not insert custom code inside a page. While custom code that runs for only a 

few milliseconds should have little effect on page response time, the best practice is to place custom 

code outside a page. Custom code placed outside a page has no effect on page response time, and its 

execution time can overlap with think time delays.

Do not use custom code for data correlation if you can instead use the data correlation features built into 

the product. The built-in data correlation code takes advantage of requests running in parallel, whereas 

custom code actions do not begin until all earlier actions are completed.

You might need to place custom code inside a page to correlate a string from the response of a request 

inside that page to another request inside the same page. Even in this case, if you split the page into two 

pages, you can use the built-in data correlation features instead of custom code.

If you still want to run tests with custom code inside HTTP pages, use the Page Element report to 

evaluate performance. The Page Element report shows the response time and throughput for individual 

HTTP requests. Custom code does not affect the response time measurement of individual HTTP 

requests.

Related information

Performance testing tips  on page
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Custom code examples
Custom code enables you to perform such tasks as managing loops, retrieving virtual user information, 

running external programs from tests, and customizing data correlation.

Controlling loops
This example demonstrates extending test execution by using custom code to control loops. It provides 

sample code that shows how you can manipulate the behavior of loops within a test to better analyze and 

verify test results.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

This example uses a recording of a stock purchase transaction using the Trade application. The concepts 

shown here can be used in tests of other applications.

The test begins with a recording of a stock purchase transaction, using dataset substitution for the login 

IDs. The pages are wrapped in a five-iteration loop, as shown in the following figure:
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Notice that among the various pages of the test, three items of custom code exist (indicated by the green 

circles with "C"s in them). This example explores these items of custom code.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

The first piece of custom code, InitializeBuyTest, is mentioned here:

package customcode;

 

import java.util.Random;

 

import com.ibm.rational.test.lt.kernel.IDataArea;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.services.IVirtualUserInfo;

 

/**

 * @author unknown

 */

public class InitializeBuyTest implements

  com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

 /**

  * Instances of this will be created using the no-arg constructor.

  */

 public InitializeBuyTest() {

 }

 

 /**

  * For description of ICustomCode2 and ITestExecutionServices interfaces,

  * see the Javadoc.. */

 public String exec(ITestExecutionServices tes, String[] args) {

  // Get the test's data area and set a flag indicating that nothing

  // has failed yet. This flag will be used later to break out

  // of the schedule loop as soon as a failure is encountered.

  IDataArea dataArea = tes.findDataArea(IDataArea.TEST);

  dataArea.put("failedYet", "false");

 

  // Get the virtual users's data area
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  IDataArea vda = tes.findDataArea(IDataArea.VIRTUALUSER);

  

  // Randomly select a stock to purchase from the set of s:0 to s:499.

     IVirtualUserInfo vuInfo = (IVirtualUserInfo) vda.get(IVirtualUserInfo.KEY);

     Random rand = vuInfo.getRandom();

  String stock = "s:" + Integer.toString(rand.nextInt(499));

 

  // Persist the name of the stock in the virtual user's data area.

  vda.put("myStock", stock);

 

  return stock;

 }

 

This custom code is located in the method exec().

First, the data area for the test is acquired to store a flag value, in this case a string of text, to be used later 

to stop the test loop when an error is discovered. Data stored in this way can be persisted across tests.

Then a randomly generated stock string is created. The value is stored as the variable stock, and is 

passed back as the return value for the method. This return value is used as a substitute in a request later, 

as shown in the following figure:

The highlighted item uses a substitution (s%3A716), which is the value returned by the InitializeBuyTest 

custom code item. We are using custom code to drive the direction of our test.

The next lines of code in InitializeBuyTest  use the Virtual User data area to store the name of the stock 

for later reference. Again, data stored in this way can persist across tests.

The second piece of custom code is called CheckStock. Its contents are as follows (listing only the exec() 

method this time):

87



Test Execution Specialist Guide

88

public String exec(ITestExecutionServices tes, String[] args) {

 

  // Get the actual and requested stock purchased.

  String actualStock = args[0].replaceAll("<B>", "");

   actualStock = actualStock.substring(0, actualStock.indexOf("<"));

  String requestedStock = args[1];

 

    // Set the log level to ALL.

   IDataArea dataArea = tes.findDataArea(IDataArea.TEST);

   ITestInfo testInfo = (ITestInfo)dataArea.get(ITestInfo.KEY);

   testInfo.setTestLogLevel(ITestLogManager.ALL);

 

   // If the log level is set to ALL, report the actual and requested stock

  // purchased.

   ITestLogManager testLogManager = tes.getTestLogManager();

  if (testLogManager.wouldReport(ITestLogManager.ALL)) {

    testLogManager.reportMessage("Actual stock purchased: "

      + actualStock + ". Requested stock: " + requestedStock

     + ".");

   }    

 

  // If the actual and requested stock don't match, submit a FAIL verdict.

   if (testLogManager.wouldReport(ITestLogManager.ALL)) { 

   if (!actualStock.equalsIgnoreCase(requestedStock)) {

     testLogManager.reportVerdict(

      "Actual and requested purchase stock do not match.",

       VerdictEvent.VERDICT_FAIL);

 

     // Use the test's data area to record the fact that an error has    

    // occurred.

     dataArea.put("failedYet", "true");

    }   

  }

    return null;

 }

This code begins by extracting two arguments that have been passed to the code. A part of the response 

in the original recording is highlighted and used as a reference, as shown in the following figure.
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Some string manipulation is needed to acquire the text of interest; in this case, the name of the stock that 

was actually purchased. This newly created reference is then passed into CheckStock  as an argument, as 

shown in the following figure:

Note that the return value of InitializeBuyTest  is passed in as an argument as well.

The CheckStock  custom code item uses these values to verify that the randomly chosen stock generated 

by InitializeBuyTest  is actually purchased during the execution of the test.

CheckStock  then sets the test log level, reports the actual and requested stock purchase, and raises a FAIL 

verdict if they do not match. CheckStock  also stores a true  value associated with the tag failedYet  in the 

test's data area.

The third piece of custom code (exec()  method only) is mentioned here:

public String exec(ITestExecutionServices tes, String[] args) {

 

  // Get the test log manager.

  ITestLogManager testLogManager = tes.getTestLogManager();

  

  // Get the test's data area and get a flag indicating to

  // see if anything has failed yet. If so, stop the loop.
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  IDataArea dataArea = tes.findDataArea(IDataArea.TEST);

  String failedYet = (String) dataArea.get("failedYet");

 

  // Break out of the loop if an error has been encountered.

  if (failedYet.equalsIgnoreCase("true")) {

   tes.getLoopControl().breakLoop();

 

   if (testLogManager.wouldReport(ITestLogManager.ALL)) {

    testLogManager.reportMessage("Loop stopped.");

   }

  }

 

  return null;

 }

This code uses the test's data area to determine the user-defined value associated with the tag failedYet. 

If failedYet  is true, StopLoopCheck  breaks out of the test loop.

Retrieving the IP address of a virtual user
This example shows how to retrieve the local IP address of a virtual user. Retrieving IP addresses is 

particularly useful when virtual users are using IP aliases.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

The following custom code retrieves the IP address that was assigned to a virtual user:

import java.net.InetAddress;

import com.ibm.rational.test.lt.kernel.IDataArea;

import com.ibm.rational.test.lt.kernel.services.ITestLogManager;

import com.ibm.rational.test.lt.kernel.services.IVirtualUserInfo;

 

public String exec(ITestExecutionServices tes, String[] args) {

 IVirtualUserInfo vui = (IVirtualUserInfo) tes.findDataArea(IDataArea.VIRTUALUSER).get(IVirtualUserInfo.KEY);

 ITestLogManager tlm = tes.getTestLogManager();

 

 if (vui != null) {

  String localAddr = null;
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  InetAddress ipAddr = vui.getIPAddress();

  if (ipAddr != null)

   localAddr = ipAddr.toString();

  tlm.reportMessage("IPAlias address is " + (localAddr != null ? localAddr : "not set"));

  return localAddr;

 }

else

  return ("Virtual User Info not found");

}

Printing input arguments to a file
The PrintArgs class prints its input arguments to the file C:\arguments.out. This class could be used, for 

example, to print a response returned by the server.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

import java.io.*;

 

/**

 * The PrintArgs class prints its input arguments to the file

 * C:\arguments.out.  This example could be used to print a response

 * returned by the server.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class PrintArgs implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

91



Test Execution Specialist Guide

92

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public PrintArgs() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        try {

            FileWriter outFile = new FileWriter("C:\\arguments.out");

            for (int i = 0; i < args.length; i++)

                outFile.write("Argument " + i + " is: " + args[i] + "\n");

            outFile.close();

        } catch (IOException e) {

            tes.getTestLogManager().reportMessage(

                                        "Unable to write to C:\\arguments.out");

        }

        return null;

    }

}

Counting the number of times that code is executed
The CountAllIterations class counts the number of times code is executed by all virtual users. The 

CountUserIterations class counts the number of times code is executed by an individual virtual user.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

The CountAllIterations class counts the number of times it is executed by all virtual users running in a 

particular JVM and returns this count as a string.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

 * The CountAllIterations class counts the number of times it is executed

 * by all virtual users running in a particular JVM and returns this count
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 * as a string.  If all virtual users on an agent are running in the same

 * JVM (as would typically be the case), this class will count the number of

 * times it is run on the agent.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class CountAllIterations implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

    private static int numJVMLoops = 0;

 

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public CountAllIterations() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        return Integer.toString(++numJVMLoops);

    }

}  

The CountUserIterations class counts the number of times code is executed by an individual virtual user.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.IDataArea;

 

/**

 * The CountUserIterations class counts the number of times it is executed

 * by an individual virtual user and returns this count as a string.

 */

 

/**

 * @author IBM Custom Code Samples
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 */

 

public class CountUserIterations implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public CountUserIterations() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        IDataArea userDataArea = tes.findDataArea(IDataArea.VIRTUALUSER);

        final String KEY = "NumberIterationsPerUser";

 

        Number numPerUser = (Number)userDataArea.get(KEY);

        if (numPerUser == null) {

            numPerUser = new Number();

            userDataArea.put(KEY, numPerUser);

        }

                        

        numPerUser.value++;

        return Integer.toString(numPerUser.value);

    }

                

    private class Number {

        public int value = 0;

    }

}

Setting and clearing cookies for a virtual user
The SetCookieFixedValue class sets a Cookie for a virtual user, and the ClearCookies class clears all 

cookies for a virtual user.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.
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The SetCookieFixedValue class sets a Cookie, defined in the newCookie variable, for a virtual user just as 

if the server had returned a Set-Cookie.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.execution.http.cookie.IHTTPVirtualUserInfo;

import com.ibm.rational.test.lt.kernel.IDataArea;

 

import java.text.ParseException;

 

/**

 * The SetCookieFixedValue class sets a Cookie, defined in the newCookie

 * variable, for a virtual user just as if the server had returned a Set-Cookie.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class SetCookieFixedValue implements

                com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public SetCookieFixedValue() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        String newCookie = "MyCookie=CookieValue;path=/;domain=.ibm.com";

        IDataArea dataArea = tes.findDataArea(IDataArea.VIRTUALUSER);

        IHTTPVirtualUserInfo httpInfo =

                (IHTTPVirtualUserInfo)dataArea.get(IHTTPVirtualUserInfo.KEY);

                

        try {

            httpInfo.getCookieCache().setCookie(newCookie);

        } catch (ParseException e) {

95



Test Execution Specialist Guide

96

            tes.getTestLogManager().reportMessage("Unable to parse Cookie " +

                                                                   newCookie);

        }

 

        return null;

    }

}

 

The ClearCookies class clears all Cookies for a virtual user. For information on how cookies are treated in 

tests and schedules, seeHow loops affect the state of virtual users  on page .

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.execution.http.util.CookieCacheUtil;

 

/**

 * The ClearCookies class clears all Cookies for a virtual user.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class ClearCookies implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public ClearCookies() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        CookieCacheUtil.clearCookieCache(tes);

        return null;

    }

}
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Determining where a test is running
The ComputerSpecific class determines where a test is running

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

import java.net.InetAddress;

import java.net.UnknownHostException;

 

/**

 * The ComputerSpecific class determined the hostname on which the test is 

 * running, prints the hostname and IP address as a message in the test log,

 * and returns different strings based on the hostname.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class ComputerSpecific implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public ComputerSpecific() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        String hostName = "Unknown";

        String hostAddress = "Unknown";
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        try {

            hostName = InetAddress.getLocalHost().getHostName();

            hostAddress = InetAddress.getLocalHost().getHostAddress();

        } catch (UnknownHostException e) {

            tes.getTestLogManager().reportMessage(

                                        "Not able to obtain host information");

            return null;

        }

        tes.getTestLogManager().reportMessage("The hostname is " + hostName +

                                             "; IP address is " + hostAddress);

        if (hostName.equals("host-1234"))

            return "Special";

        else

            return "Normal";

    }

}

Storing and retrieving variable values
You can use the getValue() and setValue() methods to store and retrieve values in variables. Depending 

on the storage location that you specify, variables can be shared among tests, or stored locally in the 

current test.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

You can use the getValue() and setValue() methods to store multiple values in variables in one custom 

code call. You can then create substitutions from variables instead of from multiple custom code 

elements.

For example, assume that a response contains three values: id, book title, and price. You can read all three 

values from the response, and then use custom code to set the variables id, title, and price. You can then 

substitute the values from the three variables as needed in the test, instead of having to write custom 

code for each variable.

Note:  The storage location passed to the method must match the storage location used when 

declaring the variable.
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package customcode;

 

import com.ibm.rational.test.lt.kernel.IDataArea;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

     * For Javadoc information on the ICustomCode2 and ITestExecutionServices interfaces,

     * see the 'Extending test execution with custom code' help topic.

     */

 

/**

 * @author IBM Custom Code Samples

 */

 

    public String exec(ITestExecutionServices tes, String[] args) {

        

        tes.getValue("myVar", tes.STORAGE_USER);  // This retrieves a value from a test for the variable called myVar. 

 The storage area is shared between tests.

        tes.getValue("myLocalVar", tes.STORAGE_LOCAL);  // This variable is stored locally, per test.

        

        tes.setValue("myVar", tes.STORAGE_USER, "myNewValue");  // Change the value of the variable myVar, which is 

 shared between tests, to myNewValue.

        tes.setValue("myLocalVar", tes.STORAGE_LOCAL, "myLocalNewVar");  // Change the value of the local variable to 

 myLocalNewVar.

        return null;

    }

Extracting a string or token from its input argument
The ParseResponse class extracts a string from its input argument. The ExtractToken class extracts a 

particular token (string) from its input argument. Both classes can be useful for handling certain types of 

dynamic data correlation.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.
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The ParseResponse class extracts a string from its input argument, using a regular expression for pattern 

matching.

package customcode; 

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices; 

 

import java.util.regex.*; 

 

/** 

 * The ParseResponse class demonstrates using Custom Code to extract a 

 * string from its input argument using a regular expression for pattern 

 * matching. 

 * 

 * In this sample, the args[0] input string is assumed to be the full 

response  from a previous request.  This response contains the day's 

headlines in a format such as: 

 * 

 *   <a class=f href=r/d2>In the News</a><small class=m>&nbsp;<span id=nw> 

 *   </span></small></h2> 

 *   <div class=ct> 

 *   &#149;&nbsp;<a href=s/213231>Cooler weather moving into eastern 

U.S.</a>  *   <br>&#149;&nbsp;<a href=s/262502>Digital camera shipments 

up</a><br>  * 

 * Given the above response, the extracted string would be: 

 *        Cooler weather moving into eastern U.S. 

 */ 

 

/** 

 * @author IBM Custom Code Samples 

 */ 

 

public class ParseResponse implements 

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 { 

 

    /** 

     * Instances of this will be created using the no-arg constructor. 

     */ 
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    public ParseResponse() {} 

 

    public String exec(ITestExecutionServices tes, String[] args) { 

        String HeadlineStr = "No Headline Available"; 

        String RegExpStr = ".*In the News[^;]*;[^;]*;[^;]*;<a 

href=([^>]*)>([^<]*)<";         Pattern pattern = 

Pattern.compile(RegExpStr, Pattern.DOTALL);         Matcher matcher = 

pattern.matcher(args[0]);                 

        if (matcher.lookingAt()) 

            HeadlineStr = matcher.group(2); 

        else 

            tes.getTestLogManager().reportMessage("Input does not match 

pattern."); 

        return HeadlineStr; 

    } 

The ExtractToken class extracts a particular string from its input argument.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

 * The ExtractToken class demonstrates using Custom Code to extract a particular

 * token (string) from its input argument.  This can be useful for handling

 * certain types of dynamic data correlation.

 *

 * In this sample, the args[0] input string is assumed to be comma-delimited

 * and the token of interest is the next-to-last token.  For example, if

 * args[0] is:

 *    javascript:parent.selectItem('1010','[Negative]1010','1010','','IBM',

 *         '30181','Rational','1','null','1','1','6fd8e261','RPT')

 * the class will return the string 6fd8e261.

 */

 

/**

 * @author IBM Custom Code Samples

 */
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public class ExtractToken implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    public ExtractToken() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        String ArgStr;

        String NextToLastStr;

        String[] Tokens = args[0].split(",");

                

        if (Tokens.length > 2) {

            ArgStr = Tokens[Tokens.length - 2];        // Extract next-to-last token

 

            // Remove enclosing '' 

            NextToLastStr = ArgStr.substring(1, ArgStr.length() - 1);

        } else {

            tes.getTestLogManager().reportMessage("Could not extract value");

            NextToLastStr = null;

        }

        return NextToLastStr;

    }

}

Retrieving the maximum JVM heap size
The JVM_Info class retrieves the maximum heap size of the JVM.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

import java.net.*;
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/**

 * The JVM_Info class retrieves the maximum heap size of the JVM. 

 * It writes a message in the test log with the hostname where the

 * JVM is running and the JVM's maximum heap size in megabytes.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class JVM_Info implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    public JVM_Info() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {

        Runtime rt = Runtime.getRuntime();

        long maxMB = rt.maxMemory()/(1024*1024); // maxMemory() size is in bytes

        String hostName = "Unknown";        

                

        try {

            hostName = InetAddress.getLocalHost().getHostName();

        } catch (UnknownHostException e1) {

            tes.getTestLogManager().reportMessage("Can't get hostname");

            return null;

        }

                

        tes.getTestLogManager().reportMessage("JVM maximum heap size for host "

                                        + hostName + " is " + maxMB + " MB");

        return null;

     }

}
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Running an external program from a test
The ExecTest class runs a program, defined in the execName variable, on the system where the test is 

running.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.services.ITestLogManager;

import org.eclipse.hyades.test.common.event.VerdictEvent;

 

import java.io.IOException;

 

/**

 * The ExecTest class runs a program, defined in the execName variable,

 * on the system where the test is running.

 * The test verdict is set to PASS if the program return code is 0.

 * The test verdict is set to FAIL if the program doesn't execute or 

 * if the program return code is non-zero

 * In this sample, the program is perl.exe.

 */

 

/**

 * @author IBM Custom Code Samples

 */

 

public class ExecTest implements

        com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    /**

     * Instances of this will be created using the no-arg constructor.

     */

    public ExecTest() {

    }

 

    public String exec(ITestExecutionServices tes, String[] args) {
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        ITestLogManager logger = tes.getTestLogManager();

        int rtnval = 1;

        Process p = null;

        String execName = "C:/Windows/System32/perl.exe C:/Perl/true.pl";

 

        Runtime rt = Runtime.getRuntime();

        // Execute test

        try {

            p = rt.exec(execName);

        } catch (IOException e) {

            logger.reportMessage("Unable to run = " + execName);

            logger.reportVerdict("Execution of " + execName + " failed",

                                                VerdictEvent.VERDICT_FAIL);

            return null;

        }

 

        // Wait for the test to complete

        try {

            rtnval = p.waitFor();

            logger.reportMessage("Process return value is " +

                                                String.valueOf(rtnval));

        } catch (InterruptedException e1) {

            logger.reportMessage("Unable to wait for " + execName);

            logger.reportVerdict("WaitFor on " + execName + " failed",

                                                VerdictEvent.VERDICT_FAIL);

            return null;

        }

 

        // Check the test return code and set the test verdict appropriately

        if (rtnval != 0)

        {

            logger.reportVerdict("Execution failed", VerdictEvent.VERDICT_FAIL);

        } else {

            logger.reportVerdict("Execution passed", VerdictEvent.VERDICT_PASS);

        }

 

        return null;
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    }

}

Adding custom counters to reports
When you want to monitor the specific requirement, you can add custom counters to performance report 

by using the custom code. After running tests, the results from the custom counters are automatically 

aggregated in the same way that the default performance testing counters.

Starting from V10.1.0, you can view and monitor the counter information generated by the custom code 

on a graph when the custom code starts in the test run.

After running tests, you can view the custom counter in the report. You can also view the custom counter 

information on a different page by creating a custom report. For more information about customizing the 

report, see related links.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

You can add the following custom code in your test to create a custom counter in a report.

package test;

 

import org.eclipse.hyades.test.common.event.VerdictEvent;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.services.stats.CountAggregationLevel;

import com.ibm.rational.test.lt.kernel.services.stats.CounterUnits;

import com.ibm.rational.test.lt.kernel.services.stats.ICounterFolder;

import com.ibm.rational.test.lt.kernel.services.stats.ICounterRegistry;

import com.ibm.rational.test.lt.kernel.services.stats.IStatisticsManager2;

import com.ibm.rational.test.lt.kernel.services.stats.IValueCounter;

import com.ibm.rational.test.lt.kernel.services.stats.ValueAggregationLevel;

 

import database.DatabaseAccess;

import database.TransactionResult;

 

public class DatabaseStats implements com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {
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 private static boolean registerDone;

 

 /**

  * This method declares the counters that will be produced during execution.

  * Declaring counters is optional, but it allows to customize some of their

  * attributes, such as the label and unit, and what level of statistical information

  * will be available in reports.

  */

 private static synchronized void registerCounters(ICounterRegistry registry) {

  if (registerDone) return;

  registry.path("Database", "Transaction", "Attempts")

   .count()

   .aggregationLevel(CountAggregationLevel.RATE_RANGE)

   .label("Started Transactions")

   .unit("transactions")

   .register();

  

  registry.path("Database", "Transaction", "Commits")

   .verificationPoint()

   .label("Transaction Commits VP")

   .register();

  

  registry.path("Database", "Transaction", "Response Time", "Network")

   .value()

   .aggregationLevel(ValueAggregationLevel.RANGE)

   .unit(CounterUnits.MILLISECONDS)

   .register();

   

  registry.path("Database", "Transaction", "Response Time", "Commit")

   .value()

   .aggregationLevel(ValueAggregationLevel.DISTRIBUTION)

   .unit(CounterUnits.MILLISECONDS)

   .register();

  

  registry.path("Database", "Error")

   .text()

   .label("Database Error Message")
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   .register();

  registerDone = true;

 }

 

 private DatabaseAccess database = DatabaseAccess.INSTANCE;

 

 /**

  * This custom code adds a record in database. It produces a couple of counters,

  * such as the database transaction attempts, successes/failures, and response time.

  */

 public String exec(ITestExecutionServices tes, String[] args) {

  String product = args.length > 0 ? args[0] : "Default";

  IStatisticsManager2 mgr = tes.getStatisticsManager2();

  registerCounters(mgr.registry());

  

  database.startTransaction();

  mgr.getCountCounter("Database", "Transaction", "Attempts").increment();

 

  database.executeQuery("INSERT INTO TABLE Purchases VALUES('" + product + "', 1000)");

  TransactionResult result = database.commit();

  

  mgr.getVerificationPointCounter("Database", "Transaction", "Commits")

   .increment(result.isSuccess() ? VerdictEvent.VERDICT_PASS : VerdictEvent.VERDICT_FAIL);

  if (!result.isSuccess()) {

   mgr.getTextCounter("Database", "Error").addMeasurement(result.getErrorMessage());

  }

  

  ICounterFolder times = mgr.getFolder("Database", "Transaction", "Response Time");

  times.getValueCounter("Network").addMeasurement(result.getNetworkTime());

  times.getValueCounter("Commit").addMeasurement(result.getCommitTime());

  

  IValueCounter value = tes.getStatisticsManager2().getValueCounter("MyStats", "Value");

  value.addMeasurement(System.nanoTime() % 2000);

  

  return null;

 }
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}

Related information

Creating custom Java code  on page78

Creating custom reports  on page

Using transactions and statistics
You can use custom code to start transactions, gather additional statistics during a transaction, and stop 

a transaction.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

The following code shows how to start a transaction. Transactions that are generated by test execution 

services automatically create and manage statistics.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.services.ITransaction;

 

/** 

 * @author IBM Custom Code Samples

 */ 

public class BeginTransaction implements

  com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

 /**  

  * Instances of this will be created using the no-arg constructor.  

  */ 

 public BeginTransaction() {  

 }   

 

 /**  

  * For Javadoc information on the ICustomCode2 and ITestExecutionServices interfaces,  

  * see the 'Test execution services interfaces and classes' help topic.  
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  */  

 public String exec(ITestExecutionServices tes, String[] args) {   

  // the name of the transaction could have been passed in via data correlation mechanism.   

  ITransaction foo = tes.getTransaction("foo");   

  foo.start();   

  return null; 

 }  

}

The following code shows how to gather additional statistics during a transaction.

package customcode;

 

import com.ibm.rational.test.lt.kernel.ITime;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.statistics.IScalar;

import com.ibm.rational.test.lt.kernel.statistics.IStat;

import com.ibm.rational.test.lt.kernel.statistics.IStatTree;

import com.ibm.rational.test.lt.kernel.statistics.impl.StatType;

 

/**

 * @author IBM Custom Code Samples

 */

public class BodyTransaction implements

  com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

 /**

  * Instances of this will be created using the no-arg constructor.

  */

 public BodyTransaction() {

 }

 

 /**  

  * For Javadoc information on the ICustomCode2 and ITestExecutionServices interfaces,  

  * see the 'Test execution services interfaces and classes' help topic.  

  */  

 public String exec(ITestExecutionServices tes, String[] args) {

  IStatTree tranStat;

  IStatTree timeStat;



Chapter 1. Test Execution Specialist Guide

  IStatTree countStat;

  

  IStat timeDataStat = null;  // counter for the time RANGE

  IScalar countDataStat = null; // counter for the count SCALAR

  

  ITime timer = tes.getTime();

  

        IStatTree rootStat = tes.getStatisticsManager().getStatTree();

        if (rootStat != null) {

         // these counters set up the hierarchy

         tranStat = rootStat.getStat("Transactions", StatType.STRUCTURE);

         timeStat = tranStat.getStat("Body Time", StatType.STRUCTURE);

         countStat = tranStat.getStat("Bocy Count", StatType.STRUCTURE);

        

         // the name of the counters could have been passed in via data correlation mechanism

         timeDataStat = (IStat) timeStat.getStat("foo", StatType.RANGE);

         countDataStat = (IScalar) countStat.getStat("foo", StatType.SCALAR);

        }

 

        // get the start time

        long startTime = timer.timeInTest();

        

        // do the work

        // whatever that work might be

        

        // get the end time

        long endTime = timer.timeInTest();

        

        // update timeDataStat with the elapsed time

        if (timeDataStat != null)

         timeDataStat.submitDataPoint(endTime - startTime);

        

        // update the countDataStat

        if (countDataStat != null)

         countDataStat.increment();

        

  return null;
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 }

 

}

The following code shows how to stop a transaction.

package customcode;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.kernel.services.ITransaction;

 

/**

 * @author IBM Custom Code Samples

 */

public class EndTransaction implements

  com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

 /**

  * Instances of this will be created using the no-arg constructor.

  */

 public EndTransaction() {

 }

 

 /**  

  * For Javadoc information on the ICustomCode2 and ITestExecutionServices interfaces,  

  * see the 'Test execution services interfaces and classes' help topic.  

  */  

 public String exec(ITestExecutionServices tes, String[] args) {

  // the name of the transaction could have been passed in via data correlation mechanism.

  ITransaction foo = tes.getTransaction("foo");

  foo.stop();

  return null;

 }

 

}
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Reporting custom verification point failures
You can use custom code to report a custom verification point failure.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

The following code shows how to report a custom verification point failure.

package customcode;

 

import org.eclipse.hyades.test.common.event.VerdictEvent;

import org.eclipse.hyades.test.common.runner.model.util.Verdict;

 

import com.ibm.rational.test.lt.execution.core.IVerificationPoint;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

 * @author IBM Custom Code Samples

 */

public class Class implements

  com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

 /**

  * Instances of this will be created using the no-arg constructor.

  */

 public Class() {

 }

 

 /**

  * For javadoc of ICustomCode2 and ITestExecutionServices interfaces, select 'Help Contents' in the

  * Help menu and select 'Extending Rational®  Performance Tester  functionality' -> 'Extending test execution with 

 custom code'

  */

 public String exec(ITestExecutionServices tes, String[] args) {

  tes.getTestLogManager().reportVerificationPoint("CustomVP", VerdictEvent.VERDICT_FAIL);

  return null;

 }

 

}
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Debugging custom code
This example demonstrates debugging custom code by adding a breakpoint. It provides sample code to 

add a breakpoint. This way of debugging custom code is applicable only for a schedule.

1. Start IBM®  Rational®  Performance Tester  and create a performance test project MyProject.

2. Create an HTTP test, MyTest, by recording a visit to http://<hostname>:7080/.

Note:  Before accessing the URL, ensure that Rational®  Performance Tester  is running. The 

URL returns an HTTP 404 error, which is expected.

3. Expand the first request and click the response element.

4. In the Test Element Details section, right-click in the Content  field and click Create Field Reference.

5. Type the reference name and click OK.

6. Click the first page, and then click Add  > Custom Code.

7. In the Arguments  section of Test Element Details, click Add.

8. Expand the data source for the search results page, select the reference name that you created in 

step 5, and click Select.

9. Click Generate Code.
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A new tab with the generated code is displayed.

10. Insert the following the code into the exec()  method:

ITestLogManager history = tes.getTestLogManager();

if (args.length > 0) {

    if (args[0].indexOf("Invester Relations") != -1) {

        history.reportMessage("First page failed.  Bail loop!");

        tes.getLoopControl().continueLoop();

    }

}

Important:

• Fix the double quotation marks, if any, so they are straight and the compiler no longer gives 

warning.

• To resolve complier warnings related to importing a class, press Ctrl + Shift + O.

The code will look like this:

11. To set a breakpoint, click anywhere on the args[0].indexOf  line. Move the pointer to the left-most 

portion of the text editor window and double-click with the pointer horizontally on the same line. A 

blue button is displayed in this left-most portion of the window indicating the breakpoint is set.

12. Save the custom code and then the test.

13. Create a new schedule, Schtest.
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a. In Schtest, set the number of users to run to 1.

b. Click User Group 1  and click Add  > Test. Select the MyTest  test and click OK.

c. Click User Group 1  and click the Run this group on the following locations  button.

d. Click Add  > Add New.

e. In the New Location  window, type the following information:

i. In Host name, type localhost.

ii. In Name, type debuglocation.

iii. In Deployment directory, type C:\mydeploy.

iv. Click Finish.

f. Save the schedule.

14. In the Test Navigator, right-click debuglocation  and click Open.

15. Click the General Properties  tab and click Add.

16. In the Property name  field, type RPT_VMARGS  and in the Property value  field, add the following values 

each separated by a space.

-Xdebug

-Xnoagent

-Djava.compiler=NONE

-Xrunjdwp:transport=dt_socket,server=y,suspend=y,address=8000

17. Save the location.

18. Attach the debugger to the schedule execution process.

a. Run the schedule.

Because the schedule is using debuglocation, it will pause at the beginning to let you attach 

the debugger to the execute process.
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b. Click Window  > Open Perspective  > Other  > Debug.

c. Click Run  > Debug Configurations.

d. In the Debug Configurations  window, right-click Remote Java Application  and click New.

e. Click Debug.

A list of running threads are displayed in the Debug window and the schedule execution 

pauses at the debug breakpoint.

f. If you are doing it for the first time, you might need to provide the source location to see the 

custom Java code. You do this by taking the following steps:

i. Click Edit Source Lookup Path  and click Add.

ii. Click Workspace Folder  > OK.

iii. Now, expand MyProject, select the src folder, and click OK. The schedule run stops at 

the specified breakpoint. 
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Accessing the actual schedule name from the custom code
When there are any special characters in the name of the schedule, you can write the actual name of the 

schedule in the test log by using the appropriate interface in the custom code.

The following sample custom code shows how to write the name of the schedule in the test log:

package customcode;

 

import com.ibm.rational.test.lt.kernel.engine.impl.Engine;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

 

@author Custom Code Samples
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*/

public class GetActualScheduleName implements com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

/**

 

Instances of this will be created using the no-arg constructor.

*/

    public GetActualScheduleName() {

        }

/**

 

For javadoc of ICustomCode2 and ITestExecutionServices interfaces, select 'Help Contents' in the

Help menu and select 'Extending Rational Performance Tester  functionality' -> 'Extending test execution with custom 

 code'

*/

        public String exec(ITestExecutionServices tes, String[] args) { 

            String schName = Engine.getInstance().getSchedule().getScheduleName();

            tes.getTestLogManager().reportMessage("Schedule Name is "+schName);

                   return null; }

}

Reading and writing data from a dataset
When a test is associated with a dataset, you can extend the test either by reading or writing the dataset 

values from the custom code.

The data that you write into the dataset is saved only when you set Open mode  to Shared (for all test 

executions)  in the Edit Dataset  window. In other open modes, the modified data is used only for the test 

run.

The following sample custom code reads and writes the data from the dataset:

package datasets;

 

import java.awt.list;

 

/**

 * @author IBM  Custom Code Samples

 */
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public class myds implements com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

 

    public myds() {

    }

public String exec(ITestExecutionServices tes, String[] args) {

// the name of the dataset is the same as what is shown in the test. The dataset must be added to the test in order

// to get a controller for it.

        IDataSetController control = tes.getDataSetController("/testproj/myds.csv");

        try {

        // once you have the controller you can get a row

        DataSetRow row = control.getNextRow();

        // returns a string representation of the row

        row.getEntireRow();

        // alternatively you can get individual values by the column name

        row.getValue("Column1");

 

        // you can also write a new row to the dataset

        // -1 means append to the end

        // alternatively you can specify a row number and whether to overwrite that row or to insert a new row at the 

 spot

        control.writeRow(-1, Arrays.asList("a", "b", "c"), false);

      } catch (Exception e) {

            tes.getTestLogManager().alwaysReportMessage( e.toString());

            // TODO Auto-generated catch block

            e.printStackTrace();

       }

        return null;

        // or whatever you want to return here

      }

Migrating custom code from previous versions
You can run scripts that contain custom code from previous releases and edit tests to make new calls to 

old or new custom code classes.

You can perform the following tasks without any additional steps:
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• Run a script that contains custom code that was created in a previous release.

• Edit a test to make a new call to an old custom code class.

• Add new custom code to a test that contains old custom code.

To edit a class in existing custom code so that it can call new TestExecutionServices methods, type cast 

the IKlog  argument in the old custom code to the ITestExecutionServices  interface.

When you migrate the custom code from the previous versions, you must use getStatisticsManager2()  as 

getStatisticsManager()  API is deprecated from V10.1.0.

Extending Rational®  Performance Tester  to support other 
protocols
The Rational®  Performance Tester  Extensibility Software Development Kit (SDK) enables you to create 

extensions to support testing new protocols without modifying the core product code. You can create an 

extension that provides functionality for testing other protocols in addition to the HTTP protocol support 

that is standard in Rational®  Performance Tester.

Rational®  Performance Tester  provides the capability to emulate multiple users applying load on a 

system under test. To test performance, you record a test and subsequently replicate it, and then play it 

back against the system being tested. Refer to the Rational®  Performance Tester  product information 

center for more details.

Rational®  Performance Tester  supports the HTTP protocol. The goal of the Extensibility SDK is to provide 

a framework that supports the development of various protocols which can be plugged into Rational® 

Performance Tester.

To develop support for testing protocols in Rational®  Performance Tester, you must be familiar with the 

following areas:

• The protocol that you intend to support

• The Eclipse platform (The Eclipse documentation provides relevant information in the "JDT 

Programmer's Guide" topic.)

• The Test and Performance Tools Platform (TPTP).

For examples of Rational®  Performance Tester  extensions, see the following plug-ins:

• com.ibm.rational.test.lt.sdksamples.core.socket

• com.ibm.rational.test.lt.sdksamples.recorder.socket
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• com.ibm.rational.test.lt.sdksamples.models.behavior.socket

• com.ibm.rational.test.lt.sdksamples.codegen.socket

• com.ibm.rational.test.lt.sdksamples.protocol.socket

• com.ibm.rational.test.lt.sdksamples.testgen.socket

• com.ibm.rational.test.lt.sdksamples.editor.socket

• com.ibm.rational.test.lt.sdksamples.results.socket

• com.ibm.rational.test.lt.sdksamples.datacorrelation.testgen.socket

• com.ibm.rational.test.lt.sdksamples.datacorrelation.execution.socket

Protocol extension structure
Before organizing your extension, note the restrictions and guidelines provided in this topic.

Restrictions

The following restrictions apply to plug-ins:

• The execution portion of the plug-in must be deployed to an agent. You cannot assume that the 

Software Development Workbench is available.

• The execution portion of the plug-in code cannot depend on any workbench code.

• The execution portion of the code cannot depend on the workspace because none is available on 

the agent.

For best results, minimize the amount of code that is deployed to the agent for execution.

Guidelines for naming plug-ins

Most base Rational®  Performance Tester  plug-ins follow this naming convention:

<prefix>.<component>[.subcomponent].<protocol>

where:

prefix: The prefix com.ibm.rational.test.lt  is used for all load-test-specific Rational®  Performance 

Tester  plug-ins.

component: One of the extension components:testgen, datacorrelation, testeditor, codegen, 

execution, or models.

subcomponent: Some plug-ins contain subcomponents (for example, execution.ui  contains 

the UI portion of execution), or they might have separate code based on their use in a different 

component (for example, datacorrelation.testgen  and datacorrelation.execution).

protocol: For example, http, or sap. (Some plug-ins use core  for the base plug-in.)
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Using these conventions, the extension can have the following plug-ins:

• com.ibm.rational.test.lt.recorder.protocol

• com.ibm.rational.test.lt.testgen.protocol

• com.ibm.rational.test.lt.models.protocol

• com.ibm.rational.test.lt.testeditor.protocol

• com.ibm.rational.test.lt.sdksamples.datacorrelation.testgen.protocol

• com.ibm.rational.test.lt.sdksamples.datacorrelation.execution.protocol

• com.ibm.rational.test.lt.codegen.protocol

• com.ibm.rational.test.lt.execution.protocol

• com.ibm.rational.test.lt.execution.results.protocol

Alternatively, you can divide the code into two plug-ins, one for the workbench and one for execution. 

This has the advantage of deploying fewer plug-ins. For an example, refer to the Siebel extension to 

Performance Tester.

Using this method, you would have the following two plug-ins:

• com.ibm.rational.test.lt.protocol

• com.ibm.rational.test.lt.protocol.execution

Within these plug-ins, you can either arrange the components in one of two ways:

• As separate source folders

• As separate packages within a single source folder

Extending the test recorder
To generate a test, the data exchanged by an application and another entity such as a server must be 

recorded. The recorded data is then processed to generate a test.

Data is recorded in a recording session. In a recording session, clients are launched in parallel with 

recorders that capture the data that the clients and the servers (or other external entities) exchange. All 

data that is captured during a recording session is stored in a file.

You can contribute to the recording framework in several ways:
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• By defining a new kind of captured data. Captured data is implemented as recorder packets. You 

can define a new type of recorder packet in which to store relevant information for a specific kind 

of captured data. The product comes with a set of recorder packet types. The packet types include 

proxy packets, socket packets, HTTP packets, SAP packets, and Citrix packets.

• By developing a new recorder to capture a new kind of data or to use a different recording 

technique. The product comes with a set of recorders. The bundled recorders include the HTTP 

proxy recorder, the SOCKS proxy recorder, the socket recorder, the SAP Recorder, and the Citrix 

recorder.

• By developing a new client whose data will be recorded. A client is not necessarily an application, 

but rather the ability to start an application. The product comes with a set of clients. The clients 

include: Application, Manual, Microsoft™  Internet Explorer, Mozilla Firefox, Apple Safari, Opera, 

Google Chrome, Generic Service Client, SAP client, Citrix client, and TN3270 client.

• By defining a new recorder-client binding. A recorder-client binding declares that a recorder is able 

to capture the data that a client sends or receives. A recorder-client binding can also define a client 

decorator, which configures a client so that the client can be recorded by the recorder. For example, 

the product comes with a decorator that can modify Internet Explorer settings so that the browser 

sends its traffic through a proxy recorder.

After the recorder framework has been defined, the user interface (UI) can be extended so that the new 

recording components can be used. The following elements are extensible:

• Packet types, recorders, and clients. You can assign specific icons to these elements.

• Wizards. You can define wizards for configuring a specific client, a specific recorder, several 

recorders together, or a client and several recorders together.

The recording framework has three main UI contributions:

• The New Recording Session  wizard. With this wizard, you can select the client to use, and then 

select the recording technique (in other words, the recorder), and finally set the configuration 

details for the client and the recorder. Extensions can contribute to this wizard. For more 

information, see Defining wizards for recorders and clients  on page 131.

• The Recording Control  view. This view shows the active recording session and the recorders and 

clients that are involved. This view shows a summary of captured data, and messages that the 

recorders and clients have issued. Extensions can contribute to labels and icons that are displayed 

in this view. Any user message that a recorder or a client sends is also displayed in this view.
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• The Recording Session Editor, which opens when you double-click a recording session 

(.recsession) file. The editor shows the same information as the recording control view, but 

includes more details about the captured data. Extensions can contribute actions, labels, and icons 

to this editor.

Defining a new type of captured data
The data captured by a recorder must be stored in a file and consumed by a test generator to produce a 

test. Captured data must be defined so that it can be stored by the recorder and consumed by the test 

generator.

To define a new type of recorded data, complete these tasks:

• Declare a new type of recorder packet in the plugin.xml  file, using the 

com.ibm.rational.test.lt.recorder.core.recorderPacket  extension point.

• Define one or more implementation classes, in the same plug-in that implement the interface: 

com.ibm.rational.test.lt.recorder.core.packet.IRecorderPacket.

These factors apply to IRecorderPacket class implementations:

• You can define as many fields as required to store your data.

• Because these classes are instantiated by a recorder, they must expose a way to construct 

themselves.

• Because a test generator uses these classes, the classes must expose ways to retrieve information 

for the test generator. In other words, they must expose getter methods.

• You must make the classes serializable. Take this into account when designing the classes. 

The classes must not have any references to data that you do not want to include in the stored 

information. Fields that include references to data that you do not want stored must be declared 

using the transient  keyword. If you plan to have evolutions to these classes, make sure that these 

evolutions are compatible with earlier versions.

Recorder packets have these common features:

• They have a type. This must be a type ID that is declared in an extension to the 

com.ibm.rational.test.lt.recorder.core.recorderPacket  extension point. The implementation 

class must be in the same plug-in where the type ID is declared.

• They have a start time and end time. This is important for sorting captured packets, as recorders 

typically do not send the packets at the exact same time as they are captured. Many packets have 
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the same time for start and end events, because they are atomically captured. Packets do not have 

to have different start and end times. Packet end times must, however, be higher or equal to the 

start time. All timestamps must be expressed in units that the framework provides. The units must 

be of the highest accuracy that the system permits.

For best results, follow these practices for implementing recorder packets:

• If you have more than one type of data, define an interface that all implementation classes 

implement.

• Define an interface for each concrete implementation class, which exposes only read-only features 

of the class. The test generator requires access only to the interfaces, while the recorder requires 

access to the classes.

• Do not define redundant or computable fields. Because the classes are serialized, a single 

additional field might make the recording file much larger if many packets are stored. Declare a 

redundant or computable field using the transient  keyword.

Defining a new recorder
To capture a new kind of data or an existing kind of data with a new recording technique, define a new 

recorder.

The only required task for a recorder is to capture data. The recorder does not start or configure a client. 

If you need to start a client or configure a client so that the client can be recorded by a recorder, see 

Defining a new client  on page 127 and Defining how a recorder can record a client  on page 129.

To define a new recorder:

• Declare a new recorder type in the plugin.xml  file. Use the 

com.ibm.rational.test.lt.recorder.core.recorder  extension point.

• Determine whether the recorder can be run locally, within the workbench, or if it must run remotely 

in a separate Java™  virtual machine (JVM).

• Define a delegate, which is the implementation class of the recorder. The delegate starts and stops 

the recorder, and captures data.

• If the recorder is remote, define a remote launcher implementation that provides details about the 

JVM that runs the delegate.

• Optionally, define a prerequisite validator that performs basic verification that the recorder can be 

run on the current computer.

• Declare which types of recorder packets are emitted by the recorder.
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Follow these requirements for implementing the IRecorderDelegate  interface:

• This interface starts and stops the recorder and provides notification about events such as 

"recorder started," "recorder stopped," and "packet captured." You must provide an implementation 

of this interface. Optionally, a recorder can support being paused and resumed. If the recorder does 

not support pause and resume operations, ensure that the implementations of the methods are 

empty.

• Most methods are asynchronous. In other words, the framework does not require that the 

operation be completed when the method returns. For this reason, a recorder delegate must notify 

the framework when an operation is complete.

• A recorder can have a configuration. The configuration is built either by using a XML file with 

the .recconfig extension or by using a wizard. For an example of an XML file, open an existing 

recording session file, and then click File  > Save recording configuration as. The configuration is 

stored in a RecorderConfiguration object, which is a map of strings to various types of objects. A 

recorder delegate reads its configuration in its initialize() method.

• A recorder delegate is given a context in its initialize() method. This context enables the recorder to 

send notifications of events, record log messages, and send captured packets.

• Typically, you extend the BaseRecorderDelegate class rather than directly implement 

IRecorderDelegate  interface. The base abstract class provides a basic behavior for most methods, 

so that you can override only those needed.

• A recorder must use the getContext().packetCaptured() method to notify the framework when it 

has captured data.

• When a recorder constructs a packet, the packet must be filled with a recorder 

ID. The recorder ID is attributed by the framework and can be retrieved using the 

getContext().getComponentUniqueId() method.

• When a recorder constructs a packet, the packet must be filled with time information. The time 

information must be expressed in a unit that the framework defines. The current time, expressed in 

the framework units, can be retrieved using the getContext().currentTime() method.

• A recorder delegate can send messages to the user by invoking the sendUserMessage() method or 

the getContext().sendMessage(new UserMessage(...)) method if the delegate does not extend the 

BaseRecorderDelegate class.

• A recorder delegate can be enabled to communicate with outside entities by setting or retrieving 

dynamic properties or by receiving messages. A recorder delegate is useful only if you develop a 

specific UI for the recorder or if you define a client decorator for the recorder.
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Defining a new client
To produce data, a recording session must start at least one client. Several clients come with the product. 

To automate starting a specific application, you can define a new client.

The only task for the client is to start an application and to notify the recording framework about client life 

cycle events. To configure a client so that it can be recorded by a recorder, see Defining how a recorder 

can record a client  on page 129.

Sometimes there is no client to launch because the client already exists or because the client is a system 

that has its own life cycle. In this case, you can use the Manual client that comes with the product. The ID 

of the Manual client is com.ibm.rational.test.lt.recorder.core.manualClient.

To define a new type of client, complete these tasks:

• Declare a new client type in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.core.client  extension point.

• Determine whether the client can be run locally within the workbench, remotely in a separate JVM, 

or in the same JVM as the recorder to which it is bound.

• Define a delegate, which is the implementation class of the client. The delegate starts and stops 

the client and notifies the framework when the client is started or closed.

• If the client is remote, define a remote launcher implementation that provides details about the 

JVM that runs the delegate.

• Optionally, define a prerequisite validator that performs basic verification that the client can be run 

on the current computer.

To implement the IClientDelegate  interface:

• You must provide an implementation of this interface. This interface starts and stops the client and 

sends notifications of events such as "client started" and "client stopped."

• The start() and stop() methods are asynchronous. In other words, the operation does not need 

to be complete when these methods return. For this reason, a client delegate must notify the 

framework when an operation is complete.

• The stop() operation is invoked only when the user clicks Stop  in the user interface. In many cases, 

the user gestures in the application itself to close the application. The delegate must monitor the 

application and notify the framework when the application is closed.

• A client can have a configuration. The configuration is built either by using an XML file, which 

is a file with the .recconfig extension or by using a wizard. For an example of an XML file, open 

an existing recording session file, and then click File  > Save recording configuration as. The 

configuration is stored in a ClientConfiguration object, which is a map of strings to various types of 

objects. A client delegate reads this configuration in its initialize() method.
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• A client delegate is given a context in its initialize() method. This context enables the recorder to 

send notifications of events and record log messages.

• Typically, you extend the BaseClientDelegate class rather than directly implement the 

IClientDelegate class. The base abstract class provides a basic behavior for most methods. You 

can override specifically those that you must override.

• A client delegate can send messages to the user by calling the sendUserMessage() method, or 

by calling the getContext().sendMessage(new UserMessage(...)) method if the delegate does not 

extend the BaseClientDelegate class.

• A client delegate can be enabled to communicate with outside entities by setting or retrieving 

dynamic properties, or by receiving messages. The client delegate is useful only if you develop a 

specific UI for the client or if you define a client decorator for the client.

If your client launches a specific process, you can extend the 

com.ibm.rational.test.lt.recorder.core.clients.ProcessBuilderClientDelegate class. In this case, you 

need to extend only the initialize() method, and then invoke setter methods to set up the command line, 

arguments, environment variables, and working directory.

Defining how a recorder can record a client
All recorders cannot record all clients. The framework must be notified that a recorder can record a client. 

In many cases, the recorder must configure a client before recording, and then undo these configuration 

actions when the client is closed. In these cases, you can declare a client decorator. A client decorator is a 

class that configures a client so that it can be recorded by a recorder.

To declare that a recorder can record a client:

• Declare a new recorder-client binding in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.core.recorderClientBinding  extension point.

• Specify the IDs of the recorder and the client that are compatible.

• Optionally, declare a client decorator. A client decorator is a class that modifies a client so that it 

can be recorded by the recorder.

To implement a client decorator, define an implementation of the 

com.ibm.rational.test.lt.recorder.core.extensibility.IClientDecorator class.

The implementation has two main methods: decorate() and undecorate(). The decorate() method is called 

when the recorder starts running, but before the client is launched. The undecorate() method is called 

after the client is closed, but before the recorder is stopped.
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The decorator can interact with the recorder delegate and the client delegate by setting or getting 

properties from them. The methods for doing so are available in the decorator context. The client and the 

recorder must support the properties.

Typically, you extend the BaseClientDecorator class rather than directly implementing the IClientDecorator 

class. The base abstract class provides a basic behavior for most methods. With that class, you can 

override specifically those methods that you must override.

Running recorders and clients without a UI
To test recorders, clients, and decorators during the development process, you can run those elements 

before any UI components are ready to start the recorders, clients, and decorators.

You can start a recording session that includes the recorders or clients that you have developed by using 

a recording session configuration file. This file specifies which recorders and clients to start and the 

options for the recorders and clients to use.

The following file is an example of such a configuration file:

<?xml version="1.0" encoding="UTF-8"?>

<__PT_EXTERNAL__:session xmlns:__PT_EXTERNAL__="__PT_EXTERNAL__">

   <rec:myRecorder  <-- recorder configuration -->

    xmlns:rec="recorder:org.xyz.myplugin"

    option1="value1"

    option2="value2"

    id="myRecorder1"/>

   <cli:myClient  <-- client configuration -->

    xmlns:cli="client:org.xyz.myplugin"

    optionA="valueA"

    id="myClient1"/>

   <__PT_EXTERNAL__:binding client="myClient1" recorder="myRecorder1"/>

</__PT_EXTERNAL__:session>

In the preceding example, replace org.xyz.myplugin  with the name of the plug-in that defines the recorder 

and the client. Replace myRecorder  with the recorder ID and myClient  with the client ID. The option1  and 

option2  attributes can be replaced by attributes that the recorder supports. You can replace the optionA 

attribute with an attribute that the client supports. You must save the file with the .recconfig extension.

In the configuration file, a session node can contain as many recorder configurations and client 

configurations as required. All the recorders and clients that are referred to are launched together and the 

options from the configuration file are passed to them. All recorders and clients must have id  attributes so 
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the recorder and clients can be referred to in a binding node. Examples of recording session configuration 

files can be generated by opening an existing recording session and clicking File  > Save Recording 

Configuration As.

To start a recording session from a recording configuration file, right-click the file, and then select Start 

Recording Session.

Defining wizards for recorders and clients
You can define wizards for recorders and clients.

The New Recording Session  wizard runs in the following sequence:

1. The recording session file is selected.

2. The client is selected.

3. The recording method is selected.

4. The client wizard pages are displayed.

5. The recorder wizard pages are displayed.

Steps 4 and 5 can be combined in into a single step. Steps 4 and 5 are extension contributions.

Declare a wizard for each client and each recorder that you define. A client or a recorder that has 

no declared wizard is not available in the user interface and can be started only with a recording 

configuration file or programmatically.

When the New Recording Session  wizard is complete, the wizard produces a recording session 

configuration that contains a client configuration and one or more recorder configurations. The recording 

session configuration is used to start a recording session and to instantiate the corresponding recorders 

and clients.

Several types of wizards can be defined, depending on how you have defined recorders and clients:

• If you have defined only a recorder and you plan to use a client that comes with the product, define 

a recorder wizard.

• If you have defined one or more types of clients and one or more types of recorders, and you want 

to combine clients and recorders in several ways, define a wizard for each client and a wizard for 

each recorder.

• If you have defined one recorder type and one client type to be used together, consider defining a 

unique wizard that configures both of them.

Additional information about the New Recording Session  wizard:
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• The recording method selection step is displayed only if there is more than one recording method 

available for the client that is selected in step 2.

• Wizards that configure both recorders and clients take precedence over separate wizards for 

clients and recorders.

To define a client wizard:

• Declare a new client wizard in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.ui.clientWizard  extension point.

• Specify the client ID that the client wizard configures.

• Optionally, provide an implementation class. If you do not provide a class, the 

wizard has no configuration page. If you provide a class, it must extend the 

com.ibm.rational.test.lt.recorder.ui.wizards.NewClientWizard class.

About the NewClientWizard class implementations:

• This class extends the JFace class wizard, so the class must extend typical methods such as 

addPages().

• The class is passed an empty client configuration, typed with the client ID selected by the user in 

step 2.

• The class sets the client configuration options, which are available using the 

getClientConfiguration() method. This configuration is typically done in the doPerformFinish() 

method.

To define a recorder wizard:

• Declare a new recorder wizard in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.ui.recorderClientWizard  extension point and the 

recordersWizard  element.

• Specify one or more recorder IDs that the recorder wizard configures.

If the recorder wizard declares configurations for more than one recorder, examine the 

performsRecorderSelection  attribute. This attribute specifies whether the wizard enables the user 

to choose which recorders to use or if the framework chooses which recorder to use. Depending 

on the conditions, the attribute then calls the wizard with the recorder ID that the user selected. In 

the first case, the recording method selection step is always displayed, whereas in the latter case, 

the recording method selection step can be skipped. In the first case, the wizard can enable several 

recorders, whereas in the latter case, only one recorder is enabled. Choose the first option if you 

need to enable more than one recorder in one recording session.
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• Provide an implementation class. This is optional only if you have associated the wizard with 

exactly one recorder or if the performsRecorderSelection  attribute is false. If you do not 

provide a class, the wizard has no configuration page. If you provide a class, it must extend the 

com.ibm.rational.test.lt.recorder.ui.wizards.NewRecordersWizard class.

About NewRecordersWizard implementations:

• This class extends the JFace class Wizard, so it must extend typical methods such as addPages().

• If the performsRecorderSelection  value is true, the class is passed null to its initialize() method 

and it must invoke the setRecorderConfigurations() method from its doPerformFinish() method, 

with the recorder configurations for each recorder that must be included in the recording session.

• If the performsRecorderSelection  value is false, the class is passed an empty recorder 

configuration, typed with the recorder ID selected in step 3, to its initialize() method and it must fill 

the empty recorder configuration with recorder options in its doPerformFinish() method.

To define a wizard that configures a client and one or more recorders altogether:

• Declare a new recorder and client wizard in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.ui.recorderClientWizard  extension point and the 

combinedWizard  element.

• Specify the client ID that this wizard configures.

• Specify one or more recorder IDs that this wizard configures.

• If this wizard declares configurations for more than one recorder, examine the 

performsRecorderSelection  attribute. This attribute specifies whether the wizard lets the user 

choose which recorders to use or if the framework chooses which recorder to use, and then 

invokes the wizard with the recorder ID selected by the user. In the first case, the recording method 

selection step is always displayed, whereas in the latter case, the recording method selection step 

can be skipped. In the first case, the wizard can enable several recorders, whereas in the latter 

case, only one recorder is enabled. Choose the first option if you need to enable more than one 

recorder in one recording session.

• Provide an implementation class. This is optional only if you have associated the wizard with 

exactly one recorder or if the performsRecorderSelection  attribute is false. If you do not 

provide a class, the wizard has no configuration page. If you provide a class, it must extend the 

com.ibm.rational.test.lt.recorder.ui.wizards.NewRecorderClientWizard class.

About NewRecorderClientWizard class implementations:
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• This class extends the JFace class Wizard, so it must extend typical methods such as addPages().

• If performsRecorderSelection  is true, the class is passed a null recorder configuration to 

its initialize() method and it must invoke the setRecorderConfigurations() method from its 

doPerformFinish() method, with the recorder configurations for each recorder that must be 

included in the recording session.

• If performsRecorderSelection  is false, the class is passed an empty recorder configuration, typed 

with the recorder ID selected in step 3, to its initialize() method and it must fill the empty recorder 

configuration with recorder options in its doPerformFinish() method.

• The class is passed a client configuration, typed with the client ID selected in step 2, to its 

initialize() method. It must fill the client configuration with client options in its doPerformFinish() 

method.

Migrating recorder implementations from previous versions
The new recording framework includes significant improvements over the generic recorder framework 

(GRF) that was delivered in previous versions. The new framework introduces more flexibility for 

combining clients and recorders. With the framework, you can start multiple recorders and clients in one 

session, consolidating the recorded data in one file.  In addition, the framework does not use the TPTP 

Agent Controller, and thus does not require recorders and clients to be run in a separate Java™  Virtual 

Machine. Finally, the new framework provides improved performance and better scalability in terms of the 

amount of recordable data and the impact on memory usage.

The API has been completely redefined to produce these improvements. Migrating existing recorder 

implementations to the new framework requires significant effort. The following tables summarize the 

changes to classes and methods in the new recording framework.

Previous class
New recording frame

work, version 8.2 and later
Comments

com.ibm.rational.test.lt.trace

.PayloadMsg

com.ibm.rational.test

.lt.recorder.core.packet

.IRecorderPacket com.ibm.ra

tional.test.lt.recorder.core.pack

et.connection.IConnectionPack

et

Use Java™  serialization for seri

alization in this product version. 

If packets support connections, 

extend the IConnectionPacket 

interface and its subinterfaces. 

This extension enables filtering 

capabilities at test-generation 

time.
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Previous class
New recording frame

work, version 8.2 and later
Comments

org.eclipse.hyades.execution

.recorder.remote.RecorderA

gent

com.ibm.rational.test.lt

.recorder.core.extensibility

.BaseRecorderDelegate

The run() method has been re

placed with the start() method. 

The threads that this method 

can start are no longer moni

tored by the framework. The 

setIsReady(true) method has 

been replaced with the send

Started(enabled) method. 

The handleCommand(STOP) 

method has been replaced with 

the stop() method. The class 

calls the sendStopped() method 

when the recorder has stopped. 

(This event was previously im

plicitly notified by the termina

tion of the thread returned by 

the run() method.) This class 

is no longer required to run in a 

separate JVM.

org.eclipse.hyades.execution

.recorder.remote.Recorder

EnvironmentAdapter org.e

clipse.tptp.test.provisional

.recorder.framework.Abstract

RecorderExecOptionsProvider 

org.eclipse.hyades.execution

.recorder.remote.RecorderExe

cutableObjectAdapter

com.ibm.rational.test.lt

.recorder.core.deploy.IRemote

Launcher

This class is required only if the 

recorder delegate must run in 

a separate JVM. With this ver

sion, you can add classpath en

tries and system properties to 

the launched JVM. There is no 

requirement for file deployment 

because the JVM is always run 

on the local computer. Record

ing on remote computers was 

never enabled in previous re

leases. The AbstractRecorder

ExecOptionsProvider.getAgent

ClassPath() and RecorderEx

ecutableObjectAdapter.getA
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Previous class
New recording frame

work, version 8.2 and later
Comments

gentClassPath() classes are re

placed by the delegate class de

claration in the extension point.

org.eclipse.tptp.test.provision

al.recorder.messages.Abstract

RecorderMessageProvider

None The IRecorderPacket auto-se

rialization class and the frame

work handle message serializa

tion in this version. Implement

ing this class is no longer re

quired.

org.eclipse.tptp.test.provisional

.recorder.ui.wizards.DefaultRec

WizardProvider

com.ibm.rational.test.lt

.recorder.ui.wizards.New

RecorderWizard com.ibm.ratio

nal.test.lt.recorder.ui.wizards

.NewRecorderClientWizard

org.eclipse.tptp.test.provisional

.recorder.framework.Recorder

ClientHelperAdapter

None The framework automatically 

handles the step that this class 

completed in earlier versions.

Previous extension point
New recording frame

work, version 8.2 and later
Comments

org.eclipse.hyades.test.core

.Recorder#Recorder.protocol

com.ibm.rational

.test.lt.recorder.core

.recorder#recorder.outputPack

et

org.eclipse.hyades.test.core

.Recorder#Recorder.id

com.ibm.rational.test.lt

.recorder.core.recorder#id

org.eclipse.hyades.test.core

.Recorder#Recorder.name

com.ibm.rational.test.lt

.recorder.core.recorder#name

org.eclipse.hyades.test.core

.Recorder#Recorder.recorderA

gent

com.ibm.rational

.test.lt.recorder.core

.recorder#recorder.delegate
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Previous extension point
New recording frame

work, version 8.2 and later
Comments

org.eclipse.hyades.test.core

.Recorder#Recorder.recorder

ClientHelper

None The framework automatically 

handles the step that this class 

handled in earlier versions.

org.eclipse.hyades.test.core

.Recorder#Recorder.recorder

MessageHandlers

None The IRecorderPacket auto-se

rialization class and the frame

work handle message serializa

tion in this version. Implement

ing this class is no longer re

quired.

org.eclipse.hyades.test.core

.Recorder#Recorder.wizard

PageProvider

com.ibm.rational.test.lt

.recorder.ui.recorderClientWiz

ard#recordersWizard.class

org.eclipse.hyades.test.core

.Recorder#Recorder.execOp

tionsProvider

com.ibm.rational

.test.lt.recorder.core

.recorder#recorder.remote

Launcher

See the previous comment 

about the AbstractRecorderExe

cOptionsProvider class.

org.eclipse.hyades.test.core

.Recorder#Recorder.requiresIn

termediateFile

None This option is no longer sup

ported. Recording sessions are 

always kept after recording.

org.eclipse.hyades.test.core

.Recorder#Recorder.fileExten

sion

None This option is no longer sup

ported. The recording format 

and extension are now always 

controlled by the framework in 

a .recsession file.

org.eclipse.hyades.test.core

.Recorder#Recorder.icon

com.ibm.rational.test.lt

.recorder.ui.recordingUiI

mage#recorderImage.icon

org.eclipse.hyades.test.core

.Recorder#Recorder.description

com.ibm.rational.test.lt

.recorder.ui.recorderClientWiz

ard#recordersWizard.descrip

tion
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Extending the test generation framework
Test generation consists of processing the recorded data and producing a test.

The recording-session file that is produced during recording provides the input for the test generation 

operation. Before writing a test generator, you must identify the type of data that the generator uses.

Recording and test generation are typically chained when you use the New Test From Recording  wizard, 

but this relationship is not always established. The user can choose to produce only a recording, using the 

New Recording Session  wizard, and can also choose to generate a test from an existing recording.

Test generation happens in the following stages and phases:

• The conversion stage is a preliminary step, during which the original packets can be filtered, sorted, 

aggregated, or converted to a different, typically higher-level, protocol. Extensions can contribute 

additional converters. For more information, see Defining a new packet converter  on page 140.

• The test generation stage consists of using the recorder packets that are sent from the converter 

stage, and then distributing the recorder packets to the appropriate test generator. The test 

generator then produces the corresponding model elements in the test model. Extensions can 

contribute new test generators for processing a new type of recorded data or producing a new type 

of test element. For more information, see Defining a new test generator  on page 138.

• The data processing phase happens after a raw test has been completely generated. During this 

phase data correlation and data transformation are performed.

• The test splitting phase is an optional step that runs if split points were inserted during the 

recording. The complete test is split into several tests.

The test generation framework also defines two wizards:

• The Generate Test  wizard opens either when the user gestures to generate a test from an existing 

recording or automatically after a recording is complete. If user input is not required, the Generate 

Test  wizard is not displayed, and test generation automatically follows the recording. Extensions 

can contribute to this wizard. For more information, see Defining a test generator wizard  on page 

143.

• The New Test From Recording  wizard is the highest-level wizard and combines the New Recording 

Session  wizard and the Generate Test  wizard. For more details about the recording aspects of this 

wizard, see Defining wizards for recorders and clients  on page 131. For more details about the 

test generation aspects of this wizard, see Defining a test generator wizard  on page 143.
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Defining a new test generator
A test generator uses recorder packets and produces test-model elements that the test generator adds to 

the test model.

Before defining a test generator, you must identify the type of data that the generator can use and the type 

of model elements that the generator produces. The input data for a test generator can either be the raw 

data that the recorders produced, or data that has been altered during the conversion stage. The output 

elements of a test generator are typed by feature, which usually corresponds to a specific protocol.

To define a new test generator:

• Declare a new test generator type in the plugin.xml  file, using the 

com.ibm.rational.test.lt.testgen.core3.testGenerator  extension point.

• Assign the test generator a unique ID and a name.

• Declare which packet types the test generator can use.

• Declare the required properties of the packet stream that is sent to the test generator. The 

framework includes the necessary converters in the conversion stage so these properties are 

verified when the packets reach the test generator. For information on defining properties by using 

converters, see Defining a new packet converter  on page 140.

• Define an implementation class that implements the 

com.ibm.rational.test.lt.testgen.core.testgen.ITestGenerator interface.

The product includes a built-in converter that produces an ordered stream of packets that is based on 

start time stamps of the packets. Typically, recorders produce packets that are sorted by their end time 

stamps. Most test generators require that input packets be ordered by their start time stamps, so the 

packet stream must include the sorted  property in the required properties.

Consider these facts about ITestGenerator implementations:

• Typically, you extend the com.ibm.rational.test.lt.testgen.core.testgen.BaseTestGenerator class, 

which provides a basic implementation and only requires overriding the necessary methods.

• The initialize() method is where any options from the test generator configuration are read using 

the getContext().getConfiguration() method.

• The process() method is the most important. The framework calls this method for each input 

packet. This method creates model elements and adds the elements to the output test. Model 

elements must be added to the test using methods from the ITestStack object that is returned by 

the getContext().getStack() method.
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• The framework calls the complete() method after all packets have been sent to the test generator. 

The complete() method can be used for performing any post-processing operations.

• Use the getContext().logMessage() method to report any messages from the test generator to the 

user, including error messages. If the message pertains to an unrecoverable error, the framework 

stops the test generation process.

Note:  A test generator must not delay in adding elements to a test. Test generators must add 

elements to the test as soon as they are created. A test generator can still add data to an element after 

the element has been added to a test. If there are delays in adding elements to a test, generated elements 

might not be correctly ordered. For example, if another test generator also generates elements in a mixed 

protocol environment, or if the recording contains annotations, then the generated elements might not be 

in the correct order. If you still need to perform processing that would delay the insertion of an element 

into to the test (for example, accumulating data in order to build a higher-level object), write a converter 

that does the processing and insert this converter before the test generator starts.

Defining a new packet converter
A packet converter transforms a stream of recorder packets. Use packet converters for adapting the raw 

data that recorders capture into a suitable format for the test generators to use.

A converter typically follows one of these patterns:

• A filtering converter removes input packets that do not meet a specific criterion. This converter 

does not modify packets, nor does the converter introduce new packets in the output stream. The 

product comes with a generic converter, with the com.ibm.rational.test.lt.testgen.core3.filter ID. 

You can add parameters to this converter with conditions.

• An annotator converter does not remove or modify packets in the input stream, but rather 

introduces additional packets in the output stream. These packets are annotation  packets that 

convey additional information that are inferred from the other packets. For instance, a converter 

might look for session, connection, or page boundaries in a packet stream, and then add a 

boundary packet whenever a boundary is detected in the input stream. This assists the test 

generator in identifying boundaries without the need to look ahead in the packet stream.

• A reordering converter does not add, change, or remove packets from the input stream, 

but it outputs them in a different order. A typical example is the packet sorter that comes 

with the product, which outputs packets sorted by their start time stamp. The sorter ID is 

com.ibm.rational.test.lt.testgen.core3.packetSorter.
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• An aggregator converter has different input and output packet types. It aggregates multiple input 

packets into one output packet. The converter usually translates a lower-level protocol into a 

higher-level protocol. For example, the product comes with a converter that transforms raw data 

in a byte stream that is exchanged between a client and an HTTP server into aggregated HTTP 

packets (request/response pairs).

To define a new converter, you must complete these procedures:

• Declare a new packet converter type in the plugin.xml  file, using the 

com.ibm.rational.test.lt.testgen.core3. packetConverter  extension point.

• Assign the packet converter a unique ID and a name.

• Declare the required properties of the packet input stream that the converter receives. The 

framework includes the required converters in the conversion stage, so these properties are 

verified when the packets reach the converter. For instance, if the converter requires the input 

packets to be ordered according to their start time stamps, specify the sorted  parameter.

• Declare which properties this converter adds to the output stream or removes from the output 

stream, as compared to the properties of the input stream. For example, a converter might disrupt 

the ordered  property of the input stream; in this case, the sorted  parameter must be included in 

removedProperties class.

• If the converter has different input and output packet types and can be considered as a packet type 

converter, declare that it contributes to packet type conversions and specify the types of input and 

output packets that the converter produces.

• Define an implementation class that implements the 

com.ibm.rational.test.lt.testgen.core.conversion.IPacketConverter interface.

Consider these facts about IPacketConverter implementations:

• Typically, you extend the com.ibm.rational.test.lt.testgen.core.conversion.BasePacketConverter 

class, which provides a basic implementation and only requires overriding the specific methods.

• A packet converter is an IPacketReferenceOutputStream interface that writes to another 

IPacketReferenceOutputStream interface. In other words, a packet converter has a writePacket() 

method, which is invoked by the framework for each input packet it processes. The packet 

converter is responsible for invoking the getContext().getOutputStream().writePacket() method 

whenever it needs to send a packet to its output.

• A packet converter can have options. The options are available by using the 

getContext().getConfiguration() method, which is typically called in the initialize() method.
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• A packet converter can send additional packets to its output in the complete() method. This 

method is called when there are no more input packets to use.

• Use the getContext().logMessage() method to report messages from the test generator to the user, 

including error messages. If the message pertains to an unrecoverable error, the framework stops 

the test generation process.

For scalability reasons, converters manipulate IRecorderPacketReference objects instead of 

IRecorderPacket objects. Follow these procedures to get the best results when you write packet converter 

code:

• An IRecorderPacket interfacecan be obtained from a reference that uses the 

IRecorderPacketReference.getRecorderPacket() method.

• A converter that must echo the same packet to its output as the one received must write the same 

reference instance that the converter has received.

• When a converter instantiates a new recorder packet, the converter can wrap the packet into a new 

reference by using the getContext().createPacketReference() method so that the packet can be 

sent as output.

• Just as recorders can produce packet attachments, converters can do so as well. To create a new 

attachment, use the getContext().createPacketAttachment() method.

• If the converter must hold a packet a long time before the packet is sent as output, the converter 

can unload the packet and keep only a reference to the packet. To do so, call the unload() method 

on the packet reference.

• Converters are provided with a facility for efficiently accumulating a large number 

of packets and atomically discarding them, or flushing them, to the output. See the 

com.ibm.rational.test.lt.testgen.core.store.IPacketReferenceStore class for more information. A 

packet store can be created using the getContext().createPacketStore() method.

Generating tests without a UI
To test converters and test generators during the development process, you can run them before any UI 

component is ready for launching them.

You can start test generation that includes the converters and test generators that you have developed by 

writing a test generation configuration file. This file specifies which converters and test generators to use 

and options for each.

This file is an example of such a configuration file:
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<__PT_EXTERNAL__:testGeneration xmlns:__PT_EXTERNAL__="__PT_EXTERNAL__"

  recsession="/Project/MyRecording.recsession"

  autoDataCorrelation="true"

  autoDataCorrelationNames="true"

  output="/Project/MyTest.testsuite">

 <cnv:packetSorter xmlns:cnv="converter:com.ibm.rational.test.lt.testgen.core3"/>

 <cnv:myConverter xmlns:cnv="converter:org.xyz.myplugin"/>

 <gen:myTestGenerator xmlns:gen="generator:org.xyz.myplugin"/>

</__PT_EXTERNAL__:testGeneration>

In the preceding example, replace org.xyz.myplugin  with the name of the plug-in that defines the converter 

and the test generator. Replace myConverter  with the converter ID, and myTestGenerator  with the test 

generator ID. Save the file with the .testgenconfig extension.

In the configuration file, a testGeneration node can contain as many converter configurations and test 

generator configurations as required. All the referenced converters and test generators are included in the 

test generation process, with the options from the configuration file passed to them.

To launch test generation from a test generation configuration file, right-click the file, and then select 

Generate Test.

Defining a test-generation wizard
The Generate Test  wizard contains four sections to guide you in defining a test generator.

The Generate Test  wizard contains these sections:

1. Test generator selection.

2. Test files selection.

3. Data correlation options.

4. Test generator wizard.

The first page is displayed only if more than one test generator is applicable for the input recording 

session. The second page is displayed only if the user has not already chosen the test file before the 

recording.

You must declare a wizard for each test generator that you have defined. A test generator that has no 

declared wizard is not available in the user interface and can be launched only using a test generation 

configuration file, which is a file with the .testgenconfig extension, or programmatically.
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When completed, this wizard produces a test-generation configuration that contains a set of converter 

and test generator configurations. This configuration is applied by the test generation framework to 

instantiate the appropriate converters and test generators and to send the packet stream from the 

recording session to the converters and test generators.

Test-generator wizards can add pages to the Generate Test  wizard by specifying an implementation class 

in the test generator wizard declaration in the plugin.xml  file.

To define a test generator wizard:

• Declare a new test generator wizard in the plugin.xml  file by using the 

com.ibm.rational.test.lt.testgen.ui.testgenWizard  extension point.

• Specify the test generator ID that the wizard configures.

• Provide a label and icon that represents the type of test to be generated by the test generator.

• Optionally, provide an implementation class. If you do not provide a class, the 

wizard has no configuration page. If you provide a class, it must extend the 

com.ibm.rational.test.lt.testgen.ui.wizards.NewTestGeneratorWizard class.

Consider these facts about NewTestGeneratorWizard implementations:

• This class extends the JFace class wizard, so it must extend typical methods such as the 

addPages() method.

• The class is passed an empty test-generator configuration, typed with the test generator ID 

selected by the user in step 1.

• The class is responsible for setting the test generator configuration options, which are available 

by using the getTestGeneratorConfiguration() method. This method is typically used in the 

doPerformFinish() method.

• The wizard can get contextual information by using getContext() method.

Migrating test generator implementations from previous versions
The new test generation framework builds on the improvements that were made in the recording 

framework. These improvements include the ability to record several protocols at the same time, which in 

turn supports generating a single test with mixed protocols. The test generation framework also includes 

improvements in efficiency and scalability.

The test generation API has been completely redefined. You must refactor existing extension code to use 

the new framework. The following tables summarize the changes to classes and methods in the new test 

generation framework.
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Previous class Current®  class Comments

com.ibm.rational.test.lt.testgen

.core2. IC2ProtocolHandler

com.ibm.rational.test.lt.testgen

.core.testgen. BaseTestGenera

tor

The class no longer has to de

termine whether it supports a 

packet type. The framework 

sends to the test generator only 

packets that are declared to be 

supported by the test generator 

in the plugin.xml  file. Previ

ously, protocol handlers loaded 

messages, then processed 

them in the process() method. 

In the new framework, pack

ets are passed one-by-one to 

the process() method. The 

process() method generates 

model elements without delay. 

The complete() method is avail

able for any post processing.

Previous extension point Current®  extension point Comments

com.ibm.rational.test.lt.testgen

.core2.protocolHandler

com.ibm.rational.test.lt.testgen

.core3. testGenerator

Contributing annotations
An annotation is an action that a user performs during a recording session. Annotations are used to 

document or structure the test generated from the recording.

These annotation types come with the product:

• Insert comment

• Insert screen capture

• Start transaction

• Stop transaction

• Insert Synchronization Point
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• Insert Split Point

• Set page name

Extensions can define additional annotation types. To contribute an annotation type:

• Define the new annotation type and its properties.

• Contribute an annotation toolbar with an action that enables inserting the annotation.

• Process the annotation in a test generator.

Defining a new annotation type
Each annotation type has its own semantics and supports a set of properties.

To define a new annotation type, complete these procedures:

• Declare a new annotation type in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.core.recorderAnnotation  extension point and the 

annotationType  element.

• Assign the type a unique ID. Typically the ID is in this form: pluginName.type.

• Assign a user-readable name to the type. The name is visible in the recording session editor.

For best results, complete these optional steps:

• Define an interface that contains a string constant with the annotation type ID defined earlier.

• In this interface, include a string constant for each property name that the annotation 

type supports. Specify the meaning and the type of the property in the constant Javadoc 

information. Property types can be those that are supported by setters and getters of the 

com.ibm.rational.test.lt.recorder.core.property.AbstractConfiguration class.

Also, define a label provider for the annotation type. A label provider returns a dynamic label that is based 

on the annotation properties and an image. The label and the icon are visible in the recording session 

editor. To define a label provider, complete these procedures:
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• Declare a new annotation label provider in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.ui.annotationContribution  extension point and the 

annotationLabelProvider  element.

• Specify the annotation type that the label provider supports.

• Define an implementation class of the label provider. The implementation class must implement 

the JFace ILabelProvider interface. Any object passed to this interface is always an instance of the 

com.ibm.rational.test.lt.recorder.core.annotations.RecorderAnnotation class.

Contributing new actions to the annotation toolbar
Typically, you produce an annotation by adding an action to the annotation toolbar. This action is 

represented as a toolbar button.

To contribute a new action to the annotation toolbar, complete these procedures:

• Declare a new annotation action in the plugin.xml  file by using the 

com.ibm.rational.test.lt.recorder.ui.annotationContribution  extension point and the 

annotationAction  element.

• Assign a unique ID to the annotation action.

• Decide whether this action is visible by default or not. Actions that are visible by default are 

available in all recording sessions unless made unavailable by a client or recorder. Actions that are 

not visible by default are available only if a recorder or client requires the action.

• Define an implementation class for this action. The implementation class must extend the 

com.ibm.rational.test.lt.recorder.ui.actions.AbstractAnnotationAction abstract class.

Consider these facts about AbstractAnnotationAction implementations:

• This class extends the JFace Action class.

• In the constructor, set the name, tooltip text, and image descriptor of the action.

• Implement the run() method. This method can interact with the user. For example, this method can 

prompt the user for a text field. If there is any interaction with the user, the time in milliseconds 

spent interacting with the user must be measured.

• To create an annotation, create an instance of the 

com.ibm.rational.test.lt.recorder.core.annotations.RecorderAnnotation class, and then pass the 
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annotation type as an argument. Set the annotation properties using the setter methods provided 

in this class.

• After the annotation has been built, forward the annotation by sending an 

AnnotationMessage message to the annotation recorder. This is typically a call of this form: 

annotationRecorder.sendMessage(new AnnotationMessage(annotation, interactionTime));

Generating a test-model element from a new annotation type
After annotations have been inserted into a recording session, the annotations must be processed by a 

test generator to translate them into a test-model element. To process annotations with a test generator, 

define a dedicated test generator or modify an existing test generator that you have developed.

To enable a test generator to process a new annotation type:

• Add the com.ibm.rational.test.lt.recorder.core.recorderAnnotation  packet type to the list of 

supported packets of the test generator in the plugin.xml  file. Set the isRequired  attribute to 

false.

• In the process() method of the test generator, add code based on this template:

 if (packet instanceof IRecorderAnnotationPacket) {

  IRecorderAnnotationPacket p = (IRecorderAnnotationPacket) packet;

  RecorderAnnotation annotation = getContext().resolveAnnotation(p);

  if (annotation == null) return true;

  if (MY_ANNOTATION_TYPE.equals(annotation.getType())) {

   // Add code to process the annotation

   return true;

  }

 }

Advanced annotation concepts
In some rare cases, annotations can be produced by recorders or clients.

Sending annotations from a recorder or a client

Annotations can be created by recorders and clients. To create annotations, the recorder delegate or the 

client delegate uses the AnnotationMessage class. The call typically is in this form:
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getContext().dispatchMessage(new AnnotationMessage(annotation, interactionTime));

Modifying the available annotation actions for a specific recorder or client

If an annotation action is available by default, you can choose to hide it when a specific recorder or client 

is active during the recording session. If an annotation is hidden by default, you can make it available 

when a specific recorder or client is active during the session.

To modify the annotation actions for specific recorders or clients, use the 

com.ibm.rational.test.lt.recorder.ui.annotationContribution  extension point and the 

annotationActionFilter  element.

Managing a state for a annotation types

By default, annotations can be inserted at any time during recording. There might be cases where 

permitting users to insert an annotation is inappropriate. For example, in a test with “Start Transaction” 

and “End Transaction”  annotations, “End Transaction”  might be available only if a transaction has already 

been started.

To manage the state of annotation types, define an annotation state handler. An 

annotation state handler manages one or more annotation types and can individually 

enable or disable annotation insertions. For more information about annotation state 

handlers, refer to the com.ibm.rational.test.lt.recorder.core.recorderAnnotation 

extension point, the annotationStateHandler  element, and the 

com.ibm.rational.test.lt.recorder.core.extensibility.AnnotationStateHandler  class.

The state handler for a specific annotation type can be retrieved from an annotation action class by using 

this code:

stateHandler = (IMyAnnotationStateHandler) getAnnotationStateHandler(myAnnotationType);

Extending the load test behavior model
The load test behavior model (LTBM) is a model of the behavior of a performance test in Rational® 

Performance Tester.

The load test behavior model (LTBM) was developed using Rational®  Software Architect and Eclipse 

Modeling Framework (EMF) to model the behavior of a performance test. The LTBM also consists of code 

generated from this model using EMF. The LTBM is extended from the common behavior model (CBM). 

The schedule behavior model (SBM) that is the underlying model to the Schedule Editor in Rational® 

Performance Tester  is the other model that extends the CBM. The CBM is itself built on top of the Test 
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and Performance Tools Platform (TPTP) common behavior model (TCBM). The LTBM plug-in ID is 

com.ibm.rational.test.lt.models.behavior.

For a sample of an extension to the LTBM, see the plug-in 

com.ibm.rational.test.lt.sdksamples.models.behavior.socket.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Updates to the load test behavior model
There are new features in the model and there are changes to the following two plug-ins, which the 

protocol behavior model plug-in depends on.

There are changes to the two plug-ins that the protocol behavior model plug-in depends on:

• com.ibm.rational.test.common.models.behavior

• com.ibm.rational.test.lt.models.behavior

com.ibm.rational.test.common.models.behavior.CBAssetMigration
To open a performance test in version 7.0 that was created in version 6.1.2, the test suite loader 

must identify model elements that have been modified in 7.0 and adapt to the changes. The suite 

loader accomplishes identification and adaptation by recognizing elements that implement the 

CBAssetMigration interface. If a model element has been modified in a given release, starting with 

that release, that particular model element must implement this interface. The two methods from this 

interface that need to be implemented are as follows:

• Public Boolean needMigration(CBVersion version): determines whether migration is needed

• Public void migrate(CBVersion version): performs any required migration

The version that is passed into this method is the version of the test. LTTestUtil.getCurrentVersion() 

always returns the current version of the test suite that can be created with the installed version of the 

product. The methods in the BehaviorUtil  class enable you to compare any two version objects.

com.ibm.rational.test.common.models.behavior.CBElementHost

A model element can implement this interface provided that it is a container and that it has children in the 

model. Some examples of core model elements that implement this interface are CBLoop, LTTransaction, 

and LTTest.
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com.ibm.rational.test.lt.models.behavior.common.LTAnnotation 
com.ibm.rational.test.lt.models.behavior.common.impl.LTAnnotationImpl

If a protocol model element is required to hold data that is not text, or that is large, the data being held 

could affect performance if it persists within the test suite model. To prevent performance issues, these 

types of data are stored in a file called annotation, which is in the test suite, but outside of the model. To 

use this feature, the attribute that holds the data must be created with type LTAnnotation. Use the APIs 

provided in this interface to access the data.

com.ibm.rational.test.lt.models.behavior.common.LTArmEnabled

A model element can implement this interface if this interface is required to log Application Resource 

Monitoring (ARM) data. ARM must be supported by the protocol being tested for this feature to work end-

to-end.

Extensibility using RSA/EMF modeling

The model can now be extended by using IBM®  Rational®  Software Architect Eclipse Modeling 

Framework (EMF). A base starter model is provided along with the Load Test Behavior Model (LTBM) 

plug-in. You can start with this model and add the protocol extension model elements to the base model. 

When generating EMF code, choose the model element that is unique to the protocol model.

Related reference

Extension points for LTBM  on page151

Public APIs for LTBM  on page159

Related information

Creating protocol constructs  on page156

Extending the classes in LTBM  on page158

Extension points for LTBM
You must register your protocol model elements with the load test behavior model (LTBM) core through 

extension points regardless of the way that you chose to model your protocol.

Related reference

Public APIs for LTBM  on page159
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Related information

Updates to the load test behavior model  on page150

Creating protocol constructs  on page156

Extending the classes in LTBM  on page158

Registering a model element
The extension point for registering a model element enables the protocol extension to specify a factory 

class, a class providing test options, and the type of the model element handled by the protocol extension.

The extension point for registering a model element allows the protocol extension to specify:

• A factory class that contains instructions to create a model element of a given type. The factory 

class must implement the ElementFactory  interface from the load test behavior model (LTBM).

• A class that provides test level options to the test for the protocol. This class should extend the 

OptionImpl  class from the LTBM.

• A type of model element that is handled by this protocol extension. The element of this type should 

extend the CBBlockImpl  class in the LTBM. The type defaults to the fully qualified name of the 

model element class. If there are duplicate element types, the element loaded later is ignored and a 

message is logged in the error log.

Sample

<extension

point="com.ibm.rational.test.lt.models.behavior.protocol">

      

<protocol 

      id="com.ibm.rational.test.lt.example.protocol"

factory="com.ibm.rational.test.lt.example.protocol.ProtocolElementFactory"

option=" com.ibm.rational.test.lt.example.protocol.ProtocolOptions">

 

<element type="com.ibm.rational.test.lt.example.protocol.XModelElement"/>

<element type="com.ibm.rational.test.lt.example.protocol.YModelElement"/>

 

</protocol>

</extension>
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Related reference

Required attributes in a model class  on page153

Registration examples  on page154

Required attributes in a model class
A model element can contain attributes of different types, both primitive and complex.

A model element typically consists of one or more of the following types:

At

tribute 

type Description

Prim

itive, 

except 

byte 

or 

byte 

arrays

• Call the appropriate setProperty()  method to set the property of the element. Various 

overrides exist for all primitive types except byte.

Byte 

ar

ray or 

large 

strings

• To store binary data, the attribute must be of LTAnnotation  type or one that extends 

it. This class has setBytes()  and getBytes()  methods to store and retrieve binary in

formation. After the getBytes()  or setBytes()  is called, the data is maintained in mem

ory until the test is saved.

Note:  If this action is not wanted–and it is not in cases where the data set can 

be large, you can flush the data to a file by individually calling the flush()  method on 

the LTAnnotation. Make sure that you call this method immediately after a set or get 

is called.

Com

plex

• Call setProperty(CBActionElement,CBActionElement)  to which you can pass the old 

and the new value of the attribute. All model elements extend from the CBAction

Element  class. The old value is passed so that it can be removed from the model 

and the new value is passed, so it can be set. If you do not have a value, then pass 

null. For example, if the value is changing from val1  to val2, then call the setProper
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At

tribute 

type Description

ty(val1,val2)  method. If you are setting the value for the first time, call the setProper

ty(null,val1)  method. If you want to clear the value, call setProperty(val1,null).

• This is similar to the other setProperty()  methods for the primitive type, with the 

added restriction that this needs the old value too.

• When the model gets loaded, the addReference()  method will be called and this 

method needs to be overwritten to interpret and properly assign the attribute to the 

object. Call the appropriate setXXX()  method to set that attribute with the value 

passed in.

List • The attribute should be of type EList. To access the list, if the element is a container, 

then it can implement the LTElementHost  interface and will need to implement the 

getElements()  method. This method must return the  EList. To load the list when the 

children of this model element are being loaded, the addReference()  method is called 

for each child and the element must put the child in the right list.

Refer

ence 

to an

other 

mod

el ele

ment

• Define an attribute of the type of the element you reference. This will provide the sim

ple getters and setters to this attribute. These getters or setters will not call getProp

erty  or setProperty, but they will simply get or set the attribute value.

• Define another attribute that will act as a proxy for this element. This element is your 

own class that extends ProxyElement  from the LTBM.

• When creating the reference, call the setHref()  method of the ProxyElement  with the 

ID (getId()) of the element that is being referenced.

• To get the element that is being referenced, use the href from the ProxyElement 

(getHref()) to locate the element in the test. You can also use the BehaviorUtil.find

Element()  method (the test containing this element, the ID of the element being 

searched) to get the element.

Related reference

Registering a model element  on page152

Registration examples  on page154
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Registration examples
The examples in this topic show you how to register strings for content verification and built-in data 

sources.

Registering strings for content verification

The following example shows how to register strings for content verification:

<extension

point="com.ibm.rational.test.lt.models.behavior.contentVPData">

 

<category

label="Example protocol strings"

id=" examples.protocol.strings ">

 

<property

type="boolean"

name="Does value exist"

value="true"

id="com.ibm.rational.test.lt.exmaple.protocol.valueExist"/>

         

<content

label="Joe"

id="example.protocol.strings.1"/>

         

<content

label="Jane"

id="example.protocol.strings.2"/>

 

 

</category>

 

</extension>

Registering built-in data sources

A protocol extension can provide its own list of built-in data sources. A data source is used to mine data 

and hold it for later consumption. This is done using the following extension point.

The following example shows how to register built-in data sources:
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<extension

point="com.ibm.rational.test.lt.models.behavior.builtInDataSource">

<dataSource typeId="protocol.buitindatasource"

className="com.ibm.rational.test.lt.example.protocol.BIDataSource">

         

<property name="database"/>

<property name="table"/>

<property name="column"/>

 

</dataSource>

 

</extension>

 

In the above example, a protocol extension can extract a value from a particular column in a table in a 

database.

Related reference

Registering a model element  on page152

Required attributes in a model class  on page153

Creating protocol constructs
The first step in creating protocol constructs is to identify the behavior of the protocol, how the ends, 

client and server, communicate through this protocol, or if there is an order in which things happen.

For example, in HTTP, the browser sends a request to the web server by using a connection to send the 

request and receives a response from the web server. This process suggests that at least the following 

model elements need to be present:

• An HTTP Request model element

• A Server Connection model element

• An HTTP Response model element

After you have the basic behavior defined, you can add additional features to the model elements.



Chapter 1. Test Execution Specialist Guide

Related reference

Extension points for LTBM  on page151

Public APIs for LTBM  on page159

Related information

Updates to the load test behavior model  on page150

Extending the classes in LTBM  on page158

Modeling the behavior of a protocol extension
To create a model element for your protocol, you must extend the 

com.ibm.rational.test.lt.models.behavior.impl.CBBlockImpl  class. Extending this class enables you to 

use all the basic functionality that is provided by this model element, including persistence into the test 

files and APIs to set or get properties of a model element.

There are other model elements in the load test behavior model (LTBM) that are extended from the 

CBBlockImpl  class and that provide various functionality. You could also extend those elements for your 

protocol. The LTBM provides common constructs (com.ibm.rational.test.lt.models.behavior.common) 

that can be reused by protocol extensions. These constructs are included in various packages in the 

LTBM. See the Javadoc information and the API topic for more details.

To create a protocol model element that is not related to any of the common constructs provided by the 

LTBM, extend the CBBlockImpl  class. If the model element for your protocol is a specific type of an LTBM 

model element, extend the implementation class for that element. For example, if a protocol extension 

provides a special type of a CBLoop  construct, it would extend the CBLoopImpl  class and add additional 

attributes to that element.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

1. Optionally, create an interface that defines the methods for the class, including the setters and 

getters for the attributes added by this element.

2. Create a new class that extends the CBBlockImpl  interface, and if you created an interface in step 

one, implement the interface.

3. In the constructor of the model element, call the method setType(type), where 

type  is a unique type string denoting the model element as registered using the 

com.ibm.rational.test.lt.models.behavior.protocol  extension point.

4. Implement the getters and setters of attributes for this model element class.
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Note:  The setter must set the value attributes of the primitive data types into the underlying 

model using one of the overloaded setProperty()  methods based on the type of attribute.

5. To set attributes of complex types, override the addReference()  method.

While the test is loading, the getter (at least initially) gets the value of the attribute from the underlying 

model by using one of the overloaded getProperty()  methods, based on the type of the property for 

primitive attributes.

You can define the model element to store the value of the attributes in local attributes. However, the 

guideline is that the getter should get it first from the underlying model and the setter should store it in the 

underlying model.

Extending the classes in LTBM
You can create a new Load Test Behavior Model (LTBM) element.

Follow these steps to create a new model element:

1. Optionally create an interface that defines the methods for the class, including the setters and 

getters.

2. Create a new class that extends CBBlockImpl  interface and that optionally implements the 

interface defined in the above step.

3. Implement the getters and setters of attributes for this model element class.

a. The setter must set the value attributes of the primitive data types into the underlying model 

using one of the overloaded setProperty()  methods.

4. Override the addReference()  method to set attributes of complex types.

5. The getter, at least initially, gets the value of the attribute from the underlying model using one of 

the overloaded getProperty()  methods based on the type of the property for primitive attributes.

6. The model element can additionally decide to store the value of the attributes in local attributes. 

However, the underlying principle to be followed is that the get should get it first from the 

underlying model and the set should store it into the underlying model.

Related reference

Extension points for LTBM  on page151

Public APIs for LTBM  on page159
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Related information

Updates to the load test behavior model  on page150

Creating protocol constructs  on page156

Public APIs for LTBM
The load test behavior model (LTBM) contains multiple packages. Each package contains the interfaces 

that define the LTBM. In addition, each package has a corresponding implementation package that 

contains the implementation classes for these interfaces.

The extensions will either use or extend the implemented classes from LTBM while having access only to 

the methods defined in the corresponding interfaces. The following packages are part of LTBM:

• com.ibm.rational.test.lt.models.behavior.lttest

• com.ibm.rational.test.lt.models.behavior.common

• com.ibm.rational.test.lt.models.behavior.data

• com.ibm.rational.test.lt.models.behavior.vps.impl

The implementation classes are contained in the corresponding implementation 

packages, such as com.ibm.rational.test.lt.models.behavior.lttest.impl, 

com.ibm.rational.test.lt.models.behavior.common.impl, 

com.ibm.rational.test.lt.models.behavior.data.impl  and 

com.ibm.rational.test.lt.models.behavior.vps.impl.

Each of these packages also contains factory classes that enable you to create a model element from 

that package. For best results, use the factory classes to create model elements. For example, to create a 

loop, use this method:LTTestFactory.eINSTANCE.createCBLoop()

The LTBM provides common constructs that can be reused by protocol extensions. These constructs are 

included in various packages in the LTBM. The Javadoc information explains each available interface in 

more detail.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Related reference

Extension points for LTBM  on page151
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Related information

Updates to the load test behavior model  on page150

Creating protocol constructs  on page156

Extending the classes in LTBM  on page158

com.ibm.rational.test.lt.models.behavior.lttest package
This package holds the interfaces related to the performance test object and its attributes.

The LTTest  interface is the root container for all model elements. The LTTest  interface also consists 

of model elements that are used to refer to outside assets, such as datasets, features, and external 

resources. An extension is not expected to implement or extend an LTTest  interface.

An LTTest  interface consists of the following items:

• An instance of LTResources  that contains features and other globally scoped items.

• A list of common and protocol based options.

• A list of datasets being used in this test, if any.

• A list of properties specific to this test.

• A list of model elements that might contain other model elements.

The following diagram shows the com.ibm.rational.test.lt.models.behavior.lttest  package structure:
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Related reference

com.ibm.rational.test.lt.models.behavior.common package  on page161

com.ibm.rational.test.lt.models.behavior.data package  on page163

com.ibm.rational.test.lt.models.behavior.vps package  on page166

com.ibm.rational.test.lt.models.behavior.common package
This package contains common interfaces that the extending model elements can implement to add 

these features to them.

The com.ibm.rational.test.lt.models.behavior.common  package also contains common constructs 

such as the IF  construct. The package also contains other commonly used constructs such as 

LTNameValuePair, in which you can store a list of name or value pairs.

The following diagram shows the relationship between the model elements in the 

com.ibm.rational.test.lt.models.behavior.common  package:
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The following diagram shows the inheritance of model elements in this package:
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Related reference

com.ibm.rational.test.lt.models.behavior.lttest package  on page160

com.ibm.rational.test.lt.models.behavior.data package  on page163

com.ibm.rational.test.lt.models.behavior.vps package  on page166

com.ibm.rational.test.lt.models.behavior.data package
This package contains classes related to data correlation and custom code.

Data correlation consists of two parts. One part is the source for the data and the other is the consumer 

of the data. The base class for all data sources is called DataSource  and the one for consumer is 

Substituter.

A model element in the protocol extension that can contain data sources must be marked as 

a data source host by implementing the DataSourceHost  interface. A model element that can 

contain consumers of data sources must be marked as a consumer host by implementing the 

DataSourceConsumer  interface.

The following diagram shows the relationship between the data source and the consumer:
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Data sources
The data sources are model elements that designate data extraction and storage for consumption by 

other model elements. The following types of data sources are provided by the load test behavior model 

(LTBM):

• DatapoolHarvester  - to denote columns of data extracted from a dataset.

• CorrelationHarvester  - to denote a string of data to be used later on in a test.

• BuiltInDataSources  - built-in functions that provide derived information (eg. Current®  time).

• Arbitrary  - enables users to write custom code to be inserted into a test.

For details about these classes, see the Javadoc information.

A protocol extension can provide its own set of built-in data sources using the extension point described 

in the "Extension points" topic.

The following diagram shows the relationship between these classes:
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Substituters

The basic consumer type provided is a Substituter. The following diagram shows the Substituter 

structure:
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The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Related reference

com.ibm.rational.test.lt.models.behavior.lttest package  on page160

com.ibm.rational.test.lt.models.behavior.common package  on page161

com.ibm.rational.test.lt.models.behavior.vps package  on page166

com.ibm.rational.test.lt.models.behavior.vps package
This package provides classes related to verification points.
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The com.ibm.rational.test.lt.models.behavior.vps  package contains the VerificationPoint  interface and 

its corresponding implementation. This package provides the generic verification point VPContent. It is 

used to detect the presence (or indicate the absence) of one or more defined test strings that correlate 

with strings, or parts of strings, that the application generates while under test. You can define the strings 

that the verification point should look for.

Related reference

com.ibm.rational.test.lt.models.behavior.lttest package  on page160

com.ibm.rational.test.lt.models.behavior.common package  on page161

com.ibm.rational.test.lt.models.behavior.data package  on page163

Extending data correlation
Data  correlation is the process of extracting data that is returned from a server, and then sending it back 

to the server in a subsequent request.

There are two main parts to data correlation. One part occurs during test generation and script editing, 

and the other part occurs during script execution.

The test generation part of data correlation is the most significant part. There is automatic data 

correlation that is performed during test generation, and there is manual correlation that can be 

performed during script editing. There are several different things that can be done as part of manual 

correlation: you can substitute values into a site from a data pool, a built-in data source, or a reference 

that is already created.

For more details about test generation extensibility, see the "Extending the test generator" topic. For 

details about the Script class, see the "Extending code generation" topic.

For examples of data correlation extensions, see these plug-ins: 

com.ibm.rational.test.lt.sdksamples.datacorrelation.testgen.socket 

com.ibm.rational.test.lt.sdksamples.datacorrelation.execution.socket

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.
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Implementing data correlation for test generation
To implement data correlation for test generation, become familiar with these 

classes: com.ibm.rational.test.lt.datacorrelation.testgen.proto.IProtoElementAdapter, 

com.ibm.rational.test.lt.datacorrelation.testgen.DataCorrelator, and 

com.ibm.rational.test.lt.datacorrelation.testgen.IDCStringLocator.

To implement data correlation for test generation and script editing, your model 

elements must extend com.ibm.rational.test.lt.models.behavior.data.DataSource  and 

com.ibm.rational.test.lt.models.behavior.data.Substituter  so that you can associate data sources 

and substituters with your model elements. Also, when you extend those classes, make sure you 

implement the code to make Substituters and DataSources persist in your model. For more information, 

refer to the model documentation.

You need to create your own data correlation plug-in to extend the extension point DCTestgenProto, 

which is defined in the plug-in com.ibm.rational.test.lt.datacorrelation.testgen. To extend the 

extension point, your code must implement the interface IProtoElementAdapter  which is defined in 

com.ibm.rational.test.lt.datacorrelation.testgen.proto. Then, when you extend the DCTestgenProto 

extension point, use the following items:

• ID - This is the unique ID of your extension.

• Name - The name that is meaningful for you.

• Point - com.ibm.rational.test.lt.datacorrelation.testgen.DCTestgenProto  extension point

.

The other element details are:

• class - This is the full name of the class (including plug-in name) that implements 

IProtoElementAdapter.

• protoType - The type of model element that this plug-in handles, for example, in HTTP, the model 

element that is handled is com.ibm.rational.test.lt.models.behavior.http.HTTPRequest.

• generic - This is a boolean that can be true or false. If it is true, this means that if there are other 

plug-ins that handle the same protoType, this plug-in will be called last.

• uniqueID - This ID is unique among all data correlators.

After you have extended the data correlation extension point, the main data correlation engine will call 

your code with all the elements of the model type that you defined.

There are two parts to data correlation at testgen time. The first part is automatic data correlation which 

happens at testgen time. This will happen through a call to DataCorrelator.CorrelateAll(). When this 

method is called automatically by testgen, it will in turn call two main methods in your plugin. Those 
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methods are IProtoAdapter.findSubs()  and IProtoAdapter.findReference(). The findSubs()  method 

should return a list of substituters that are found for the current element that is passed into your method, 

and null if there were no substituters found. The findReference()  method should try to find a reference for 

the substituter passed into it. You start looking for references at the element before the substituter and 

keep working backwards in the testsuite until you find a suitable reference. If no reference is found, return 

null. CorrelateAll  is used to find all correlations that you can so that the user does not have to manually 

find them at test editing time.

The other parts of the IProtoAdapter  class are called at test editing time when a user wants to create a 

substitution site, a reference, or make a correlation between a substitution site and a reference. If you are 

creating your own type of Substituters or DataSources, your makeDataSource() and makeSub() methods 

will be used for that. You will be passed the DCStringLocator  class with all the information about offsets 

and text that you need. Use this DCStringLocator  to determine what substituter or data source you want to 

create and then call back into IDataCorrelator. Correlations, substituters, and data sources are created in 

the model for you. Read the documentation on the IDataCorrelator  class to learn which methods are right 

for your purposes.

Related information

Implementing data correlation for execution  on page169

Implementing data correlation for execution
To implement data correlation during execution, set up your class that extends the 

com.ibm.rational.test.lt.kernel.action.KAction  class to trigger a call into the data correlation engine.

Before you implement data correlation, become familiar with the following classes:

• com.ibm.rational.test.lt.datacorrelation.execution.harvest.IDataHarvester

• com.ibm.rational.test.lt.datacorrelation.execution.sub.IDataSub

• IDataCorrelationVar

• com.ibm.rational.test.lt.datacorrelation.execution.proto.IProtoActionAdapter

See the Javadoc information for class and method descriptions.

The IKAction  interface defines the basic functionality that all kernel actions must implement. The 

IKAction  interface is the base interface for all kernel actions. The actions can represent loops, conditions, 

or other code constructs.
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To implement data correlation during execution , codegen  writes your harvesters and substituters into 

containers. To implement data correlation at execution time, codegen will need to write your harvesters 

and substituters into containers. This is done by calling LTTestTranslator.translateHarvesterContainer() 

and LTTestTranslator.translateSubstituterContainer()  at codegen time when you are translating 

your action. Both of these methods live in the com.ibm.rational.test.lt.codegen.core  plugin. These 

containers will need to be added to your action and stored with your action. These containers must 

be added to and stored with your action. When your actions are being executed, they must call these 

substituter and datasource containers. The substituter container is called at the beginning of your action, 

before you send data, and the data source container is called at the end of your action, after you have 

received the data.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

To implement the execution portion of data correlation:

1. You must extend an extension point in codegen.core  to get your execution IProtoActionAdapter 

regisetered for playback:

a. Extend the extension point DataCorrelationProtoAdapter  in the 

com.ibm.rational.test.lt.codegen.core  package. To do the extension, use your plug-in 

that is the extension to the com.ibm.rational.test.lt.datacorrelation.execution  plug-in that 

implements the IProtoActionAdapter  interface.

b. Tell the com.ibm.rational.test.lt.datacorrelation.execution  plug-in what types of IKActions to 

handle and the name of your plug-in.

c. When this is complete, you should see something similar to the following added near the top 

of your generated .java code:

pa.addPA("com.ibm.rational.test.lt.sdksamples.datacorrelation.execution.socket.SocketActionAdapter", 

"com.ibm.rational.test.lt.sdksamples.protocol.socket.io.SocketSend");  The first string 

should be the name of your class that implements the IProtoActionAdapter, and the second 

string should be the name of the KAction  that your IProtoActionAdapter  class should be 

called for. Be very careful on the spelling, it has to be exactly right.

2. To implement the datacorrelation.execution  plug-in extension, your plug-in must implement 

the com.ibm.rational.test.lt.datacorrelation.execution.IProtoActionAdapter  interface. The main 

com.ibm.rational.test.lt.datacorrelation.execution  plug-in uses the interface to call your plug-in and 

to get the information for the implementation.
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Note:  This is also the plug-in that extends the DataCorrelationProtoAdapter  class in the 

codegen  extension point.

3. To start the substitution process, in the IDataSub.substituteData()  method, use the action and hash 

map as parameters.

a. The action that is currently active will call the 

com.ibm.rational.test.lt.datacorrelation.execution.sub.IDataSub.substituteData()  method. 

The substitution container executes all substitution rules and put the new string values 

(read from data correlation variables) into the hashMap. The first value of the hashMap is 

the propertyType, and the second value is the entire new string for that propertyType. So, 

when the substitution is done, it fixes the entire string for you.

b. The substitute container returns the control to the IKAction  interface.

c. The IKAction  interface reads the string values from the hash map and sends them to the 

appropriate places.

4. To start data harvesting, the action that is currently active calls the IDataHarvester.harvestData() 

method. The action passes itself to the container.

a. The data harvester calls the plug-in that has extended the data correlation execution plug-in 

to get the string values that the harvest rules must be applied to.

b. The data harvester container places the harvested values into data correlation variables. 

These data correlation variables are then used in later substitute executions.

Related information

Implementing data correlation for test generation  on page167

Extending the test editor
The performance testing software provides application programming interface (API) classes for 

extending the test and performance tools platform (TPTP) to write new editors and protocol extensions.

The editors in performance testing are extensions of the defined editor framework in TPTP. The editors 

are loaded by TPTP based on the file type, for example schedule, test, or data pool.

The performance testing editor is built of several layers: the common framework, the editor, and the 

protocol layers.
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• The common framework layer consists mainly of abstract classes and interfaces, and some utility 

libraries. The common framework is initialized by TPTP editor architecture.

• The editor layer extends classes from the common framework layer to provide specific 

implementations for their models.

• The protocol layers can be basic and dependent. The basic layers do not depend on other 

protocols such as HTTP. The dependent layers are built on top of other protocols, for example 

Siebel on top of HTTP. The protocol layers are implemented on top of the single editor layer.

When the editor needs to be opened in a model file, TPTP determines which editor is 

capable of handling this particular model and loads, and initializes the specific extension. 

The common framework layer provides its implementation of the handler class, the 

com.ibm.rational.common.test.editor.framework.extensions.CommonEditorExtension  class. The editor 

layer creates an instance of the com.ibm.rational.common.test.editor.framework.TestEditor  class that 

must be extended by the editor layer. After the TestEditor  object is created, the user interface (UI) widgets 

and components are created to display the model data.

The TestEditor  class provides the bridge between TPTP (through the CommonEditorExtension), the model 

(through the CBTest  member variable), Eclipse, and the concrete protocol code. When the editor is closed 

by the user or reloaded, the first instance of the TestEditor  class is destroyed and a new one is created.

The editors support only data that comes out of the corresponding models. The editor layer of 

the performance testing editor is called the Load Test class. The Load Test class extends the 

TestEditor  class by creating concrete LoadTestEditor  and CommonEditorExtension  classes through the 

LoadTestEditorExtension  extension point.

For the recorder extension sample, see the plug-in com.ibm.rational.test.lt.sdksamples.editor.socket.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Migrating test editor extensibility
Changes in the performance testing editor base framework package are provided in this release to 

support more standardized ways of handling model element attributes.

Details area contents and layout (attribute field support)

You can now manage the layout and contents of the Details area in the test editor (schedule and test 

editors) that developers had to manage in earlier versions. In this version, you can manipulate the 

contents by using the abstraction called AttributeField. This construct hides much of the required 
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behavior from developers, and enables a great deal of extensibility. Updates to AttributeField  can coexist 

with the user interfaces of existing editors or protocol extensions, provided that some minor adjustments 

are made. Classes derived from AttributeField  must be used whenever an attribute from a model 

element is displayed. Do not use the AttributeField  for any other information presented to the user in the 

Details area. Instead, use regular Eclipse widgets.

Behavior

The getXXXvalue(), setXXXValue(), and getFieldName() classes and APIs provide a way to link model data 

with their user-interface representation, and at the same time hide related low-level maintenance work 

from the developer.

These classes are abstract. When a developer chooses one of them to display their model data, only a 

small number of methods need to be implemented to define the default behavior of the attribute field. If 

more customized behavior is needed, other methods are available for overriding. Refer to the Javadoc 

HTML documentation for more information.

The smallest set of methods that a developer must implement are as follows:

• getXXXValue(): Retrieves and returns a value from model element. XXX  signifies a type of an 

attribute. For example, when extending IntegerAttributeField, the name of the method is 

getIntegerValue().

• setXXXValue(): Sends a value obtained from the UI to the model element. The meaning of XXX  is the 

same as above.

• getFieldName(): Returns the name of the field. Names make a field addressable for navigation.

Note:  Before version 7.0, field names were optional; in this version they are mandatory.

Classes
The following table is a hierarchy of the AttributeField  related classes that are available to editor and 

protocol developers. The list includes descriptions about which classes to use in specific situations.

Note:  These classes have limited functionality because they must support classes and APIs from 

versions earlier than 7.0.

AttributeField class Description

OptionsComboField This class is used to display a set of options to 

a user. Options are presented in a combination 

box. When extending this class, you must pro

vide an index of the option currently selected in 

the model element. When a user chooses a dif
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AttributeField class Description

ferent value from the combination box, the new 

index is passed to the derived class, in order to 

update the model. The class developer needs to 

understand the meaning of the index in the con

text of the model.

OptionsRadioField The same provision that applies to OptionsCom

boField  applies to OptionsRadioField. The fol

lowing exception, however, applies: options are 

displayed as a set of radio buttons in a group. A 

user must select one of the radio buttons to indi

cate the index of the selected option.

BooleanAttributeField This class is used when the model element at

tribute is a Boolean value. The value is displayed 

as a check box. The developer must provide a 

Boolean value from a model element and accept 

a new Boolean value from the user interface to 

update the model element.

IntegerAttributeField This class is used when the model element at

tribute holds an integer value. The field can rep

resent an integer value in several ways. The fol

lowing control types are available for representa

tion:

• StyledText

• Spinner

• Slider

• Scale

Note:  This class is subject to change in the 

future.

TextAttributeField Use this field when there is text data in the model 

element.

FilteredTextAttibuteField This class extends the behavior of TextAttrib

uteField  by enabling condition checking and dis
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AttributeField class Description

playing alternative text (message) to the user. 

For example, the developer might want to filter 

binary data, or filter text that is too long for con

venient display.

DataCorrelatingTextAttrField Use this class when the text data can be either 

substituted, data correlated, used as a reference, 

or configured in any combination of these.

Porting code from layoutProvider

The following is a short guide to porting existing code, typically found in the layoutProvider  class, to the 

new function.

Previous implementation:

class MyLayoutProvider extends ExtlayoutProvider

{

 layoutControls( CBActionElement element )

 {

   super.layoutControls( element ); // call super first.

   createWidgets(); // create all the UI for display

   refreshWidgets(); // call refreshLayout to populate UI

   return true; // return true is success.

 }

 

 createWidgets()

 {

   new StyledText();

   new Button();

 }

 

 refreshControls( CBActionElement element )

 {

   super.refreshControls( element ); // call super first

   // grab data from model element and apply it to UI widgets

   applyModelDataToWidgets();

   return true; // return true if success.

 }
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 /* because the ExtLayoutProvider is SelectionListener, 

 this method is called when Buttons, ComboBoxes and 

 such are modified. */

 widgetSelected( SelectionEvent event )

 {

   // find the widget, get its value and apply it to model 

   applyUiDataToModelElement();

   // call super to update the editor.

   super.widgetSelected();

 }

 

 /* because the ExtLayoutProvider is ModifyListener, 

 this method is called when StyledText is modified. */

 modifyText( ModifyEvent event )

 {

   // find relevant StyledText control and apply 

   // its value to the model element.

   applyTextUiDataToModelElement();

   super.modifyText();

   }

 

}

Current®  implementation:

class MyLayoutProvider extends ExtlayoutProvider

{

   // class declared as internal.

   class MyTextField extends TextFieldAttribute

   {

     String getTextValue(){

       return ((MyModelElement)getSelection()).getTextAttr();

     }

     setTextValue( String newVal ){

       ((MyModelElement)getSelection()).setTextAttr( newVal );

     }

     String getFieldName(){

       return MY_FIELD_NAME; // defined elsewhere
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     }

   };

 

   MyTextField m_fldText;

   MyDataCorrelationField m_DcField; // declared outside.

 

   layoutControls( CBActionElement element )

   {

     createWidgetsAndFields(); // create all the UI for display

     updateNonFieldWidgets(); // update non-model widgets 

     // always call super at the end.

     return super.layoutControls( element ); 

   }

 

   createWidgetsAndFields()

   {

     // create UI widgets for displaying non-model info

     …

     // create Fields

     m_fldText = new MyTextField( this );

     m_fldText.createLabel( … );

     m_fldText.createControl( …. );

 

     // create more UI widgets for displaying non-model info

 

     m_DcField = new MyDataCorrelationField( this );

     m_DcField.createLabel( … );

     m_DcField.createControl( …. );

 

   }

 

   refreshControls( CBActionElement element )

   {

     // update NON-UI widgets only.

     applyModelDataToWidgets();

     //always call super at the end.

     return super.refreshControls( element ); 
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}

 

   /*You do not have to have this method unless you want 

   to update NON-model widgets/data. */

   widgetSelected( SelectionEvent event )

   {

     // find the widget and do whatever you need, but 

     // do not update the model. 

     applyUiDataTo_NON_ModelElement();

     // DO NOT call super to update the editor.

   }

 

   /* You do not need to have this method unless you 

   want to update non-model widgets/data. */

   modifyText( ModifyEvent event )

   {

     // find the widget and do whatever you need, but do not 

     // update the model. 

     applyTextUiDataToModelElement();

     // DO NOT call super to update the editor.

 

   }

 

}

Related reference

Common editor framework  on page180

Editor layer extension points  on page187

API classes  on page189

Related information

Test editor structure  on page178

Contributing actions to the menu  on page184
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Test editor structure
The editor in Rational®  Performance Tester  is built of several layers; the common framework, the editor 

and the protocol layer.

The common layer defines the interfaces and extension-points, provides the API classes and interfaces. 

It also provides the hooks into the Eclipse user interface (UI) menus, actions, markers. The common 

framework layer is initialized by the TPTP editor architecture. Because test editors are in fact extensions 

loaded and initialized by the TPTP platform via org.eclipse.hyades.ui.editorExtensions extension point, 

one of the common editor framework’s responsibilities is to provide hooks and application programming 

interfaces (APIs) for concrete editors implementations to communicate with TPTP. The common editor 

framework defines the classes that must be extended for a more specific behavior to be used by the 

extended editor implementations. This extension is realized by the TestEditor  class that is extended by 

the Load Test Editor plugin and called LoadTestEditor.

The editor layer extends classes from the common framework layer to provide specific implementations 

for their models. The protocol layers can be basic and dependent. The basic protocols do not depend on 

other protocols, such as HTTP. The dependent protocols are built on top of other protocols, for example 

Siebel on top of HTTP. The protocol layers are implemented on top of the single editor layer. The protocol 

layers provide handlers for protocol-specific objects.

When the editor needs to be opened on a model file, Hyades determines which editor is capable of 

handling this particular model and loads and initializes specific extension. The common layer provides its 

implementation of the handler class, the CommonEditorExtension  class. The common editor layer creates 

an instance of the TestEditor  class that must be extended by the editor layer. After the TestEditor  object is 

created, the user interface (UI) widgets and components are created to display the model data.

The TestEditor  provides the bridge between TPTP, the model, Eclipse, and the concrete protocol code. 

The CommonEditorExtension  class is used. When the editor is closed by the user or reloaded, the first 

instance of the TestEditor  is destroyed and a new one is created.

The layers described above are split into separate plugins. Each plugin defines some extension points 

which are used by the higher-level plugins as well as by the defining plugins themselves. Additionally, 

there are some Java™  interfaces that must be used when writing classes.

The plugins are:

• com.ibm.rational.test.common.editor.framework

• com.ibm.rational.test.lt.testeditor

• com.ibm.rational.test.lt.http.editor

• com.ibm.rational.test.lt.http.siebel
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Related reference

Common editor framework  on page180

Editor layer extension points  on page187

API classes  on page189

Related information

Migrating test editor extensibility  on page172

Contributing actions to the menu  on page184

Common editor framework
Extend performance test editing in the common editor framework. It contains the classes to extend for 

specific behaviors that will be used by the extended editor implementations.

Because performance testing editors are extensions loaded and initialized by the TPTP platform through 

the org.eclipse.hyades.ui.editorExtensions  extension point, one of the common editor framework 

functions is to provide hooks and application programming interfaces (APIs) for concrete editor 

implementations to communicate with TPTP. The common editor framework defines the classes to be 

used by higher editor implementations. One of the most widely used classes is the TestEditor  class, 

which is extended by the com.ibm.rational.test.lt.testeditor.main.LoadTestEditor  plug-in.

The layoutProvider, labelProvider, contentProvider  and actionHandler  extension points have been 

deprecated and are superseded by the modelObjectDescriptor  extension point that combines and 

enhances them. The following table lists the active extension points that you can use to extend the 

common editor framework:

Exten

sion 

point Description

modelOb

jectDe

scriptor

Specifies the type of the object, the test editor, and the general name and icon for the ob

ject.

testOp

tions

Used to contribute user interface (UI) elements for displaying the protocol options in the 

Details  area of the root element in the tree, Performance Test  or Schedule.
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Exten

sion 

point Description

editor

AddonEn

abler

Used to write contributions to existing user interface (UI). It can have enabled and dis

played state. Works with the AddonReader  class.

search

Type

Provider

Contributes a search category to the performance testing Search  window. The category 

consists of object type and, optionally, search parameters.

search

TypeOp

tions

Contibu

tor

Contributes extra search parameters to some other search type category.

pref

erence

PageCon

tributor

Provides a way to create extensible preference pages as well as to contribute UI to other 

preference pages. For preference pages, use the Eclipse extension point and extend the 

class com.ibm.rational.common.test.editor.framework.kernel.EditorPreferenecePage. 

For page contributions, use this extension point and extend the com.ibm.rational.common

.test.editor.framework.kernel.TestPreferenceContributor  class.

Related reference

Editor layer extension points  on page187

API classes  on page189

Related information

Migrating test editor extensibility  on page172

Test editor structure  on page178

Contributing actions to the menu  on page184

The modelObjectDescriptor extension point
The modelObjectDescriptor  extension point combines and enhances the deprecated contentProvider, 

labelProvider, layoutProvider, and actionHandler  extension points.
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The modelObjectDescriptor  extension point has four attributes. The attributes specify the type of the 

object, the type of the test editor where the object is used, and the general name and icon for the object. 

The name should not have any formatting characters in it. The name with the icon is used primarily for 

reporting purposes.

At

tribute Description

type Represents the type of the model object, returned by the CBActionElement.getType() 

method.

mod

el_

type

The type of the model or test. The same value returned by your CBTest.getType()  method. 

For performance testing, protocol extensions use com.ibm.rational.test.lt.lttest.

icon The image that represents your object.

label The name of your object.

The modelObjectDescriptor  extension point has four child definitions, as described in the following table:

Child Attributes description

label

Provider. 

See 

com.ibm

.rational

.common

.test.edi

tor.frame

work.ex

tensions

.  ExtLabel

Provider 

class.

• treeLabel  — The text to be displayed in the tree in the Main  section of the editor. 

This text can be static or contain formatting. It is up to the implementing class 

to format and return proper textual representation of an element.

• statusLine  — The text to be displayed on the status line when the object is se

lected in the Main  section tree of the editor. If omitted, the value of the treeLa

bel  attribute will be used for this purpose.

• tooltip  — The text to be displayed in the tooltip (when appropriate). If omitted, 

the value of the treeLabel  will be used for this purpose.

• menuText  — The text to be displayed in a pop-up menu, such as Add  or Insert. 

If omitted, the value of the modelObjectDescriptor  label will be used for this pur

pose.

• description  — The longer description of the model element. If omitted, the value 

of the modelObjectDescriptor  label will be used for this purpose.

• icon  — The image that represents the model element. May be same or different 

as the one specified in the modelObjectDescriptor  icon.

• class  — The instance of this class will be created when an object is set up to 

be referenced in the editor. There is a default base class to be used for this 
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Child Attributes description

purpose, called ExtLabelProvider. It provides methods that return information, 

specified in the extension. All of its methods can be overridden by the extending 

class to provide appropriate formatting.

layout

Provider. 

See 

com.ibm

.rational

.common

.test.edi

tor.frame

work.ex

tensions. 

ExtLayout

Provider 

class.

• class  — The instance of this class will be created when the object details are 

displayed in the editor’s Details  section. A model element must have a layout

Provider  class if this object is displayed in the Main  section tree. There is a de

fault base class to be used for this purpose, called ExtLayoutProvider. It pro

vides methods for constructing, formatting, and refreshing Details  section for 

the model element. The methods layoutControls  and refreshControls  must be 

overridden by the extending class. The com.ibm.rational.common.test.editor

.framework.extensions.ExtLayoutProvider  class implements the SelectionLis

tener  and ModifyListener  interfaces, so it can be used to listen to such events 

generated by your controls.

content

Provider. 

See Ext

Content

Provider 

class.

• class  — The instance of this class will be created when the object hierarchy 

information needs to be discovered. A model element must have a content

Provider  class if the object is displayed in the Main  section tree. There is a de

fault base class to be used for this purpose, called ExtContentProvider. It pro

vides methods for discovering information about object children and parents. 

See the Eclipse IStructuredContentProvider  interface for more details. In many 

cases there is no need to override any of the ExtContentProvider  methods, but 

if some non-standard processing must be done, the first method to override is 

getChildrenAsList(), as it is called by other methods in this class.

actionHan

dler. See 

the ExtAc

tionHan

dler  class.

• class  — The instance of this class will be created when a new object of this type 

needs to be created or when the existing object needs to be removed from mod

el or moved up or down. Your class must extend ExtActionHandler.

Related reference

The testOptions extension point  on page183
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The testOptions extension point
The testOptions  extension point is used to contribute user interface elements for displaying options for 

a protocol in the Details  area of the root element in the tree, Performance Test  or A schedule, in this 

context, is used to refer to both VU Schedule  and Rate Schedule. Each contribution is displayed in a 

separate tab in a Tab  folder.

The testOptions  extension point has the following attributes:

At

tribute Description

label The text to be displayed in the tab title.

toolTip The text to be displayed in the tab tooltip.

image The image to be displayed in the tab title.

fea

ture_

id

The feature to which these options pertain, currently not filtered.

order The numeric order of the tab, used to sort tabs. If no number is given or there are duplicate 

numbers, the label will be used for sorting.

class The class that will be instantiated to display and handle options. The default implemen

tation base class, DefaultOptionsHandler , provides convenience methods. This class is 

abstract, which means that it needs to be extended to provide concrete user interface el

ements. The default implementation of the ExtLayoutProvider  class for Test objects, De

faultTestLayoutProvider, loads and displays relevant options declared through this exten

sion point.

Related reference

The modelObjectDescriptor extension point  on page181

Contributing actions to the menu
You can use extensions to extend the menu, change navigation, and perform data correlation.
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Related reference

Common editor framework  on page180

Editor layer extension points  on page187

API classes  on page189

Related information

Migrating test editor extensibility  on page172

Test editor structure  on page178

Test editor menus
The test editor has three menus. You can extend the menus by adding more actions such as remove, 

move up, or move down

The first menu is displayed when the user right-clicks inside the left side of the tree. The other two 

menus are displayed when the user clicks the Add  and Insert  buttons. The Add  or Insert  menus are also 

displayed as submenus in the tree menu.

The IDs of the menus and named group separators are listed in the following table:

ID

Group separator defined 

in ITestEditorActionIDs

org.eclipse.hyades.test.ui.editor.TestSuiteEditorPart

.tree.menu

• additions.new-start

• additions.new-end

• additions.edit-start

• additions.edit-end

• additions.find-start

• additions.find-end

• IWorkbenchActionConstants.MB_

ADDITIONS

org.eclipse.hyades.test.ui.editor.TestSuiteEditorPart

.action_add

• IWorkbenchActionConstants.MB_

ADDITIONS

org.eclipse.hyades.test.ui.editor.TestSuiteEditorPart

.action_insert

• IWorkbenchActionConstants.MB_

ADDITIONS
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Related information

Creating actions  on page186

Creating actions
You can use the com.ibm.rational.common.test.editor.framework.extensions.ExtActionHandler  class to 

remove, move up, and move down menu buttons

The editor or protocol extensions that are needed to manipulate the test, and the test add, remove, 

insert specific model elements, must use the NewModelElementAction  class as described in the following 

conditions:

1. For every model element displayed in the tree, the 

com.ibm.rational.common.test.editor.framework.Test Editor  class expects to find an instance 

of the com.ibm.rational.common.test.editor.framework.extensions.ExtActionHandler  class and 

some com.ibm.rational.common.test.editor.framework.kernel.actions.NewModelElementActions 

registered in com.ibm.rational.common.test.editor.framework. TestEditorplug-in’s 

com.ibm.rational.common.test.editor.framework.RptMenuManager.

2. The ActionHandlers are declared in the plugin.xml file, while the 

com.ibm.rational.common.test.editor.framework.kernel.actions.NewModelElementAction  class 

must be created and registered programmatically through the protocol plug-in class. Only one set 

of actions is needed for multiple editors, because this class is context sensitive.

3. The ActionHandlers of the selected elements are asked whether 

to enable the Remove, Move up  and Move down  buttons . The 

com.ibm.rational.common.test.editor.framework.extensions.ExtActionHandler  examines the 

selection, looks for the objects of the recognized types, and then returns a value of true  or false.

4. To enable or disable Add  and Insert  buttons and menus, the 

TestEditor  class passes the selection to each of the registered 

com.ibm.rational.common.test.editor.framework.kernel.actions.NewModelElementAction 

instances. The action is expected to examine the selection, and enable or disable its state, based 

on whether this action can add its model object to the selected item.

5. The ID of each 

com.ibm.rational.common.test.editor.framework.kernel.actions.NewModelElementAction  or 

the derived type must match the type of the model object that this action represents. The ID 

must have the same value as the one used in the modelObjectDescriptor  extension point. The 
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com.ibm.rational.common.test.editor.framework.Test Editor  class uses this value to locate 

various providers for the specific model element.

6. There are two separate sets of actions maintained by the 

com.ibm.rational.common.test.editor.framework.RptMenuManager  class, the Add  and the Insert 

actions. While objects of the same type can be registered for both, the same instances of the 

same class cannot. This means that two instances of the AddObject  action must be created and 

registered. If the object cannot be inserted, the insert action is not required. The same is true for 

the add action.

7. If an action is selected, the action calls its correspondent ActionHandler  to create a new model 

object. At this point, the ActionHandler  class must create and initialize a new model object, 

including any required children. The action will add the new model object to the selected parent, 

but only if the selected parent ContentProvider  returns a list of the children that have EList  type, 

the native model list. For a composite list of children, for example the ArrayList  assembled by 

provider, the ActionHandler  is expected to add a new child to the parent.

8. The protocol writers must use the LoadTestNewModelElementAction  class as the base class for 

creating actions. The class supports filtering by feature.

Related information

Test editor menus  on page185

Editor layer extension points
The editor layer enables you to write protocol extensions. During the initialization process, a number of 

extension points are checked for extensions that define different aspects of the test editor.

The editor layer extends classes from the common framework layer to provide specific implementations 

for their models. The extensions must be defined in the protocol-specific plug-ins extending the test 

editor.

Extension point Description

dataCorrelationHandler • Defines an entry in the Data Correlation 

Handler Selection window. The handlers 

are queried and displayed in a dialog for 

the user to choose when there is more 

than one protocol capable of creating da
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Extension point Description

ta correlation objects out of the selected 

text.

• The user interface descriptor of a handler 

is matched to its data correlation package 

through the typeID  attribute in the exten

sion point.

dataCorrelationUICategory • Defines a category for grouping built-in 

data sources that are represented in the 

user interface by the dataCorrelation

UIDescriptor  extension point.

dataCorrelatorUIDescriptor • Provides visual representation for built-in 

data source types. These are grouped un

der data correlation user interface cate

gories in the Built-in Datasource Selection 

Wizard. The wizard is displayed when the 

user wants to create data correlation with 

a built-in data source.

wizardPageContributor • Used for contributing a protocol specific 

page or pages to the New Test Wizard.

The protocol handler can make a contribution to the details page of the test to protocol-specific 

test-wide options. If your protocol needs to support data correlation, you can use the class 

DataCorrelationLabelProvider. The class contains several methods to use with data correlation. Many of 

the methods deal with display aspects of the data correlation objects.

In data correlation there must be an attribute name assigned to every field or property of a model object 

that supports data correlation. These names are used for many purposes, one of which is to provide 

formatted labels for data correlation objects. Because the LoadTest  editor creates labels early in a 

process cycle, these labels may not contain detailed formatting instructions. To overcome this issue, 

higher level protocol extensions or plug-ins can register LabelFormatters  that are called when needed.

Related reference

Common editor framework  on page180

API classes  on page189
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Related information

Migrating test editor extensibility  on page172

Test editor structure  on page178

Contributing actions to the menu  on page184

API classes

The following classes and methods can be used to extend the common editor framework:

Class Methods

com.ibm.rational.common.test.editor

.framework.extensions.ExtLabelProvider

• getTestEditor()  - Returns the TestEditor  object, 

the LoadTestEditor  in the Performance Test Edi

tor

.

com.ibm.rational.common.test.editor

.framework.extensions.ExtLayoutProvider

• getTestEditor()  - Returns the TestEditor  object.

• getFactory()  - Returns the WidgetFactory  for cre

ating widgets and controls.

• getDetails()  - Returns Composite which is a par

ent for creating controls.

Related reference

Common editor framework  on page180

Editor layer extension points  on page187

Related information

Migrating test editor extensibility  on page172

Test editor structure  on page178

Contributing actions to the menu  on page184
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Contributing error handlers
An error handler is associated with an error condition. Error handlers specify the action to take when a 

specified error condition occurs. Error handlers are provided for conditions such as verification-point 

failures, connection failures, server timeouts, and data-correlation problems. You can add new types of 

errors and error handlers.

Defining the user interface for an error handler
After you create a new type of error, you must define the user interface for the error handler. If you do not 

define a user interface, the error handler is not available in the test editor or schedule editor.

To define the user interface for a new error handler, use the 

com.ibm.rational.test.common.editor.framework.exceptionDefinition  extension point.

The creator class can implement the 

com.ibm.rational.common.test.editor.framework.extensions.IExceptionCreator  class or extend the 

com.ibm.rational.common.test.editor.framework.extensions.DefaultExceptionCreator  class. The 

com.ibm.rational.common.test.editor.framework.extensions.DefaultExceptionCreator  class provides 

a default implementation of the IExceptionCreator element, which uses the isMyType(CBErrorType 

exceptionType)  method.

The following is an example definition using HTTP:

<extension point="com.ibm.rational.test.common.editor.framework.exceptionDefinition">

 <exceptionTypeDefinition

               creatorClass="com.ibm.rational.test.lt.http.editor.PageTitleErrorExceptionCreator"

               defaultBehavior="0"

               defaultMessage="%PageTitle.Vp.Failed"

               forFeature="com.ibm.rational.test.lt.feature.http"

               labelProvider="com.ibm.rational.test.lt.http.editor.ui.exceptions.PageTitleVpErrorLabelProvider">

 </exceptionTypeDefinition>

 <exceptionTypeDefinition

               creatorClass="com.ibm.rational.test.lt.http.editor.ResponseCodeVpErrorCreator"

               defaultBehavior="0"

               defaultMessage="%Resp.Code.Vp.Failed"

               forFeature="com.ibm.rational.test.lt.feature.http"

               labelProvider="com.ibm.rational.test.lt.http.editor.ui.exceptions.ResponseCodeVpErrorLabelProvider">

 </exceptionTypeDefinition>

 <exceptionTypeDefinition
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               creatorClass="com.ibm.rational.test.lt.http.editor.ResponseSizeVpErrorCreator"

               defaultBehavior="0"

               defaultMessage="%Resp.Size.Vp.Failed"

               forFeature="com.ibm.rational.test.lt.feature.http"

               labelProvider="com.ibm.rational.test.lt.http.editor.ui.exceptions.RespSizeVpErrorLabelProvider">

 </exceptionTypeDefinition>

</extension>

You must specify the feature ID when you define the user interface for an error handler. By specifying 

the feature ID, the test editor can find the new types of errors and to filter out error types that are not 

applicable in multiprotocol tests.

Related information

Controlling how available error handlers are displayed  on page191

Controlling how error handlers for specific elements are displayed  on page192

Creating an error type  on page194

Implementing code generation for error handling  on page196

Implementing execution for error handling  on page197

Controlling how available error handlers are displayed
You can control how custom error handlers are displayed in the test and schedule editors.

For any test element, all core errors and all applicable protocol-specific errors are displayed automatically 

in the Details  section of the Advanced  page in the test editor, if the following conditions are satisfied:

• The element implements the CBErrorHost  interface.

• The canHostErrors  method returns true.

• The isErrorGenerator  method returns false.

These conditions are tested in the createExceptionsUi  method in the ExtLayoutProvider  class. 

Typically, you do not modify the default behavior for a test element, but it is possible to override the 

createExceptionsUi  method. If the createExceptionsUi method  returns null, no user interface for error 

handling is displayed on the Advanced  page in the test editor.

The ExceptionsUI  class controls the user interface for error-handling on the Advanced  page. The test-

specific implementation is the TestExceptionsUI  class. The schedule-specific implementation is the 

191



Test Execution Specialist Guide

192

ScheduleExceptionsUI  class. A shortcut way to create these classes is to call the createExceptionsUi 

method in the TestEditor  class.

Note:  Container objects in schedules do not display any user interface for error handling if there are 

no tests inside the containers.

Related information

Defining the user interface for an error handler  on page190

Controlling how error handlers for specific elements are displayed  on page192

Creating an error type  on page194

Implementing code generation for error handling  on page196

Implementing execution for error handling  on page197

Controlling how error handlers for specific elements are displayed
You can control how error handlers for specified test elements are displayed.

In the test editor, users can configure error handling for a specific model element that produces an 

error. For example, if a specific instance of a content verification point fails, the user can change the 

error-handling behavior for only that instance of the content verification point. To change how the error 

handlers for protocol-specific elements are displayed, you must know what types of errors can be 

generated for the element when tests run.

The test editor SDK provides classes for the display of the error-handling user interface. 

The com.ibm.rational.test.lt.testeditor.main.exceptions.TestExceptionProducerUI  class 

controls the error-handling user interface in the Details  section of the Advanced  page. The 

com.ibm.rational.test.lt.testeditor.main.exceptions.DialogExceptionProducerUI  class controls the error-

handling user interface in dialog boxes and properties pages.

The following code is an example for the Details  section of the Advanced  page in the test editor. In the 

layoutControls  method, add code similar to these lines:

m_exceptionUi = new TestExceptionProducerUI( 

 getTestEditor(),

 new AuthenticationExceptionCreator());

m_exceptionUi.createErrorProducerContents( 

 getDetails(), 
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 getNtlm(),

 (LoadTestWidgetFactory) getFactory());

The AuthenticationExceptionCreator  class is the same class that is specified in the plugin.xml  file in 

the exceptionDefinition  extension point. In the refreshControls  method, add code similar to this line:

m_exceptionUi.refresh( getNtlm() );

The following code is an example for dialog boxes and properties pages. In the createContents  method or 

the createDialogArea  method, add code similar to these lines:

m_errorHandling = new DialogExceptionProducerUI(

 m_page.getEditor(),

 new PageTitleErrorExceptionCreator());

m_errorHandling.createErrorProducerContents( parent, vp );

In the onCancelPressed  method, which is called when the user clicks Cancel  in a dialog box, add code 

similar to this line:

m_errorHandling.cleanUp();

When the user clicks OK  in a dialog box or property page, the changes are applied to the CBError  object 

immediately, so no extra code is required. When the user clicks Cancel  in a dialog box or property page, 

the changes must be undone using the cleanUp  method.

To receive notifications when changes are made to a CBError  object, override the updateEditor  method by 

using this code:

m_errorHandling = new DialogExceptionProducerUI( 

   TestEditorPlugin.getEditorFor(m_datapool), 

   new EndOfDatapoolExceptionCreator()){

  @Override

  protected void updateEditor() {

   getButton(OK).setEnabled(true);

   super.updateEditor();

  }

 };

 m_errorHandling.createErrorProducerContents(composite, m_datapool, null );

Related information

Defining the user interface for an error handler  on page190

Controlling how available error handlers are displayed  on page191
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Creating an error type  on page194

Implementing code generation for error handling  on page196

Implementing execution for error handling  on page197

Creating an error type
The core performance test model includes the generic CBError  object. The CBError  object is a shell that 

contains the actual error, the CBErrorType  object. Extend the CBErrorType  object to add new types of 

errors, including protocol-specific errors. Associate error-handling behavior with an error by using the 

CBErrorBehaviorEnum  object.

The following code is an example of creating a new protocol error type from the generic error object:

public abstract class ProtocolErrorTypeImpl extends CBErrorTypeImpl implements ProtocolErrorType {

 /**

  * <!-- begin-user-doc -->

  * <!-- end-user-doc -->

  * @generated

  */

 protected ProtocolErrorTypeImpl() {

  super();

 }

 

 /**

  * <!-- begin-user-doc -->

  * <!-- end-user-doc -->

  * @generated

  */

 protected EClass eStaticClass() {

  return ErrorsPackage.Literals.PROTOCOL_ERROR_TYPE;

 }

 

 public boolean isErrorGenerator(){

  return true;

 }
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 /** 

  * Imports needed at code generation time 

  * so that the test runs correctly.

  */

 public List<String> getExecImport() {

  ArrayList<String> imports = new ArrayList<String>();

  imports.add("import com.ibm.rational.test.lt.execution.protocol.tes.*;");

  imports.add("import com.ibm.rational.test.lt.kernel.action.impl.KThrow;");

  imports.add("import com.ibm.rational.test.lt.kernel.services.*;");

  return imports;

 }

} //ProtocolErrorTypeImpl

The following code is an example of creating a protocol error type from another protocol error type:

public class ProtocolNewErrorTypeImpl extends ProtocolErrorTypeImpl implements ProtocolNewErrorType {

 /**

  * <!-- begin-user-doc -->

  * <!-- end-user-doc -->

  * @generated

  */

 protected ProtocolNewErrorTypeImpl() {

  super();

  

 }

 /**

  * <!-- begin-user-doc -->

  * <!-- end-user-doc -->

  * @generated

  */

 protected EClass eStaticClass() {

  return ErrorsPackage.Literals.PROTOCOL_NEW_ERROR_TYPE;

 }

 

 public String getExecType(){

  return "ProtocolNewEvent" ;

 }

} //ProtocolNewErrorTypeImpl
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For model elements that generate errors, declare these elements to be error generators by using this 

code:

public boolean isErrorGenerator(){

  return true;

}

Related information

Defining the user interface for an error handler  on page190

Controlling how available error handlers are displayed  on page191

Controlling how error handlers for specific elements are displayed  on page192

Implementing code generation for error handling  on page196

Implementing execution for error handling  on page197

Implementing code generation for error handling
During code generation, test elements are translated into code language elements. You must implement 

code generation for new error-handling methods.

To learn more about code generation, see Extending code generation  on page 202.

Complete these steps to implement code generation for objects that do not generate errors:

• For Script  objects, add the <PARAM name="codegen.core.attributes">  parameter to the creation 

template for the method. For KAction  objects, add the <PARAM name="codegen.core.attributes"> 

parameter to the execute()  method.

• Add a call to the translateCoreAttributes()  method. For example, the LTTestScriptDefinition class 

now includes this call:

LTTestTranslator.translateCoreAttributes(scriptTemplate, null, (CBActionElement)test);

Complete the following steps to implement code generation for methods that generate errors, such as 

connection failures and authentication failures:

• Add the <PARAM name="errorBehavior">  parameter to the creation template for the method.

• Add a call to the translateErrorBehavior()  method. For example, code generation for the 

BasicAuthentication object in HTTP includes these calls:
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  CBError err = (bAuth.getCBErrors().size()==0)?null:(CBError)bAuth.getCBErrors().get(0);

  translateErrorBehavior(err, bAuthElem, ILanguageElement.TEMPLATE_CREATION);

Related information

Defining the user interface for an error handler  on page190

Controlling how available error handlers are displayed  on page191

Controlling how error handlers for specific elements are displayed  on page192

Creating an error type  on page194

Implementing execution for error handling  on page197

Implementing execution for error handling
Events that require error handling at run time must have an associated errorBehavior  action. Extend the 

RPTEventGenerator  class to specify event behaviors.

KAction  objects handle events by implementing the IRPTEventHandler  method. When an event such as a 

verification-point failure or connection failure occurs, make the following call to the KAction  object that is 

the parent of the event:

KAction.registerEvent(eventType, eventBehavior);

In the previous example, the eventType  parameter is the type of failure. The eventBehavior  parameter is 

the action to take when the failure occurs.

During the KAction.finish()  procedure, all registered event behaviors are processed. Behaviors that are 

registered for a specific event are processed. Applicable behaviors that are specified at a higher level in 

the event hierarchy are processed.

The following code implements the RPTEventGenerator  class:

public abstract class RPTEventGenerator implements IRPTEventGenerator{

 RPTEvent behavior = null;

 boolean behaviorSet = false;

 IKAction act = null;

 RPTEvent eventType;

 

 

 public void setEventBehavior(IKAction act, RPTEvent eventType, RPTEvent behavior){
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  behaviorSet = true;

  this.behavior = behavior;

  this.act = act;

  this.eventType = eventType;

 }

 

 public RPTEvent getEventBehavior(){

  return behavior;

 }

 

 public RPTEvent getEventType(){

  return eventType;

 }

 

 public KAction getAction(){

  return act;

 }

}

The following code examples demonstrate how to implement error handling at run time for the 

ServerConnection  class.

public class ServerConnection extends RPTEventGenerator implements IServerConnection {

 

public ServerConnection(String name, int port, ISSLInfo sslInfo,

   INtlmAuthenticationContext ntlmContext,

   IProxyServerInfo proxyServerInfo,

   boolean closeWhenTestCompletes, RPTEvent behav) {

  this.serverAddr = new InetAddressInfo(name, port);

  this.sslInfo = sslInfo;

  this.ntlmCxt = ntlmContext;

  this.proxyInfo = proxyServerInfo;

  this.inUse = true;

  this.closeWhenTestCompletes = closeWhenTestCompletes;

  setEventBehavior(null, new RPTConnectEvent(), behav);

 }

}

The behavior for a server connection failure now includes the following code:
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 registerEvent(((IRPTEventGenerator)m_Request.getServerConnection()).getEventType(), 

 ((IRPTEventGenerator)m_Request.getServerConnection()).getEventBehavior());

Related information

Defining the user interface for an error handler  on page190

Controlling how available error handlers are displayed  on page191

Controlling how error handlers for specific elements are displayed  on page192

Creating an error type  on page194

Implementing code generation for error handling  on page196

Extending the schedule component
When you extend the schedule component in performance testing, another plug-in can contribute options 

to a schedule. Those options can be set up to persist in the schedule model, and a corresponding user 

interface can be displayed for editing the new options.

Another plug-in can contribute options to a schedule, have them persisted in the schedule 

model, and have a corresponding user interface displayed to edit those options. A schedule 

object represents a performance testing schedule. It is the main object in the schedule model. 

Schedules can have only one type of element added to them, a UserGroups object. You can use the 

com.ibm.rational.test.common.schedule.UserGroup interface to add a user group to a schedule.

The mechanism to extend scheduling is similar to the mechanism used to extend the test editor. See the 

"Extending the test editor" topic for more information.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Extension points for extending schedules
During the process of extending the schedule object, a number of extension points are checked to 

determine whether they extend different aspects of the schedule object.

The following table lists the extension points:
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Exten

sion point Description

com.ibm

.rational

.test.com

mon.sched

ule.edi

tor.option

Provider

This extension point enables a contributor to add options when a new schedule object 

is created through the File  > New wizard  command. The class  attribute must be set 

to a class that implements the IOptionProvider  interface from the com.ibm.rational

.test.common.schedule.extensions  package. A child node, forTypes, must be added al

so, with the type  attribute set to com.ibm.rational.test.common.schedule.Schedule.

com.ibm

.rational

.test.com

mon.editor

.framework

.testOp

tions

This extension point enables a contributor to specify that the user interface code dis

play or edit the options.

• Set the label  attribute to the desired label string. Each set of contributed op

tions will appear under its own tab in the editor.

• Set the order  attribute, if desired. A value of zero (0) must not be used, because 

it is used by the User Load  tab.

• Set the forTestType  attribute to com.ibm.rational.test.common.schedule

.Schedule.

If you are contributing options for both the Test and Schedule objects, you must cre

ate two instances of the extension definition in your plugin.xml file.

Related reference

Public APIs for extending schedules  on page200

Public APIs for extending schedules
The public APIs contain the public interfaces and classes that you can use to extend the Schedule object.

The following table lists the public interfaces and classes:
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Classes 

and in

terfaces Description

com.ibm

.rational

.test.com

mon.sched

ule.editor

.extension

s.IOption

Provider

• The IOptionProvider  interface is used in conjunction with the optionProvider 

extension point to allow contributors to initialize and add their options to a 

Schedule object when it is created by using the File  > New wizard  command.

• The class has the method public void setDefaultOptionValues(Schedule the

Schedule), which is called after the schedule object is created. In this method, 

create your option object. This object must be a subclass of the com.ibm.ratio

nal.test.common.models.behavior.CBOption  class.

• Once you have created the schedule object, you can add the option object to the 

schedule object by calling the addOptions()  method on the schedule object. See 

the Javadoc information for more details about the schedule interface.

com.ibm

.rational

.test.com

mon.model

s.behavior

.CBOption

• This class has no functionality. It only serves as a common type for options 

that are added to test and schedule objects.

com.ibm

.rational

.test.com

mon.sched

ule.Sched

ule

• For option contributors, the important method is the boolean addOptions(CBOp

tion options)  method. Use this method to add your option object to the Sched

ule  object. This should be done through the optionProvider  extension point. 

The method returns true  if the option object is successfully added.

• If you need to remove your options from the schedule, use the boolean remove

Options(CBOption options)  method. The parameter is the option object to re

move. The method returns a value of true  if the option object is successfully re

moved.

• Use the com.ibm.rational.test.common.models.behavior.CBOption.getOption

s(String strType)  method to retrieve your options from the schedule object. 

The parameter is the fully-qualified classname of the object type you want to re

trieve. Note that the return type is CBOption, so it must correspond to the appro

priate type. For example, to retrieve the general options for the schedule, the fol

lowing code can be used: ScheduleOptions2 theOptions = theSchedule.getOp

tions(ScheduleOptions2.class.getName());
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The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Related reference

Extension points for extending schedules  on page199

Extending code generation
The code generation subsystem maps Load Test Behavior Model (LTBM) elements to objects of the code 

generation element model (IModelElement), which in turn are mapped to objects of its ILanguageElement 

class. As a result, a language element tree is created that contains all equivalent elements of the behavior 

model test element tree and at the same time determines the structure of code to be generated.

The language elements are typed, named, and have appropriate templates defined for them. Performance 

testing code generation takes place entirely within the Eclipse workbench. The Eclipse extension point 

mechanism is used for code generation extensibility to accommodate new protocols.

The com.ibm.rational.test.lt.codegen.core plug-in supports code generation for the generic Load 

Test  script extending the com.ibm.rational.test.lt.execution.core.impl.LTTestScript  class 

and generic test elements such as loops, containers, transactions, data pools, generic content 

verification points, data sources and substituters, and generic custom code. Specific protocols 

such as the com.ibm.rational.test.lt.codegen.http plug-in are implemented as extensions of the 

com.ibm.rational.test.lt.codegen.core plug-in. The com.ibm.rational.test.lt.codegen.schedule plug-in 

generates schedules implemented on top of com.ibm.rational.test.lt.codegen.core functionality.

For the code generation extension sample, see the plug-in 

com.ibm.rational.test.lt.sdksamples.codegen.socket.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Code generation
The com.ibm.rational.test.lt.codegen.core.extLibraryDependency  extension point has been modified.

The com.ibm.rational.test.lt.codegen.core.extLibraryDependency  extension point has been modified in 

the following ways:
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• supportedFeature  has been added with attribute featureName, which is the feature ID of this 

protocol extension as defined by extending the com.ibm.rational.test.lt.licensing.feature 

extension point. If this element is specified, and the test being generated does not contain this 

feature, the existence of external libraries will not be enforced. This will prevent the developer from 

requiring that libraries are invalid for various OS platforms. If the element is not defined, external 

libraries are enforced as before, so no existing code is broken. Essentially these external libraries 

will not be enforced for tests that do not contain this feature.

• optionalExtLibraryLocation  has been added with attribute pathname  (the same as the one for the 

existing extLibraryLocation  element). Libraries defined by this element are deployed when present. 

If they are not present, however, no warning will be raised. An optional external library might have 

the supported feature defined, so if the test does not contain the feature, the optional library, even if 

it exists, will not be deployed.

• optionalExtLibraryLocation  and extLibraryLocation  have a new attribute, 

RelativetoExternalFiles. Set this attribute to true  if you are providing a library that is in the 

external_files directory and to false  if you are providing a library that is relative to your plug-in.

Related reference

Extension points for code generation  on page203

Code generation templates  on page208

New protocol extensions  on page209

Public APIs of codegen.core  on page210

Related information

Generating test code  on page205

Creating the script class  on page206

Extension points for code generation
During the initialization process a number of extension points are checked for existence of extensions 

that define different aspects of the code generation behavior.

These extensions must be defined in the protocol specific plug-ins extending core code generation 

classes.

Note:  Java™  has a 64KB limit on the size of a class method code. When there is a possibility of 

creating large methods that approach this limit, a check has to be programmed into the code generation 
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extension to ensure that the limit is not being exceeded. The guideline is to generate multiple smaller 

methods instead.

Extension point Description

com.ibm.rational.test.lt.codegen.core.type

DefDescription

Defines language element types that specify 

their own translators.

com.ibm.rational.test.lt.codegen.core.ele

mentTranslatorMapping

Defines what AbstractTranslator  class exten

sions are responsible for generating code for 

code generation model elements.

com.ibm.rational.test.lt.codegen.core.struc

tureDefinition

Defines the class that perform translation at the 

script level, the ScriptDefinition  class.

com.ibm.rational.test.lt.codegen.core.model

ElementAdapter

Defines the relationship between low-level be

havior model elements and code generation 

model elements.

com.ibm.rational.test.lt.codegen.core.model

Reader

Defines the class that reads the behavior model 

elements.

com.ibm.rational.test.lt.codegen.core.Tem

plateLocation

Defines the location of the directory that con

tains the templates.

com.ibm.rational.test.lt.codegen.core.ele

mentTypeTemplateBinding

Associates element types with the text tem

plates.

com.ibm.rational.test.lt.codegen.core.ele

mentTypeImportMapping

Defines the packages to be imported into the 

script when a particular element type is used in 

the test.

com.ibm.rational.test.lt.codegen.core.test

ProjectDependency

Defines the projects and the plug-ins to be added 

to the test project’s class path.

Related reference

Code generation templates  on page208

New protocol extensions  on page209

Public APIs of codegen.core  on page210
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Related information

Code generation  on page202

Generating test code  on page205

Creating the script class  on page206

Generating test code
During the initialization phase of a code generation request, an object extending the 

LTTestExtensionPreferences  class is created by calling all plug-ins implementing the 

com.ibm.rational.test.lt.codegen.core.codegenProtocolExtension  extension point through their 

supportFeatures()  method.

The supportFeatures()method  gets the feature list of the test model object, and if it determines that it 

supports these features, it returns the appropriate LTTestExtensionPreferences  object. The returned 

object implements the com.ibm.rational.test.lt.codegen.core.config.IExtensionPreferences  interface, 

which is the public part of the LTTestExtensionPreferences  class.

The code generation is controlled by the com.ibm.rational.test.lt.codegen.core.CodeGenerator  class. 

This class uses an EclipseCodegenConfiguration  object that stores the hash maps for translators, the 

model element adapters and the templates that are determined by language element types. The container 

test elements, data pools, and some other independent protocol-specific elements have their own 

translators defined. Elements that cannot exist on their own are translated as children of their containing 

elements by calling the translateChildren()  method of the translator.

The code generator determines the proper translator and calls its getTranslationFor()  method for the 

given model element.

The ElementAdapter  class with its getAdapterForType()  method determines the proper code generation 

model element for the given Behavior Model element.

The translation of test elements involves the following steps:

1. The test elements are read from the behavior model, and the appropriate translator is determined 

for each of them.

2. The language element object is created for the element and its template is determined.

3. The element attributes are read from the model and their corresponding parameters are 

substituted in the template.
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The generation of the code language elements is recursive and generates the language element tree 

containing all levels of the execution model test elements, each with the template object instantiated and 

containing all the requested test substitutions. The tree is implemented by using the language element 

containers as its nodes. The template substitutions for the language element containers for parameters 

defining multiple elements are processed by the LangElemCollectionValue  class.

Related reference

Extension points for code generation  on page203

Code generation templates  on page208

New protocol extensions  on page209

Public APIs of codegen.core  on page210

Related information

Code generation  on page202

Creating the script class  on page206

Creating the script class
After all model language elements are processed and the code language elements created, the code for 

the script class is generated.

The global script variables need to be declared at the top of the script, and their number and types are 

not known until all test elements are processed. The names of these variables and other associated 

information are gathered during the processing of the test element tree and are stored as temporary 

attributes of the test elements in the test model. The script class creation is accomplished by the 

ScriptDefinition  class and is based on a separate script template.

The script template declares the imports and the script globals. It contains the parameters for script type-

specific declarations and for methods creating and returning the test elements.

The creation of the top-level script class and test project involves the following steps:

1. The language element tree and the top level script element are created.

2. The generation of script text is performed and the text is stored in Eclipse storage units.

3. The test project is configured, the class path is determined and updated, and the project is built.

The following code represents an example of the script code structure:
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package customcode;

 

import com.ibm.rational.test.lt.execution.http.IHTTPRequest;

...

 

public class Google_Test_C240F3CB2D546DE2A9BDE160BDA411D9 extends 

 com.ibm.rational.test.lt.execution.protocol.impl.HTTPTestScript  {

 

    

    //GLOBAL DECLARATIONS

    private IBuiltInDataSource bds1 = new          

                       com.ibm.rational.test.lt.kernel.custom.impl.timestampdatasource();

 

    { builtInDCVars[50] = new BuiltInCorrelationVar(bds1);

 

        builtInDCVars[50].setProperty(1, "16");

        builtInDCVars[50].setProperty(2, "16"); }

 

    //TEST CLASS CONSTRUCTOR

    public Google_Test_C240F3CB2D546DE2A9BDE160BDA411D9(IContainer container, String  

                                                            invocationId) {

 

 super(container, "google", invocationId);

 

 setTimeoutScheme(IKTimeoutControl.CONTINUE);

 setArmEnabled(false);

 

 public void execute() {

         this.add(page_1(this));

         ...

         super.execute();

    }

 ......

 

 

    //page_1 CREATION METHOD

    private HTTPPage page_1(IContainer parent) {
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     HTTPPage page = new HTTPPage(parent, "Google", .....)  {

 

         public void execute() {

                 this.add(request_1(this);

                 ... 

              super.execute();

             }             

              .....

        };

        return page;

    }

 

    //request_1 CREATION METHOD

    private HTTPAction request_1(IContainer parent) {

 HTTPAction reqAction = new HTTPAction(parent, .....);

        .....

 harvestContainer_16.addHarvestInstruction ("resp_content", dcVars[50], ..);

 .....

 return reqAction;

 

    }

 

}

Related reference

Extension points for code generation  on page203

Code generation templates  on page208

New protocol extensions  on page209

Public APIs of codegen.core  on page210

Related information

Code generation  on page202

Generating test code  on page205
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Code generation templates
The code generation subsystem uses declaration templates and creation templates.

The declaration templates contain code for declarations of the methods and classes creating the test 

element. The creation template contains code that calls these methods to instantiate the test element 

objects.

The type of the template is reflected in the template name and is defined by the 

com.ibm.rational.test.lt.codegen.core.elementTypeTemplateBinding  extensions.

Note:  It is possible to have name conflicts between code generation templates with the same names 

that come from different protocol extensions. Use template names containing a protocol name (for 

example: HTTPScript.template) to avoid this problem.

The following example shows a creation template for a DCSubstituter object:

ISubRule sub_<PARAM name="subRuleIdx> = newSubRule(<PARAM name="targetAttr">",

                       <PARAM name="offset">,

                                                  <PARAM name="length",

                                                  <PARAM name="isEncoded",

                                                  <PARAM name="dataSourceVarName">,

<PARAM name="parentInstancename">, addSubInstruction (sub_<PARAM name="subRuleIdx">);   

Related reference

Extension points for code generation  on page203

New protocol extensions  on page209

Public APIs of codegen.core  on page210

Related information

Code generation  on page202

Generating test code  on page205

Creating the script class  on page206

New protocol extensions
This section describes the implementation of the code generation subsystem extension for the socket 

protocol as an example of using code generation extensibility features.
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A dedicated code generation plug-in, called com.ibm.rational.test.lt.sdksamples.codegen.socket  was 

created with subpackages of config, lang, and model. The socket code generation subsystem extends the 

capabilities of the codegen.core plug-in.

The config package contains the SocketExtensionPreferences  class which contains the 

supportsFeatures()  method that expresses interest in tests with feature lists containing the socket 

feature. Also, its getSupportedModelElements()  method declares which translator-associated model 

element types this codegen extension will support.

The lang package contains two main classes, a script definition (SocketScriptDefinition) class and 

a translator (SocketTranslator) class. The classes extend the appropriate super classes from the 

codegen.core plug-in, and defining methods for translating script and test elements. The script definition 

class overrides the doScriptLevelTranslation()  method which, after calling its superclass, translates 

all socket script template parameters specific to the socket protocol. The translator class overrides 

the getTranslationFor()  method, handling all non-socket functionality by calling its superclass, and all 

socket-specific test elements and parameters locally.

The model package contains the SocketElementAdapter  class, which implements a getAdapterFor() 

method that states what Common Behavior element type this protocol extension handles, and returns the 

corresponding codegen  model element.

The template directory was also added to the protocol extension plug-in, and socket-specific templates 

were created and placed there. All necessary extensions were defined in the protocol extension plugin.xml 

file.

For the code generation extension sample, see the plug-in 

com.ibm.rational.test.lt.sdksamples.codegen.socket.

Related reference

Extension points for code generation  on page203

Code generation templates  on page208

Public APIs of codegen.core  on page210

Related information

Code generation  on page202

Generating test code  on page205

Creating the script class  on page206
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Public APIs of codegen.core
The public APIs contain the public interfaces and classes used to extend the code generation core 

subsystem.

The following table lists the public interfaces and classes:

Package Public classes and interfaces

com.ibm.rational.test.lt.codegen.core.config • IExtensionPreferences

• InitializationException

• ConfigurationException

com.ibm.rational.test.lt.codegen.core.template • ITemplate

• Template

• ITemplateParameter

• LangElementCollectionValue

• LangElementParameterValue

com.ibm.rational.test.lt.codegen.core.lang • IStructureDefinition

• ILanguageElement

• LanguageElement

• ITranslator

• ICoreTranslationConstants

• TranslationException

com.ibm.rational.test.lt.codegen.core.model • IModelElement

• ModelElement

• IModelElementAdapter

com.ibm.rational.test.lt.codegen.lttest.config • LTTestExtensionPreferences

com.ibm.rational.test.lt.codegen.lttest.lang • ILTTestTranslationConstants

• LTTestScriptDefinition

• LTTestTranslator

com.ibm.rational.test.lt.codegen.lttest.model • LTTestElementAdapter

Related reference

Extension points for code generation  on page203

Code generation templates  on page208

New protocol extensions  on page209
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Related information

Code generation  on page202

Generating test code  on page205

Creating the script class  on page206

Extending the run-time environment
The run-time environment defines the plug-ins on which all other plug-ins depend. The run-time 

environment is responsible for defining a structure for plug-ins and the implementation detail behind 

them.

Blocked Action detection
The performance testing execution engine provides the capability of detecting that an Action is blocked. 

The definition of blocked is provided by the author of the Action. The definition is provided as an amount 

of time an Engine Worker Thread is allowed to be unresponsive in the course of executing the Action 

before it is considered blocked. The performance testing execution engine logs the detection of blocked 

actions at level FINEST in the Problem Determination Log. In the simplest case, the run would be hung, 

and discovery of the blocked action would come from examining the Problem Determination log after 

clicking Stop  to end the run.

In addition to detecting blocked actions, a protocol can be notified that the action is blocked. A reference 

to the blocked Eengine thread is provided with the action, making it possible for a protocol to send a 

message to the blocked thread. Upon notification of an action being blocked, the protocol can retry the 

action, finish the action and move to the next action, or finish the virtual user execution.

The IKAction  interface will provide the following method as an entry point for protocols to react to a 

blocked action condition:

public void blocked(). The KAction  object state, upon entering blocked(), is potentially corrupted. The 

protocol writer must assume any or all data associated with the Action is not safe. Also, any locks which 

may have been held during execute() have been released.

public long getBlockedTimeout()

Returns the action blocked timeout value. Default is 0, which means block indefinitely

public WorkerThread getWorkerThread()

Returns the Engine WorkerThread executing the action when the blocked state was detected.
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IEngine

The performance testing engine interface has added public boolean createWorker(). The purpose of 

createWorker()  is to allow the sentinel thread monitoring workers to add additional workers in response to 

having removed workers found executing blocked actions.

Extending subsystem management during a test run
A subsystem is a collection of classes in a discrete component within the performance testing engine 

that provides a service to many actions. For example, in test execution, the KernelWait  subsystem 

manages think and sleep time for virtual users while a test is running.

Here are additional examples of the services that subsystems provide:

• Tracking server responses. For example, consider tests in which an HTTP request is sent to a 

server, and you need to know when the response returns. Instead of tying up a thread to wait for 

the response, a subsystem can do this while the rest of the threads perform other actions. The 

subsystem can provide notification or reissue an action when the server response occurs.

• Handling asynchronous communication.

• Managing the sleeping action for virtual users.

• Managing logging. For example, creating a custom execution history can take a long time. You 

can assign a subsystem to do this without tying up a thread with this process. You can set up a 

subsystem to take care of the special logging actions while the rest of the actions perform other 

things.

Creating the performance test engine subsystem sample

A performance test engine subsystem provides services to one or more actions. An action that uses a 

subsystem during a test run is known as a recurrent action. Most actions contain finish() at the end of 

their execute(). A recurrent action requests service from a subsystem before the end of execute(). After 

the service is provided, the subsystem that provides the service updates state information in the action 

and reissues the action for execution. Based on the state information, a performance test engine worker 

thread takes a different course of execution during the recurring call to execute() and eventually calls 

finish() to end the action.

The following list gives an overview of the steps that are required to use this sample:

• Creating the performance test engine subsystem sample

• Informing the performance test engine of the existence of the subsystem

• Creating a simple test and schedule
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• Adding SampleAction and SampleSubsystem to the project

• Running the schedule with SampleAction using SampleSubsystem

Informing the test engine that the subsystem exists
Subsystems are identified to the performance test engine with extensions. Typically, a new protocol 

indicates in its plugin.xml file the class name of the subsystem that it is providing. This example modifies 

an existing performance test plug-in and specifies the class name of the sample plug-in in the plugin.xml 

file.

To identify the subsystem to the performance testing engine, complete the following steps.

1. Open a command prompt, and change directory to the __PT_ACRONYM__ plug-ins directory.

2. Save a copy of the existing HTTP execution JAR. For example: C:\__BRAND_NAME__\common

\plugins>copy com.ibm.rational.test.lt.execution.http_7.0.0.v200609010404.jar 

com.ibm.rational.test.lt.execution.http_7.0.0.v200609010404.jar.orig

3. Make a new copy of the HTTP execution JAR for modification. For example: C:\__BRAND_NAME__

\common\plugins>copy com.ibm.rational.test.lt.execution.http_7.0.0.v200609010404.jar 

foo.jar

4. Extract the plugin.xml file. For example: C:\__BRAND_NAME__\common\plugins>jar xvf foo.jar 

plugin.xml  Note:  You must have a Java™  SDK in your PATH statement so that you have access to 

the JAR utility.

5. Add these lines to the plugin.xml file just above the </plugin>  line at the bottom:

<extension

 point="com.ibm.rational.test.lt.execution.Subsystem">

 <Subsystem

  feature="com.ibm.rational.test.lt.feature.lt"

  class="test.SampleSubsystem"/>

</extension>

6. Start Rational®  Performance Tester  with the -clean  option so that the plug-ins are reloaded, for 

example: C:\IBM\RPT>eclipse –clean.

Creating a simple test and VU Schedule
You must create a simple performance test and VU Schedule. By creating and playing back a test and a 

VU Schedule, code is generated for both. Later, you will modify the generated test code so that the test 

contains a special action that uses the sample subsystem.
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1. Create a performance test project (File > New > Performance Test Project).

2. Type a project name, for example, testproj, and then click Finish.

3. When the Create New Test From Recording prompt opens, click Cancel.

4. Right-click testproj  and select New > Test.

5. Expand Test Assets, select New Test, and then click Next.

6. Name the test, for example, subtest, and then click Next.

7. In the Test Attributes window, click Next.

8. In the Protocols and Features  window, select the HTTP Protocol  check box.

9. In the HTTP Extension window, in the Number of HTTP pages to generate  field, type 0  (zero).

10. Specify the connection details and click Finish.

11. Right-click testproj  and select New >Performance Schedule.

12. Type a name for the schedule, for example, Schtest, and then click Finish.

13. Select User Group 1, and then click Add > Test.

14. Select subtest, click OK, and then click File > Save.

15. Right-click Schtest, and then select Run as > Performance Schedule.

Adding SampleAction and SampleSubsystem to the project
Import the performance test and schedule source files into the testproj project.

1. Open the Java™  perspective, open src, and then right-click test.

2. Select Import.

3. Import SampleAction.java and SampleSubsystem.java.

4. Edit the generated subtest file. The name will begin with Subtest_Test_ and end in .java.

5. At the bottom of the constructor for the test, add the following line: add(new SampleAction(this, 

"Sample Action"));

Running the schedule with SampleAction using SampleSubsystem
Modify the generated test code to use SampleAction, so that the subsystem is active during the next 

playback.

1. Right-click the schedule and select Run As > Performance Schedule.

2. When the run completes, right-click the results in the Performance Test Runs view and select 

Display Test Log.

3. Click Events.

4. Open the test log hierarchy and navigate through the events of the schedule playback. Look for 

message events where SampleAction indicates it is requesting service from the subsystem, and 

where SampleAction recognizes that it has received services from SampleSubsystem.
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SampleAction.java code sample
This is an example of SampleAction.java.

SampleAction.java

package customcode;

 

import com.ibm.rational.test.lt.kernel.IKSubsystem;

import com.ibm.rational.test.lt.kernel.action.IContainer;

import com.ibm.rational.test.lt.kernel.action.impl.KAction;

 

public class SampleAction extends KAction {

 final String subsystemName = "test.SampleSubsystem";

 private boolean serviced = false;

 

 public SampleAction(IContainer arg0, String arg1) {

  super(arg0, arg1);

  // TODO Auto-generated constructor stub

 }

 

 public void execute() {

  if (serviced) {

   reportMessage("SampleAction execute():  service completed");

   finish();

  } else {

   IKSubsystem subsystem = getSubsystem(subsystemName);

   if (subsystem != null) {

    reportMessage("SampleAction execute():  requesting service");

    subsystem.enqueue(this);

   } else {

    reportMessage("SampleAction execute():  Cannot find subsystem '" + subsystemName + "'");

    finish();

   }

  }

 }

 

 public void setServiced() {

  serviced = true;
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 }

}

SampleSubsystem.java code sample
This is an example of SampleSubsystem.java.

SampleSubsystem.java

package customcode;

 

import com.ibm.rational.test.lt.kernel.action.IKAction;

import com.ibm.rational.test.lt.kernel.engine.impl.Queue;

import com.ibm.rational.test.lt.kernel.impl.KSubsystem;

 

/**

 * Sample __PT_ACRONYM__ Engine Subsystem

 */

 

public class SampleSubsystem extends KSubsystem {

 private Queue sampleSubsystemQueue;

 private boolean stopRequested = false;

 private SampleAction client;

 

 public SampleSubsystem(String name) {

  super(name);

  sampleSubsystemQueue = new Queue();

  sampleSubsystemQueue.setBlocking(true);   // Allows for waiting for something to appear on the queue

 }

 

 /*

  * Actions enter the subsystem for service via a call to enqueue().

  * An action can get a reference to the subystem using the IKAction

  * getSubsystem() method.

  * 

  * @see com.ibm.rational.test.lt.kernel.IKSubsystem#enqueue(com.ibm.rational.test.lt.kernel.action.IKAction)

  */

 public void enqueue(IKAction action) {

  sampleSubsystemQueue.enqueue(action);
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 }

 

 /*

  * Message to the subsystem to stop.

  * 

  * @see com.ibm.rational.test.lt.kernel.IKSubsystem#shutdown()

  */

 public void shutdown() {

  stopRequested = true;

 }

 

 /*

  * @see java.lang.Thread#run()

  */

 public void run() {

  while(!stopRequested) {

   ringIn();    // Informs engine subsystem is healthy

   client = null;

   

   // If nothing to do wait for work

   updateJob("Idle");

   client = (SampleAction)sampleSubsystemQueue.dequeue(pingTime);

 

   // This subsystem's work will be to touch an attribute of the action

   if (client != null) {

    updateJob("Servicing " + client.getName()); // Good for debugging

    

    client.setServiced();

    dispatch(client);  // Serviced action leaves subsystem

   }

  }

 }

}
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Extending initialization and finalization during a test run
You can specify code for your protocol to be executed by the Rational®  Performance Tester  engine 

threads at strategic points during startup and shutdown. For example, you can specify code to load 

libraries, unload libraries, or perform other initialization or cleanup as required by the protocol.

You create a class that implements IKInitializeFinalize. The interface requires the following methods:

• public void initializeEngine()

• public void finalizeEngine()

• public void initializeWorker()

• public void finalizeWorker()

• public interface IKInitializeFinalize

The IKInitializeFinalize  interface provides a way for protocols to specify code that must be executed to 

the Rational®  Performance Tester  engine:

• once by the engine at startup

• once by the engine at shutdown

• once by each engine worker thread at startup

• once by each engine worker thread at shutdown

Use this startup and shutdown code when it is necessary for the engine to execute initialization or 

shutdown code. Also use this code for each worker thread before test execution occurs or after test 

execution finishes.

1. Specify a dependency on com.ibm.rational.test.lt.execution  in the plugin.xml  file of a protocol.

2. Use Add under plugin Extensions  to specify an extension for 

com.ibm.rational.test.lt.execution.InitializeFinalize.

3. Create a new extension element called InitializeFinalize. This element must have the following 

properties:

• class: The class name that implements IKInitializeFinalize

• id: The protocol feature ID

• dependsOn: Leave blank

For example:

• class="com.ibm.rational.test.lt.execution.http.impl.HTTPInitializeFinalize"

• id="com.ibm.rational.test.lt.feature.http"

• dependsOn=
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Public APIs for run time
The public APIs contain the public interfaces and classes that you can use to extend the run-time 

environment functionality.

The following table lists the public packages:

Package Description

com.ibm.rational.test

.lt.kernel

Contains the factory, counter, monitoring, and constants classes.

com.ibm.rational.test

.lt.kernel.action

Contains the classes and interfaces necessary to define conditions and 

the basic functionality that all kernel actions should implement

com.ibm.rational.test

.lt.kernel.arbitrary

Contains the IArbitrary  interface.

com.ibm.rational.test

.lt.kernel.custom

Contains the interfaces that enable additions of custom code to a perfor

mance test.

com.ibm.rational.test

.lt.kernel.engine

Contains the interfaces used to manage the process of arranging actions 

onto queues.

com.ibm.rational.test

.lt.kernel.io

Contains the interfaces that get the buffer factory.

com.ibm.rational.test

.lt.kernel.library

Contains the class that loads the library.

com.ibm.rational.test

.lt.kernel.logging

Contains the interfaces to manage the cache.

com.ibm.rational.test

.lt.kernel.runner

Contains the IRatlRunner  interface.

com.ibm.rational.test

.lt.kernel.services

Contains the interfaces for dataset, loop control, test information.

com.ibm.rational.test

.lt.kernel.statistics

Contains the interfaces for statistical counters.

com.ibm.rational.test

.lt.kernel.util

Contains the interfaces and classes for kernel utilities.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.
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Extending the test log viewer
After running a test, the test results are saved in a test log. Use the Test Log viewer to check the results 

for specific events, such as the script start and end, loop, invocation, message, or verdict.

You can extend the test log viewer for your protocol. For information about how to do this, see the Testing 

Performance Tools Platform (TPTP) documentation.

Extending evaluation results
Reports are a specification of how performance test data should be extracted from the statistical model 

and presented to the user.

The persisting reports contain no statistical data. After a report is created, it can be focused on any 

statistical model.

The user interface components for evaluation results are the Performance Test Runs view, Results Viewer, 

Report Wizard, Execution History Viewer (TPTP), Protocol Data view and Properties view in Eclipse. For 

details about how to use the user interface components, see the "Evaluating results" topic in the product 

information center.

Besides the user interface components, generic counters and aggregators also enable you to 

extend the evaluation of results. The generic counters represent the mechanism for specifying 

the model path of statistical data to be displayed in the Results Viewer. The generic counters 

are specified with the com.ibm.rational.test.lt.execution.results.DynamicCounter extension 

point. The aggregators calculate the majority of the data contained in the statistical model and 

reduce the amount of data that must be transmitted. The aggregators are deployed through the 

com.ibm.rational.test.lt.execution.results.data.aggregation.Aggregator extension point. For details 

about generic counters, see the "Generic counters" topic in the product information center. For details 

about extending evaluation results with aggregators and other classes and interfaces, see the Javadoc 

information.

For an example of extending evaluation results, see the plug-in 

com.ibm.rational.test.lt.sdksamples.results.socket.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.
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Aggregation of statistical data
To minimize network load, the guideline is to send only a minimal subset of the statistical data that can 

be used to aggregate the remainder of the statistical data. This aggregation is handled by the aggregation 

subsystem. There are two primary types of aggregators: transfer aggregators and standard aggregators. 

Transfer aggregators transfer data of like origin from individual nodes to the All Hosts node. Standard 

aggregators calculate additional data based on the data sent across the network from the execution 

engine. An example of a transfer aggregator task is creating the counter "Pages/Response Time/Google/

Average interval" on the All Hosts node by considering the same counter from three drivers. An example 

of a standard aggregator task is calculating counter "Pages/Response Time/Google/Average cumulative" 

on the All Hosts node by tracking and weighting each "average interval" value in real time.

For more information on aggregation, refer to the Javadoc information for the following transfer 

aggregators:

• MaxTransferAggregator

• MinTransferAggregator

• ScalarTransferLastValueAggregator

• AverageTranferAggregator

as well as the following standard aggregators:

• AverageAggregator

• MaxAggregator

• MinAggregator

• PercentAggregator

• PercentAggregator_NonInclusive

• RateAggregator

• TotalScalarAggregator

Related reference

Public APIs for evaluate results  on page231

Related information

Extending report counters  on page222

Extending default reports  on page228



Chapter 1. Test Execution Specialist Guide

Extending report counters
In performance test reports, generic counters are collectable queries in the user interface that 

dynamically gather specific information from the statistical model, such as the number of page hits, the 

response time, the response success, and information about verification points. Counters are dynamic. 

The counter wizard is used to add counters to reports. You can extend the counter wizard for specific 

protocols.

You extend the counter wizard in the ReportAction extension point, which is contained in the 

com.ibm.rational.test.lt.execution.results  plug-in.

Note:  Any report that provides mean average data now also provides standard deviation data. If a 

protocol-specific report contains a mean counter, the extension is able to add the corresponding standard 

deviation counter onto that report.

Related reference

Public APIs for evaluate results  on page231

Related information

Aggregation of statistical data  on page221

Extending default reports  on page228

The ReportAction extension point
ReportAction  enables interactions directly on the report screen as well as in the Performance Test 

Runs view. Use this extension point to enable report menus and menu items in the tree and to extend 

the counter wizard for your protocol. Implementors of generic ReportActions  must extend the abstract 

class com.ibm.rational.test.lt.execution.results.actions.ReportAction, while implementors of 

AddCounterAction  must specify relevant data in plugin.xml  only.

The following table describes the elements and attributes of the ReportAction  extension point.

Elements and attributes Description

ReportActionGroup Provides menu groupings for ReportActions 

that define the location of report actions within 

menus in reports.
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Elements and attributes Description

     menuPos Position of a menu group in a report menu. Valid 

values: "start" (top) "mid1," "mid2," and "end" (bot

tom).

ReportAction Provides interactivity on performance test re

ports and in the Performance Test Runs view. De

fines the behavior of actions in reports.

     groupID ID of the ReportActionGroup  (menu grouping) 

that contains this ReportAction  menu item.

     actionprovider Behavior provider that extends com.ibm.ratio

nal.test.lt.execution.results.ReportAction.

     Menutext Text for this menu item.

     Icon The project-relative path to the icon for this 

menu item.

     Tooltip Tooltip for menu item.

AddCounterAction Provides a wizard for adding and removing spec

ified statistical descriptors (counters).

     groupID ID of ReportActionGroup  that contains this wizard 

action.

     Menutext Menu text for an agent.

     Icon The project-relative path to the icon in the wizard 

for this action.

     Tooltip Tooltip for this action.

     allowAllAvailable When true, a check box is displayed at the bot

tom of the wizard that reads "Automatically add 

localizedCounterCategoryName counters to 

graphic as they appear in result." If the user se

lects this check box, any counter that appears in 

the stat model that meets the specifications of 

the AddCounter action is automatically added to 

the graphic of focus. For an example of this fea
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Elements and attributes Description

ture in use, see the Add/Remove Resource Coun

ters wizard in the performance testing product.

     agentID Returns the ID of the TRCAgent  to which this add 

wizard action applies. Agent IDs can be declared 

as "not" to specify systems under test, for exam

ple !com.ibm.rational.test.lt.execution.re

sults.XMLStatisticalDataProcessor. Declaring 

a "!" ID causes all other agents to be included. If 

this attribute is blank, it defaults to com.ibm.ra

tional.test.lt.execution.dataprocessor.XM

LStatisticalDataProcessor  which is the perfor

mance testing Statistical agent.

     wizardIcon The project-relative path to the icon that is dis

played on the wizard page.

     modelBasePath Specifies the root path from the statistical mod

el from which AddCounterAction  should pull coun

ters for the add/remove action.

     cshelpID The context-sensitive help ID for this wizard.

     localizedCounterCategoryName The localized description of the type of counters 

this wizard processes. This string is substitut

ed into the wizard to describe what the user is 

adding to the report. For example, in the string 

"Add/Remove Resource Counters Wizard", "Re

source Counters" is the localizedCounterCatego

ryName. This name should be plural as indicated 

above.

     showScale Makes data readable within the space provided 

for it in the user interface. If showScale  is true, the 

wizard enables the user to adjust the scale of 

counters relative to each other. It also enables a 

recommended scale to be calculated when da

ta is added to a report from the wizard. For an 

example of this feature in use, see the Add/Re
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Elements and attributes Description

move Resource Counters wizard in the perfor

mance testing product.

     showScope "Scope" refers to the nodes from which data is 

pulled from in the statistical model. If true, the 

user is provided with a control to specify the 

scope of a counter. Valid scopes are:

• All Locations  Data is pulled from any node 

in the model that has data meeting the 

specifications of an AddCounterAction.

• Systems Under Test  Data is pulled from 

any node that does not contain an "Statis

tical Agent." This signifies that the node is 

a "driver node."

• Selected location  Data is pulled only from 

the node on which the report is focused.

For an example of this feature in use, see the 

Add/Remove Resource Counters wizard in the 

performance testing product.

     showAgents If true, the wizard shows agents in the tree hier

archy. If not included or if false, descriptors are 

shown as the root objects.

     defaultScope Specifies the default scope to be used by the 

wizard. "Scope" refers to the nodes in the wiz

ard from which data is pulled from in the wizard. 

It can be used with or without the showScope  at

tribute. Valid entries are: "CURRENT", "SUT", and 

"ALL."

Enablement Controls when actions are visible and selectable.

type Specifies selected object types for which this ac

tion should be enabled. Any object that can be 

identified in a report or in the Performance Test 

Runs view (PTR) can be specified as a valid type, 
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Elements and attributes Description

for example, a chart or table as shown in the PTR 

or in a report.

path Controls visibility. If no path is specified, the item 

is visible on any selection where "type" is valid. 

Path also specifies the model path to the da

ta to be referenced within the selected object 

for menu-item visibility. Paths can contain wild

cards, and more than one path can be specified. 

An example path specification is as follows:

<path value="Pages,Response Time,*,Average 

 Cumulative"/>

runstate Controls enablement (not visibility) by run state. 

If true, the menu item is enabled only if a run is in 

progress.

Filterstate Controls enablement (not visibility) by filter state. 

If true, the menu item is enabled only if the se

lected object is filtered.

The following is an example of a ReportAction  extension point.

<extension

  point="com.ibm.rational.test.lt.execution.results.ReportAction">

 

 <ReportAction

   groupId="com.ibm.rational.test.lt.execution.results.ImportGroup"

     menutext="%IMPORT_RESMON_COUNTERS"

   tooltip="%IMPORT_RESMON_COUNTERS_TOOLTIP"

   icon="icons/elcl16/import_resmon_data.gif"

   actionprovider="com.ibm.rational.test.lt.execution.rm.actions.ImportResourceCounters"

  <Enablement>

   <type objecttype="com.ibm.rational.test.lt.execution.results.view.countertree.MonitorTreeObject"/>

   <type objecttype="com.ibm.rational.test.lt.execution.results.view.countertree.GraphicTreeObject"/>

   <type objecttype="com.ibm.rational.test.lt.execution.results.view.graphics.Graphic"/>

   <runstate active="false"/>

  </Enablement>
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 </ReportAction>

 <AddCounterAction

   agentID="!com.ibm.rational.test.lt.execution.dataprocessor.XMLStatisticalDataProcessor"

   allowAllAvailable="true"

   cshelpID="add_resource_wiz"

   defaultScope="ALL"

   groupId="com.ibm.rational.test.lt.execution.results.addcountersgroup"

   icon="icons/elcl16/add_res_ctr.gif"

   localizedCounterCategoryName="%RESOURCE_COUNTERS_DESCRIPTION"

   menutext="%ADD_RESOURCE_COUNTER"

   showAgents="true"

   showScale="true"

   showScope="true"

   tooltip="%ADD_RESOURCE_COUNTER_TOOLTIP"

   wizardIcon="icons/wizban/add_res_wiz.gif"

  <Enablement>

   <type objecttype="com.ibm.rational.test.lt.execution.results.view.graphics.Graphic"/>

   <type objecttype="com.ibm.rational.test.lt.execution.results.view.countertree.GraphicTreeObject"/>

  </Enablement>

 </AddCounterAction>

</extension>

 

Extending default reports
You can specify the default performance report for your protocol. In the Preferences page in performance 

testing, the Determine the default report based on protocols in test  check box is selected by default. 

You can specify, for your protocol, the report that automatically displays during a test run. You 

define the default performance report in the RPTReport  extension point, which is contained in the 

com.ibm.rational.test.lt.execution.results  plug-in.

Related reference

Public APIs for evaluate results  on page231
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Related information

Aggregation of statistical data  on page221

Extending report counters  on page222

The RPTReport extension point
Use this extension point to define performance testing reports that are installed with the product and are 

available for "Restore to default."

The following table describes the elements and attributes of the RPTReport extension point.

Elements and attributes Description

Report A performance testing report definition. Can be 

a part of a ReportGroup; however, any report that 

applies only to a specific protocol should be as

signed to that protocol report group.

     path The provider plug-in relative path to the .view  file 

that defines the performance report, for exam

ple:/reports/my_report.view.

     menuText A localized string for the Report menu item (for 

example, "Display Performance Report"). Local

ize this string using the "%" prefaced key. When 

this string is retrieved from the extension, the lo

calized value from the plug-in resource bundle 

is provided. Refer to the example that follows in 

this topic.

     icon Plug-in root-relative path to an icon used with the 

menu of this report, for example: /icons/my_i

con.gif

     restrictToPostRun To have this report available only after the run 

has completed, set this Boolean variable to 

"true."

     id A unique identifier for this report.
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Elements and attributes Description

     PostRunGenerator Implies restrictToPostRun. If a report requires 

post-run processing (for example, a Page Per

centile report that calculates its data based on 

the entire test run), this attribute can specify an 

implementor of PostRunReportGenerator. Refer to 

the example that follows in this topic.

     isTemplate Note: this attribute is not currently available.

ReportGroup Grouping for protocol-specific reports. Results in 

a drop-down menu labeled with text provided in 

menuText. All protocol-specific reports must have 

a protocol group.

     menuText Text that labels the protocol group drop-down 

menu. Should be localized using the "%" prefaced 

key.

     capability_id Note: This attribute is not currently available.

     defaultReportID The ID of the default report for the protocol asso

ciated with this group.

     protocol_id The ID of the protocol to which this ReportGroup 

applies.

The following example shows an RPTReport  extension point.

<Report

   menuText="%DISPLAY_TRANS_REPORT_LABEL"

   icon="icons/elcl16/trans_report.gif"

   path="reports/Transaction Report.view"

   id="com.ibm.rational.test.lt.execution.results.transactions"/>

 <ReportGroup menuText="%HTTP_REPORTS">

  <Report

   menuText="%DISPLAY_PERF_REPORT_LABEL"

   icon="icons/report_default.gif"

   path="reports/default.view"

   id="com.ibm.rational.test.lt.execution.results.performance"/>

  <Report
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   menuText="%PAGEEL_REPORT"

   icon="icons/elcl16/pageelem_report.gif"

   path="reports/Page Element Report.view"

   id="com.ibm.rational.test.lt.execution.results.pageelement"/>

  <Report

   restrictToPostRun="true"

   menuText="%PERCENTILE_REPORT"

   icon="icons/report_percent.gif"

   path="reports/Percentile Report.view"

   PostRunGenerator="com.ibm.rational.test.lt.execution.results.view.controller.PercentileReportController"

   id="com.ibm.rational.test.lt.execution.result.percentile"/>

  <Report

   menuText="%VP_REPORT"

   icon="icons/report_vp.gif"

   path="reports/Verification Point Report.view"

   id="com.ibm.rational.test.lt.execution.results.vp"/>

 </ReportGroup>

Public APIs for evaluate results
The public APIs contain the public interfaces and classes that you can use to extend the evaluate results 

functionality.

The following table lists the public packages:

Package Description

com.ibm.rational.test

.lt.execution.results

.data

Contains the IStatModelFacade  interface used to access and modify the 

performance testing statistical model.

com.ibm.rational.test

.lt.execution.results

.data.aggregation

Contains the aggregation classes used to aggregate statistical data in re

al time.

com.ibm.rational.test

.lt.execution.result

s.data.aggregation.ag

gregators

Contains the aggregator classes that aggregate statistical data in real 

time and place the newly calculated data on the host which contains the 

aggregators dependency data.
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Package Description

com.ibm.rational.test

.lt.execution.result

s.data.aggregation

.transferaggregators

Contains the aggregator classes that aggregate statistical data based on 

data from all hosts in the resultset. Data calculated by these aggregators 

is placed in the â€œAll Hostsâ€? host.

com.ibm.rational.test

.lt.execution.results

.internal.actions

Contains the PostRunReportGenerator  interface that is specified in the ex

tension point RPTReport. Post Report generators are used to calculate 

statistical data after a run has completed.

com.ibm.rational.test

.lt.execution.result

s.view.data.string

translator

Contains the IRPTStatStringTranslator  interface extended by the imple

mentors of the com.ibm.rational.test.lt.execution.results.Statisti

calStringTranslator  class. String translators are used to localize strings 

contained in the statistical model.

The Javadoc for the test execution services interfaces and classes can be accessed from the product by 

clicking Help  > Help Contents  > IBM®  Rational®  Performance Tester  API Reference.

Related information

Aggregation of statistical data  on page221

Extending report counters  on page222

Extending default reports  on page228
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This document provides information about copyright, trademarks, terms and conditions for the product 

documentation.

© Copyright IBM Corporation 2001, 2016 / © Copyright HCL Technologies Limited 2016, 2021

This information was developed for products and services offered in the US.

IBM®  may not offer the products, services, or features discussed in this document in other countries. 

Consult your local IBM®  representative for information on the products and services currently available 

in your area. Any reference to an IBM®  product, program, or service is not intended to state or imply that 

only that IBM®  product, program, or service may be used. Any functionally equivalent product, program, or 

service that does not infringe any IBM®  intellectual property right may be used instead. However, it is the 

user's responsibility to evaluate and verify the operation of any non-IBM®  product, program, or service.

IBM®  may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You can send 

license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119

Armonk, NY 10504-1785

US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM® 

Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION  PROVIDES THIS PUBLICATION "AS IS" WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 

PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain 

transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically 

made to the information herein; these changes will be incorporated in new editions of the publication. 
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IBM®  may make improvements and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice.

Any references in this information to non-IBM®  websites are provided for convenience only and do not in 

any manner serve as an endorsement of those websites. The materials at those websites are not part of 

the materials for this IBM®  product and use of those websites is at your own risk.

IBM®  may use or distribute any of the information you provide in any way it believes appropriate without 

incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 

exchange of information between independently created programs and other programs (including this 

one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119

Armonk, NY 10504-1785

US

Such information may be available, subject to appropriate terms and conditions, including in some cases, 

payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by 

IBM®  under terms of the IBM®  Customer Agreement, IBM®  International Program License Agreement or 

any equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. 

Actual results may vary.

Information concerning non-IBM®  products was obtained from the suppliers of those products, their 

published announcements or other publicly available sources. IBM®  has not tested those products and 

cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM® 

products. Questions on the capabilities of non-IBM®  products should be addressed to the suppliers of 

those products.

Statements regarding IBM®'s future direction or intent are subject to change or withdrawal without notice, 

and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate 

them as completely as possible, the examples include the names of individuals, companies, brands, and 

products. All of these names are fictitious and any similarity to actual people or business enterprises is 

entirely coincidental.

COPYRIGHT LICENSE:



Chapter 2. Notices

This information contains sample application programs in source language, which illustrate programming 

techniques on various operating platforms. You may copy, modify, and distribute these sample programs 

in any form without payment to IBM®, for the purposes of developing, using, marketing or distributing 

application programs conforming to the application programming interface for the operating platform 

for which the sample programs are written. These examples have not been thoroughly tested under 

all conditions. IBM®, therefore, cannot guarantee or imply reliability, serviceability, or function of these 

programs. The sample programs are provided "AS IS", without warranty of any kind. IBM®  shall not be 

liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright 

notice as follows: 

© (your company name) (year). 

Portions of this code are derived from IBM Corp.  Sample Programs. 

© Copyright IBM Corp.  2000, 2017.

Trademarks
IBM®, the IBM®  logo, and ibm.com®  are trademarks or registered trademarks of International Business 

Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be 

trademarks of IBM®  or other companies. A current list of IBM®  trademarks is available on the web at 

"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM®  website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary 

notices are preserved. You may not distribute, display or make derivative work of these publications, or 

any portion thereof, without the express consent of IBM®.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all 

proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, 
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distribute or display these publications or any portion thereof outside your enterprise, without the express 

consent of IBM®.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either 

express or implied, to the publications or any information, data, software or other intellectual property 

contained therein.

IBM®  reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use 

of the publications is detrimental to its interest or, as determined by IBM®, the above instructions are not 
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laws and regulations, including all United States export laws and regulations.

IBM®  MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS 

ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, 

AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
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identifiable information, specific information about this offering use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable 

information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect 

personally identifiable information from end users via cookies and other technologies, you should seek 

your own legal advice about any laws applicable to such data collection, including any requirements for 

notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, 

see IBM's Privacy Policy at http://www.ibm.com/privacy  and IBM's Online Privacy Statement at http://

www.ibm.com/privacy/details  in the section entitled Cookies, Web Beacons and Other Technologies, 

and the IBM Software Products and Software-as-a-Service Privacy Statement at http://www.ibm.com/

software/info/product-privacy.
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